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Introducing SEQRITE Endpoint Security 

Welcome to the Help file of Seqrite Endpoint Security Cloud! 

Seqrite Cloud is an integrated solution that allows the management and regulation of multiple 

Endpoint Security products deployed at different geographical locations. IT administrators from 

any location can easily connect to the Cloud to view the latest security status, configure product 

policies, receive notifications and rectify critical network events from one single dashboard. It 

also facilitates policy configuration, backup and more on the Cloud for Seqrite products.  

Available Flavors 

Seqrite Endpoint Security Cloud is available in the following flavors: 

• Standard 

• Advanced 

• Premium 

 

The following table lists the features that are available in the flavors: 

Features Standard Advanced Premium 

Antivirus 
   

Anti-Ransomware 
   

Email Protection 
   

IDS/IPS Protection 
   

Firewall 
   

Anti phishing 
   

3rd Party App Remover 
   

GoDeep.AI 
   



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  8 

Vulnerability Scan 
   

Antispam    

Web Security    

Advanced Device Control    

Application Control    

Asset Management    

Tuneup    

YouTube Access Controller    

Google Access Controller    

Data Loss Protection  Add On Add On 

File Sandbox  Add On Add On 

Data Loss Protection – Available as add-on pack with Advanced and Premium. 

File Sandbox – Available as add-on pack with Advanced and Premium. 

As per the flavor purchased, the features are available in the portal. In this guide, all the 

features are explained. 

Supported Web Browsers 

The following Web browsers are supported for Seqrite Endpoint Security Cloud, 

• Internet Explorer 10 and 11 

• Microsoft Edge 

• Google Chrome 60 and above 

• Mozilla Firefox 55 and above 

• Safari (Only Mac) 11, 12 and 13 
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Best Cyber Security Practices 

Best cyber security practices for enterprises to stay cyber secure in wake of the rising 

incidences of targeted attacks on enterprises, there is no way organizations can afford to ignore 

the importance of cyber security. Regardless of the size and type of enterprise, even a small 

data breach or cyber-attack could mean millions of dollars of loss, crippling the economy of the 

enterprise. 

It is for this reason that as a thumb rule, enterprises start following these good cyber security 

practices, to be cyber secure against known and unknown threats: 

• Invest in Security Solutions – An enterprise may be subjected to various kinds of threats 

and thus, to ensure enterprise-wide security, it is a good practice to invest in a variety of 

security solutions that cover the changing needs of an organization. 

• Use Complex and Unique Passwords – As a thumb rule, enterprises must encourage 

employees to use strong and unique passwords and prohibit them from sharing their 

credentials. 

• Invest in Training – Educate and train employees about cyber security so that they are 

cautious about clicking suspicious links, sharing sensitive data, and responding to 

security alerts. 

• Backup Your Data – Follow the 3-2-1 rule when it comes to data backup, meaning that 

maintain 3 varying copies of your crucial data in 2 different formats, where at least 1 of 

the data storage locations should be offline. 

• Robust Security Policies – To ensure that both employees and third parties follow the 

security policies, it is important to strictly convey the enterprise security policies and 

expectations. 

• Use Updated Software – Using expired software is as good as counting on a dead 

security solution. Thus, it is good practice to keep your software updated to the latest 

version, to safeguard your organization against evolving threats. 

• Data Encryption – It is advisable to encrypt all the saved and backed-up data while 

providing access rights to only limited and specific personnel. 

• Two-Factor Authentication – An additional and reliable login procedure is to use two-

factor authentication that uses a secondary device like a mobile for access 

authentication. 

• Have an MDM Plan – It is important to monitor and regulate the mobile device usage of 

employees since they often use it for accessing sensitive data and company emails, 

while using the company’s wireless network. This may serve as a soft vulnerability for 

attacks. 
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• Change Default Credentials – Several IoT devices come with default passwords that 

make it easy for malware to target such IoT devices. Thus, it is a good practice to change 

these default credentials. 

• Secured Wi-Fi – A device can connect to only those Wi-Fi networks which have a known 

SSID. Thus, to prevent an unknown device from connecting to the Wi-Fi network of your 

enterprise, a good security mechanism is to use a hidden SSID to prevent it from getting 

broadcast. 

• Limited Access Right Grant – Anyone who requests access to a resource should be 

provided with minimum access rights and that too for the shortest duration necessary. 

Such restricted delegation of access rights can limit attackers from intruding into 

systems. 

• Server OS Hardening – To address the security of your enterprise adequately, it is 

advisable to configure and harden the operating system. This typically involves removing 

all the unnecessary applications, services, and network protocols. 
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Back to HawkkEye 

This page will only be visible to the customers who have purchased Seqrite HawkkEye with 

Seqrite EndPoint Security Cloud. 

To access HawkkEye console, click Back To HawkkEye link. 

Seqrite HawkkEye is an integrated solution that allows the security management of multiple 

endpoints deployed at different geographical locations. Endpoints may consist of desktop 

computers, laptops, and mobile devices that are registered with Seqrite EndPoint Security 

Cloud or Seqrite mSuite products. 

Seqrite HawkkEye is a consolidated security solution that allows existing users of Seqrite 

EndPoint Security Cloud, Seqrite mSuite, or Seqrite HawkkHunt to access and manage all your 

subscribed products from one central console of Seqrite HawkkEye. 
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Dashboards 

The Dashboard displays the statistics and charts only when the endpoints are deployed. As a 

new user, when you land on this page, the message appears to deploy the endpoints. Click the 

Deployment button if you want to deploy the endpoints at that moment. 

The Dashboard screen on the Home page displays the widgets for Status, Compliance, DLP, and 

Custom tabs. You can refresh the widget with the refresh button. You can remove the widget 

with the remove button (X). The removed widget name appears in the Customize Dashboard > 

Unassigned Widgets section. 

Current Status Summary 

Feature Description 

Endpoints Displays total number of endpoints in the network at that 

time. Clicking the icon below endpoint count, redirects to the 

Virus Scan report page.  

Protection Disabled 

(All Endpoints are 

Protected) 

Displays number of endpoints on which the following features 

are disabled: 

▪ Virus protection  

▪ Phishing protection  

▪ Browsing Protection 

Clicking the icon below endpoint count redirects to the Status 

page. 

When the above features are enabled on all the endpoints, All 

Endpoints are Protected message appears. 

Infected Endpoints 

(All Endpoints are 

Clean) 

Displays number of infected endpoints in last 7 days. 

Clicking the icon below endpoint count, redirects to the Virus 

Scan page.   

When no virus attacks are found, All Endpoints are Clean 

message appears. 

Vulnerable Endpoints 

(No vulnerabilities) 

Displays number of vulnerable endpoints in the network. 

Clicking the icon below endpoint count, redirects to the 
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Vulnerability Scan page. 

When no vulnerabilities are found, No vulnerabilities message 

appears. 

Status  

Feature Tab Description 

Infection 

Detected 

Infected 

Systems 

Gives a graphical representation of the infection in the 

network for the selected time period. The graphs can be 

viewed for the following time periods: 

• Last 7 Days: Displays the report of the last seven 
days. 

• Last 15 Days: Displays the report of the last 15 
days. 

• Last 30 Days: Displays the report of the last 30 

days. 

Clicking the data points on the chart, redirects to the 
Virus Scan page. 

 

Top 10 

Infected 

Systems 

Gives a progress bar chart that displays the top 10 

infected systems in the network for the selected time 

period. The chart can be viewed for the following time 

periods: 

• Last 7 Days: Displays the chart of the last seven 

days. 

• Last 15 Days: Displays the chart of the last 15 

days.  

• Last 30 Days: Displays the chart of the last 30 

days.  

Clicking the infection count redirects to the Virus Scan 

report page. 

Host Integrity 

Report 

 Gives a doughnut chart that displays the number of 

compliant and non-compliant endpoints. An endpoint is 

protected and compliant if all the following conditions 

are true. Client Agent version is the latest Virus Database 

is updated Virus protection is enabled Behavior 
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Detection System is enabled No malware is found on it 

Clicking the slice of the chart, redirects to the Host 

Integrity report page. 

Update Status  Gives a doughnut chart which displays the number of 

endpoints on which the virus definitions are up-to-date 

and not up-to-date for 1, 3, 7, 15 and 30 days.  

Clicking the slice of the chart, redirects to the Status 

page. 

Top 10 Malware 

Detected 

 Gives a progress bar chart that displays top 10 malware 

detected systems in the network for the selected time 

period. The chart can be viewed for the following time 

periods: 

Last 7 Days: Displays the chart of the last seven days. 

Last 15 Days: Displays the chart of the last 15 days.  

Last 30 Days: Displays the chart of the last 30 days.  

Clicking the Detection count redirects to the Anti-

Malware Scan report page. 

Operating 

System 

 Gives a doughnut chart which displays the total number 

of endpoints installed on Windows, Linux and Mac 

platform. 

Clicking the slice of the chart, redirects to the Status 

page.  

Managed and 

Unmanaged 

Endpoints 

 Gives a bar graph which displays the number of managed 

and unmanaged endpoints. This is the enumeration 

result for the selected clients. For more information, see 

Enumerate Network.  

Clicking the bar of the chart, redirects to the Status page. 

License Usage 

Status 

 Gives two half pie charts, one chart for EPS License and 

the other for DLP License. The chart displays the number 

of licenses utilized and licenses remaining. 

Clicking the slice of the chart, redirects to the Status 

page. This widget is not applicable for postpaid clients. 
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Last Connected 

Endpoints 

 Gives a doughnut chart which displays the number of 

endpoints which are connected last and not connected 

for last 3, 7, 15 and 30 days. 

Clicking the slice of the chart, redirects to the Status 

page. 

Agent Versions  Gives a doughnut chart which displays the agent versions 

of all the endpoints. 

Clicking the slice of the chart, redirects to the Status 

page. 

Compliance 

Advanced Device Control 

Feature Description 

Device 

Violations 

Gives a graphical representation of the device violations on the endpoints for the 

selected time period. The graphs can be viewed for the following time periods:  

• Last 7 Days: Displays the report of the last seven days. 

• Last 15 Days: Displays the report of the last 15 days. 

• Last 30 Days: Displays the report of the last 30 days. 

Clicking the data points on the chart, redirects to the Advanced Device Control 
report page. 

Policy 

violations 

by 

Devices 

Gives a doughnut chart which displays the number of policy violations by various 

devices for the last 7, 15 and 30 days. 

Clicking the slice of the chart, redirects to the Advanced Device Control report page. 
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Application Control 

Feature Tab Description 

Blocked Applications Blocked 

Applications 

Gives a graphical representation of the blocked 

applications for the selected time period. The 

graphs can be viewed for the following time 

periods:  

• Last 7 Days: Displays the report of the last 

seven days. 

• Last 15 Days: Displays the report of the last 

15 days. 

• Last 30 Days: Displays the report of the last 

30 days.  

Clicking the data points on the chart, redirects to 

the Blocked Applications on Access report page.  
Top 10 Blocked 

Applications 

Gives a progress bar chart that displays top 10 

blocked applications for the selected time period. 

The chart can be viewed for the following time 

periods: 

• Last 7 Days: Displays the chart of the last 

seven days. 

• Last 15 Days: Displays the chart of the last 

15 days.  

• Last 30 Days: Displays the chart of the last 

30 days.  

Clicking the Block count redirects to the 

Application Control on Access Report page. 

Blocked Application 

Category 

Blocked 

Application 

Category 

Gives a doughnut chart which displays the number 

of blocked application categories for last 7, 15 and 

30 days. Clicking the slice of the chart, redirects to 

the Blocked Applications on Access report page.  
Top 10 Blocked 

Application 

Categories 

Gives a progress bar chart that displays top 10 

blocked application categories for the selected 

time period. The chart can be viewed for the 

following time periods:  

• Last 7 Days: Displays the chart of the last 

seven days.  

• Last 15 Days: Displays the chart of the last 

15 days.  
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• Last 30 Days: Displays the chart of the last 

30 days.  

Clicking the Block count redirects to the 

Application Control on Access Report page. 

Top 10 users who 

attempted to access 

blocked applications 

 
Gives a progress bar chart that displays top 10 

users who attempted to access blocked 

applications for the selected time period. The 

chart can be viewed for the following time 

periods:  

• Last 7 Days: Displays the chart of the last 

seven days. 

• Last 15 Days: Displays the chart of the last 

15 days.  

• Last 30 Days: Displays the chart of the last 

30 days. Clicking the Block count redirects 

to the Application Control on Access 

Report page. 
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Web Security 

Feature Tab Description 

Blocked 

Websites 

Blocked Websites Gives a graphical representation of the Blocked Websites for 

the selected time period. The graphs can be viewed for the 

following time periods: 

• Last 7 Days: Displays the report of the last seven days.  

• Last 15 Days: Displays the report of the last 15 days.  

• Last 30 Days: Displays the report of the last 30 days.  
Top 10 Blocked 

Websites 

Gives a progress bar chart that displays top 10 blocked 

websites for the selected time period. The chart can be 

viewed for the following time periods: 

• Last 7 Days: Displays the chart of the last seven days.  

• Last 15 Days: Displays the chart of the last 15 days.  

• Last 30 Days: Displays the chart of the last 30 days.  

Clicking the Block count redirects to the Web Security 

Report page. 

Web 

categories 

 Blocked Web 

Categories 

Gives a doughnut chart which displays the number of 

Websites blocked by categories for last 7, 15 and 30 days.  
Top 10 Blocked 

Web Categories 

Gives a progress bar chart that displays top 10 blocked web 

categories for the selected time period. The chart can be 

viewed for the following time periods:  

• Last 7 Days: Displays the chart of the last seven days.  

• Last 15 Days: Displays the chart of the last 15 days.  

• Last 30 Days: Displays the chart of the last 30 days.  

Clicking the Block count redirects to the Web Security 

Report page. 
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Assets 

Feature Description 

Hardware 

changes 

Gives a graphical representation of hardware changes detected on endpoints 

with Windows and Mac operating systems for the selected time period. The 

graphs can be viewed for the following time periods: 

• Last 7 Days: Displays the report of the last seven days. 

• Last 15 Days: Displays the report of the last 15 days. 

• Last 30 Days: Displays the report of the last 30 days. 

Clicking the data points on the chart, redirects to the Asset Management report 

page. 

Software 

changes 

Gives a graphical representation of software changes detected on endpoints 

with Windows and Mac operating systems for the selected time period. The 

graphs can be viewed for the following time periods: 

• Last 7 Days: Displays the report of the last seven days. 

• Last 15 Days: Displays the report of the last 15 days. 

• Last 30 Days: Displays the report of the last 30 days. 

Clicking the data points on the chart, redirects to the Asset Management report 

page. 

Top 10 Vulnerabilities 

Feature Description 

Top 10 

Vulnerabilities 

Gives a progress bar chart that displays top 10 Vulnerabilities detected in 

the systems in the network. Clicking the Detection count redirects to the 

Vulnerability Scan report page. 
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Data Loss Prevention 

Feature Tab Description 

DLP Policy 

Violations 

Violating 

Endpoints 

Gives a graphical representation of DLP violations 

detected on endpoints for the selected time period. The 

graphs can be viewed for the following time periods: 

• Last 7 Days: Displays the report of the last seven 

days. 

• Last 15 Days: Displays the report of the last 15 days. 

• Last 30 Days: Displays the report of the last 30 days. 

Clicking the data points on the chart, redirects to 
the Data Loss Prevention report page. 

 Top 10 

Violating 

Endpoints 

Gives a progress bar chart that displays top 10 DLP policy 

violating endpoints for the selected time period. The 

chart can be viewed for the following time periods:  

• Last 7 Days: Displays the chart of the last seven 

days. 

• Last 15 Days: Displays the chart of the last 15 

days.  

• Last 30 Days: Displays the chart of the last 30 

days.  

Clicking the Block count redirects to the Data Loss 

Prevention Report page. 

Top 10 users who 

attempted to 

breach DLP policy 

 Gives a progress bar chart that displays top 10 users who 

attempted to breach DLP policy for the selected time 

period. The chart can be viewed for the following time 

periods:  

• Last 7 Days: Displays the chart of the last seven 

days. 

• Last 15 Days: Displays the chart of the last 15 

days.  

• Last 30 Days: Displays the chart of the last 30 

days.  
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Clicking the Block count redirects to the Data Loss 

Prevention Report page. 

Data Leaks 

through Data 

Transfer Channel 

 Gives a doughnut chart which displays the number of 

data leaks through data transfer channel for last 7, 15 

and 30 days. 

Clicking the slice of the chart, redirects to the Data Loss 

Prevention report page. 

Type of Data 

Leaks 

 Gives a doughnut chart which displays the type of data 

leaks for the last 7, 15 and 30 days. 

Clicking the slice of the chart, redirects to the Data Loss 

Prevention report page. 
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User 

The User page displays the information of all the users in the table format. The table includes 

information such as Username, User Role, Email, Mobile No., and Status. 

You can customize the User table as per column names. 

To select all the users from the table, select the check box in the header row. 

To select an individual user, select the check box in that row. 

You can search the user with the help of search criteria. 

For the users of Seqrite EPS Cloud with HawkkEye 

If you have purchased Seqrite EPS Cloud along with Seqrite HawkkEye, 

• You need to add users from the Seqrite HawkkEye console only. 

• You have restricted access to this page. You cannot Add, Delete User from this page. 

• While editing, you can only change the User Role, you cannot edit other information. 

For the users of only Seqrite EPS Cloud 

If you have purchased only Seqrite EPS Cloud, you have full access to this page. 

You can add, delete, edit User from this page. 

Here you can view the details of the user. Also, you can create a user, and assign user role. You 

can rename, edit or delete the user. You can enable or disable the user. 

You can resend the activation link to set the password to access the account. 

Adding a User 

This feature helps you create a user and assign user role. 

Adding a User 

To add a user, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to User. The Users page appears displaying list of users. 

3. Click Add User button. 
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4. Click Add. 

The Add User dialog appears. 

Active Directory User switch appears only when Active Directory settings are enabled. Keep 

the switch at No position. 

5. Enter First Name, Last name, Email ID, Password, Confirm Password,  and Mobile No. 

6. Select the User Role from the list. The selected role will be assigned to the user. 

For more information, see User Roles. 

7. The User role can be changed to the other role as and when required. 

If you assign the User Role as Group Admin, click Next. 

In the dialog, a list of groups appears. Select the group to be assigned to the Group Admin. 

Only one group can be assigned to the Group Admin here.If the Parent group is selected, all 

child and sub child group are selected automatically. You can select only one child or a 

subchild group from the hierarchy. One group can have multiple Group Admins.  

8. Click Add. 

The new user is added to the list. You can create maximum 49 users. 

When you log on to SEQRITE Endpoint Security as Group Administrator, the Status page is 

displayed by default. Only pages having privileges for Group Admin are displayed. 

Enabling a User 

To enable a user, follow these steps: 

1. Select the check box of the user that you want to enable. An action bar is enabled above the 

table. 

2. Select Enable. 

3. Click Submit button. 

4. The confirmation message appears. Click Yes. 

The selected user is enabled. 

Disabling a User 

To disable a user, follow these steps: 

1. Select the check box of the user that you want to disable. An action bar is enabled above 

the table. 

2. Select Disable. 

3. Click Submit button. 

4. The confirmation message appears. Click Yes. 

The selected user is disabled. 
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Note: The disabled user cannot log on to the Seqrite Endpoint Security portal. 

Deleting a User 

To delete the user, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to User. The Users page appears displaying list of users. 

3. Select the check box of the user that you want to delete. An action bar is enabled above the 

table. 

4. Select Delete. 

5. Click Submit button. 

6. The confirmation message appears. Click Yes. 

The selected user is removed. 

Note: You cannot edit or delete the default user. 

If you delete the Group Admin, the policies created by the Group Admin can be deleted if the 

policies are not assigned to any group and endpoints. 

Editing a User 

For the users of Seqrite EPS Cloud with HawkkEye 

If you have purchased Seqrite EPS Cloud along with Seqrite HawkkEye console, 

You have restricted access to this page. While editing User, you can only change the User Role.  

For the users of only Seqrite EPS Cloud 

If you have purchased only Seqrite EPS Cloud, you have full access to this page. 

Here you can edit the user information. You can edit the name, Email address or mobile 

number of users. You can also change the user role. If you change the role to Group Admin, you 

can assign a group. 

To edit the user, follow these steps: 

1. Log on to the Seqrite Endpoint Security Cloud. 

2. Go to User. The Users page appears displaying list of users. 

3. Click the Edit icon of the user that you want to edit. 

The Edit User dialog appears. 

4. Edit the information. 
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5. If you assign the User Role as Group Admin, click Next. 

6. In the dialog, a list of groups appears. Select the group to be assigned to the Group 

Admin.If the Parent group is selected, all child and sub child group are selected 

automatically. You can select only one child or a subchild group from the hierarchy.  

7. Click Save. 

User information is updated. 

Note: You cannot edit or delete the default user. 

Importing a User 

You can import maximum 49 users at a time through a CSV file. 

To import the users, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Users. The Users page appears displaying list of users. 

3. Click Add User > Import. 

4. In the Import User dialog, import a CSV file by clicking Browse. The file size must be less 

than or equal to 1 MB. 

The CSV file content should be in the following format: 

First Name Last Name EMAIL Country 

Code 

MOBILE 

NUMBER 

User Role Name 

aaa rrr aaa@mail.com +91 1111111111 ADMIN 

bbb sss bbb@gmail.com +44 22222222222 REPORT_ONLY 

ccc ddd ccc@gmail.com +1 3333333333 ADMIN 

As you see in the above example, the Country Code should contain + sign. 

The User Role name (REPORT_ONLY, ADMIN, HAWKKHUNT_ADMIN, 

HAWKKHUNT_INCIDENT_RESPONDER) should be in Capital letters. 

5. Click Import. 
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Resend Activation Link 

For the User Roles, Administrator and Report Viewer, an Email with activation link can be sent 

to the Email ID provided. Users need to click the link to set the password to access the account. 

The link is valid for specific periods only. If the link expires or the user does not receive the 

Email, you can resend the activation link. 

To resend the activation link, follow these steps: 

1. Log on to the Seqrite Endpoint Security Cloud. 

2. Go to User. The Users page appears displaying list of users. 

3. Select the check box of the user to which you want to send the activation link. An action 

bar is enabled above the table. 

4. Select Resend Activation Link. 

5. Click the Submit button. 

6. The confirmation message appears. Click Yes. 

The activation link is sent to the selected user. 
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Groups 

On the Groups page, you can view, create, and manage groups and subgroups. In the left pane, 

a tree like structure of groups and subgroups is displayed. The synchronized groups with Active 

Directory have AD tag in their name. In the right pane, the group name and number of 

endpoints assigned to that group is displayed. One group may have multiple Group Admins. 

Names of Group Admins are also displayed. You can edit Group Admin. 

In the ‘Assigned policies to the group’ section, a table shows the assigned policies to the 

selected group. The policy applied on the group is applicable to all the endpoints within the 

group. 

This feature helps you create groups and subgroups and apply a policy to a group (or a 

subgroup). You can delete or rename a group or set different policies for different groups. You 

can also change Group Admin of the group. 

Adding a Group 

To add a new group, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Groups. 

3. Select the root if you want to create the new group at the root level. Select a group to 

create subgroup. 

4. Click Add Group. The Add Group screen appears. 

5. In the Group Name text box, type a group name. 

6. Select the policy for endpoint from the list. 

7. Click Add. 

The new group/subgroup is added. 

Note: No subgroup can be created under the Default group. 

Assigning Group Admin to the Group 

1. Add a new group. See Adding a group. 

2. Go to User. The Users page appears displaying list of users. 

3. Click Edit icon of the Group Admin that you want to assign to your group. 

Edit User dialog appears. 

4. Click Next. 
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5. In the dialog, a list of groups appears. Select your group to assign to the Group Admin. Only 

one group can be assigned to the Group Admin here. If the Parent group is selected, all child 

and sub child group are selected automatically. You can select only one child or a subchild 

group from the hierarchy. One group can have multiple Group Admins. 

6. Click Save. 

The confirmation dialog appears. 

7. Click Ok. 

The Group Admin is assigned to the group. On the Groups page, when you select the group, 

you can view assigned Group Admin in the right pane. 

Group Admin can view all the endpoints of the assigned groups and subgroups.  

Setting Policy to a Group 

Policies may include different client settings for different groups in an organization. 

If the policy is pushed from MSSP, it will get applied on default EPS group and that policy will be 

read only. 

To set a policy to a group, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Groups. 

3. In the left pane, select a group to apply the policy. The list of policies for endpoints is 

displayed. 

4. To change the policy, click Change Policies option. The Change Computer Policies dialog 

appears. 

5. In the Default Policies tab, select the policy that you want to apply. 

6. In the Override Policies tab, select the features for which you want to override the policy.  

7. Click Assign. 

The policy is applied to the selected group. 

The policy created by Super Admin or Admin when applied on the group is read only for Group 

Admin. 

For more information about policies, see Policies. 

Deleting a Group 

To delete a group/subgroup, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  29 

2. Go to Groups. 

3. In the left pane, select a group/subgroup. 

Note: You cannot delete the group if Group Admin is assigned to that group. 

4. In the right pane, click the Delete button. A confirmation message is displayed. 

5. Click Yes. 

The selected group/subgroup is deleted. 

If you delete the group, all the subgroups available under that group will be deleted. The 

endpoints assigned to the subgroup and groups will be moved to Default group. The policy of 

default group is applied on the moved endpoints except the feature policy assigned on the 

endpoint. 

If you delete the subgroup, the endpoints assigned to the subgroup will be moved under its 

parent group and policy of parent group is applied on the moved endpoints except the feature 

policy assigned on the endpoint. 

Moving Group 

To move a group/subgroup, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Groups. 

3. In the left pane, select a group/subgroup. Drag the group to a desired group where you 

want to move. 

The endpoints and policies associated with the group remain the same, but under new parent 

group. 

Renaming a Group 

To rename a group, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Groups. 

3. In the left pane, select a group/subgroup to rename. The Group details appears.  

4. Click the edit icon in the Group Name. Edit the Group Name. 

5. To save changes, click the tick mark. 

The group/subgroup name is modified. However, the policy applied earlier to this group does 

not change. To change a policy, you have to apply a new policy. 
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Changing Group Admin 

To change a group/subgroup assigned to Group Admin, follow these steps:  

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Groups. 

3. In the left pane, select a group/subgroup. 

4. In the right pane, the details of the group appears. The names of Groups Admins with edit 

icon appears. Click the edit icon of the Group Admin that you want to change. 

5. The Change Group dialog appears. In the dialog, a list of groups appears. Select the group to 

be assigned to the Group Admin. Only one group can be assigned to the Group Admin here. 

If the Parent group is selected, all child and sub child group are selected automatically. You 

can select only one child or a subchild group from the hierarchy. One group can have 

multiple Group Admins. 

6. Click Apply. 

The changed group is assigned to the Group Admin. 
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Status 

The Status page displays the current status of all the endpoints of the selected group. The 

status includes the following information of the endpoint. 

Column Name Description 

Endpoint Name Displays the name of the endpoint. 

IP Address Displays the IP address of the endpoint. 

Endpoint Status Displays whether the endpoint is online or offline. Endpoint status is 

changed to offline according to set missed heartbeat count to turn 

endpoint offline. For more details, see Admin Settings. 

The status Disconnected means infected endpoint is disconnected 

from the network when a non-repairable virus is found, and a 

suspicious file is found by the DNA scan. 

Domain Name Displays the name of the domain to which the selected client logs in. 

Group Name Displays the group name to which the selected client belongs. 

User Name Displays the username of endpoint. 

Policy Displays the policy applied on the endpoint. 

Virus DB Date 

(GMT+5:30) 

Displays VDB date along with Update time. 

Last Connected Displays the date when the endpoint was last connected. 

Last Scanned Displays the date when the endpoint was last scanned. 

MAC Address Displays the MAC address of the endpoint. 

Client Version Displays the installed EPS client version. 

Operating System Displays the name of the operating system of the endpoint. 

AV Status Displays the antivirus status of the endpoint. 

• In progress 

• Success 

• Failed 

• Reboot Required 

• NA 

Note: Not applicable to Mac and Linux client. 

The following options help to customize and search the desired endpoints:  

• Columns: You can use this option to customize the status list as per column names. 

• Filter by: You can use this option to filter the status list according to the Operating 

Systems platforms, Endpoints with DLP, Endpoints without DLP and Clients Need 
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Upgradation. The legend for Assigned DLP License and Assigned Update Agent Role are 

displayed for the respective endpoints. 

• Endpoint Name: You can use this option to search the endpoints with different 

parameters. 

You can initiate client actions by selecting the endpoint. The list of client actions is OS specific.  

To select all the endpoints from the list, select the check box in the header row. 

To select an individual endpoint, select the check box in that row. 

Viewing status of selected endpoint 

To view the status of an endpoint, click the name of the endpoint for which you want to view 

the status. The Endpoint Status page appears displaying detailed status of the endpoint. For 

more details, see Endpoint Status. 

Update Agent 

Important 

Update Agent helps you to download and manage the updates for SEQRITE Endpoint Security. It 

provides you the flexibility to download the updates on a single machine. All the SEQRITE 

Endpoint Security clients fetch the updates from this centralized location. It also provides the 

facility of automatically updating SEQRITE Endpoint Security for enhancements or bug fixes.  

Viewing Update Agent Status 

You can view information of all types of updates downloaded by the Update Agent. 

To view the update agent status, follow these steps: 

1. On the Status page, identify and click the endpoint name with update agent role.  

2. The Endpoint Status page appears. You can see the label as Update Agent. Click the Switch 

to Update Agent button. 

3. The Update Agent page appears. The endpoint name and IP address of the endpoint where 

update agent is installed is displayed. 

4. In the Status tab, the status of the update Agent is shown in the tabular format with the 

following details: 

 

Fields Description 

Product Name Displays the name of the SEQRITE product for which update can 

be downloaded. 

Version Displays the version of the SEQRITE product. 
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Service Pack Displays information about the service pack. 

Virus Database Date Displays the updated Virus Database date. 

 

Note: A label Outdated is displayed for the product only if the product is not updated since last 

72 hours. 

5. You can do one of the following: 

▪ Update Now – Click this button to send a Notification to the Update Agent to download 

the updates. 

▪ Rollback – Click this button to take the Update Agent back to the previous update state. 

Update Agent Settings 

To do the update agent setting, follow these steps: 

1. On the Status page, identify and click the endpoint name with update agent role.  

2. The Endpoint Status page appears. You can see the label as Update Agent. Click the Switch 

to Update Agent button. 

3. The Update Agent page appears. The endpoint name and IP address of the endpoint where 

update agent is installed is displayed. 

4. In the Settings tab, you can see the following list of settings with expand sign and toggle 

button. Expand and enable settings. 

▪ Update Settings 

▪ Proxy Settings 

5. To save the changes, click Save. 

Update Settings 

1. Under Update Type, you can select either of the following update options:  

▪ Automatic: Select this option to enable automatic update of SEQRITE Endpoint Security. 

However, this feature is enabled by default. It is recommended that you do not disable 

this feature. 

▪ Custom: If you select this option, configure the following options: 

a. In Frequency, select either the Daily or Weekly option. If you select the Weekly option, 

select the weekday from the list. 

b. In Start At, set time in hours and minutes. 

c. If you want to repeat the update of the Update Agent, select the Repeat Update check box 

and set the frequency in hours to repeat the update. 
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2. Select the update mode from the following options: 

▪ Download from Internet Center: Helps you download the updates from the default 

Internet Center. 

▪ Download from Specified URL: Helps to obtain the updates from a specified endpoint 

that has the updates downloaded by the connected system. 

a. In the Server text box, type the URL. 

b. In the Port text box, type the port number. 

Note: The msg32.htm file should be present at the update location in the system with 

Internet connection. To create the msg32.htm file, rename a text file as msg32.htm file.  

▪ Pick from specified path: Helps you pick the updates from a specified local folder from 

your computer without Internet connection. You can specify the path of the local folder 

from where the updates are to be copied. 

For example, if you have downloaded the updates on other system, you can copy them 

into a CD/DVD or pen drive and then paste in the local folder. Update Agent will fetch 

the updates from this local folder path. 

a. Select the Pick from specified Path option. 

b. Type the path to the folder from where the updates need to be copied. 

c. Select the updates available for download from the list. 

d. Under Other Settings, select the Download the endpoint security service pack check box. 

This feature is enabled by default. 

e. Select the Always take backup before downloading new update  check box. Helps you take 

the backup of the existing updates before new updates are downloaded. These backups are 

used in case a rollback to previous update is required. This feature is enabled by default.  

f. Select the Restrict download speed (kbps) check box if you want to restrict the download 

speed. Enter the speed in the text box. 

g. Select the Delete report after check box. This helps you delete the reports as per the time 

interval selected by you. This feature is enabled by default. The default value of time 

interval is 10 days. 

h. Verify the path mentioned in Download updates to box. All the SEQRITE Endpoints Security 

products will take the updates from this centralized location. 

Proxy Settings 

1. Select Proxy Type from the list. 

2. In the Server text box, type the IP address of the proxy server or domain name (Example: 

proxy.yourcompany.com). 
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3. In the Port text box, type the port number of the proxy server (Example: 80). 

4. Under Authenticate in case of firewall or proxy server section, type your logon credentials in 

the User Name and Password boxes to authenticate. 

Action Log 

View Action Log of selected endpoint 

You can view the action log (history) of all actions performed on the endpoints. To view the 

action log, click the row of the endpoint for which you want to view the history. The action log 

appears in the lower pane of the page in the tabular format. The Action Status column displays 

the corresponding status of the action. The status and meanings are as follows: 

• Queued – After initiating, the action is in the queued state until the endpoint pulls the 

action. 

• Success – The initiated action has been reached the endpoint. The endpoint has 

acknowledged the request to the server. 

• Skipped – The multiple requests for the same action are skipped. 

• Failed –The scenario can be one of the following: 

▪ The similar action is in progress at the endpoint side. 

▪ The antivirus is not installed so cannot carry the selection action. 

▪ The action is not applicable for the selected endpoint. 

By default, you can view the action log of last 7 days. You can view the log for 

last 3,7, and 15 days by selecting from the list. 

The activity logs will be deleted as per settings done in Admin > Settings. 

If the antivirus is not installed, the action logs about only the following actions are displayed:  

• Enumerate Network 

• Remote Uninstall 

• Remove selected endpoints 

• Temporary Device Access 

• Provides the facility of automatically updating SEQRITE Endpoint Security for 

enhancements or bug fixes. 

Endpoint Status 

You can keep a watch on the system information, hardware information, and software 

installed. You can also view the hardware changes, if any, that are made to the configuration of 

the systems in your network. You can also keep a tab on the list of the endpoints where the 

changes have been carried out. 
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To view status of an endpoint, click name of the endpoint for which you want to view the 

status. The Endpoint Status page appears displaying detailed status of the endpoint.  

The System Details tab displays the system information in detail. OS Product key of the 

Windows OS appears. 

Note: The OS Product key is available only in the clients with Windows Vista and above 

operating systems. 

The Hardware and Software details tab will be displayed only after Asset scan. For more 

information, see Asset Management. 

The Hardware Details tab displays the hardware information in detail.  

The Software details tab displays the details of software installed on the system. 

Note: The MS Office Product key is available only for MS Office 2010 and above. 

The Product key of MS Office is not available in the clients with MAC operating system. 

The license status of MS Office appears in the License column. 

The following table mentions possible License status and their description in the tool-tip for MS 

Office. 

License status Description 

Unlicensed The product is not licensed. 

Licensed The product is licensed. 

OOBGrace The MS Office license is in the grace period. 

OOTGrace The MS Office license requires reactivation. 

NonGenuineGrace The MS Office license has failed online validation and is in the grace 

period. 

ExtendedGrace The grace period of the MS Office license is extended. 

Notification The MS Office license is either out of the grace period or failed 

validation. 

Export 

1. To export status in the CSV format, click CSV button. Export To CSV File dialog appears. 

2. Select one of the following, 

• Export data displayed on Status page only. If you select this option, .csv is downloaded. 

• Export comprehensive data of endpoints listed on Status Page. The data includes 

System details, Software and Hardware details and System User Details. If you select this 

option, Comprehensive Asset Reports zip file is downloaded. 

3. Click Export. 
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Client Action 

Using the options in the Client Action list, you can perform different actions on the endpoints.  

You can remotely initiate scan for individual endpoints or endpoints in a group, customize scan 

settings, and stop scanning as per your preference. You can improve the performance of your 

endpoints by initiating Tune-up scan which can clean up disk space, registry entries, and 

schedule defragmentation at next boot. You can update the SEQRITE Endpoint Security virus 

database for the endpoints. 

The following table shows a comparison of the features in Client Action that are applicable for 

different SEQRITE Endpoint Security clients on different operating systems. Only supported 

feature list will be displayed as per the OS. 

Features Clients   

 Windows Mac Linux 

Scan Yes Yes Yes 

Update Yes Yes Yes 

Tuneup Yes No No 

Temporary Device Access Yes Yes No 

Enumerate Network Yes No No 

Remote Uninstall Yes Yes Yes 

DLP Yes Yes No 

Update Agent Role Yes No No 

Delete Backup Data Yes No No 

Assign Custom Policy Yes Yes Yes 

Upgrade Clients Yes No No 

Application Control Yes No No 

Vulnerability Scan Yes No No 

Move to Group Yes Yes Yes 

Remove Selected Endpoint(s) Yes Yes Yes 

The Client Actions button helps you to initiate actions on the selected endpoints.  

Scan 

This feature allows to initiate scanning on remote endpoints. You can initiate a manual scan 

with preconfigured policies or custom scan. This feature reduces the additional task of 

personally overseeing each target endpoint. 

To initiate scanning, follow these steps: 

1. On the Status page, select the endpoints you want to scan. 
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2. The client action bar is enabled above the table. In the Client Actions drop down, 

select Scan. 

3. In the Please Select list, select Start Scan. 

4. Click Submit. 

Start Scan dialog appears. 

Click Start Scan to start the scan of the selected endpoints. The action will be initiated on 

the client as per set polling interval. 

You can stop scanning by clicking Stop Scan at any time you prefer. 

You can customize the scan settings if required. 

5. To customize the scan settings, click Scan Settings. 

6. In the Scan Settings section, do the following: 

a. In Scan type section, select either Quick Scan or Full System Scan. Quick Scan includes 

scanning of the drive where operating system is installed, and Full System Scan includes 

scanning of all fixed drives. 

b. Select Scan Priority. The Scan Priority is Normal by default. You can change the priority to 

Low or High, if required. 

c. Select either Automatic or Advanced scan mode. 

Automatic scanning involves optimum scanning and is selected by default. 

When the Advanced scan mode option is selected, all the related attributes get enabled. Do 

the following: 

i. From the Select the items to scan options, select either Scan executable files option 

or Scan all files option. Scanning of all files takes a longer time. 

ii. The Scan packed files and Scan archive files check boxes are selected, by default. 

You can select the Scan mailboxes check box if required. 

iii. In Archive Scan Level, set the scan level. You can set the level for scanning in an 

archive file up to 16. The default scan level is 2. Increasing the default scan level may 

affect the scanning speed. 

iv. To remove an infected file from your system, Select action from the drop down list:  

– Select action when a virus is found in the archive file, whether you want to delete, 

quarantine, or skip the file. 

– Select action when a virus is found in your active folder/drives, whether you want 

to delete, quarantine, or skip the file. 

d. Under Antimalware Scan Settings, Perform Antimalware scan is selected, by default.  

e. Select action when a malware is found, whether you want to clean or skip the file. The 

action selected here will be taken automatically. 
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f. Under Boot Time Scan Settings, Perform Boot Time Scan is selected, by default. The Select 

Boot Time Scan Mode option is activated. Select one of the following scan options:  

• Quick Scan 

• Full System Scan 

g. After configuring the scan setting, click Apply Changes. 

The new setting is applied. You can reset the Scan setting to default with Reset button, if 

required. 

Note: 

• Scan packed files, Scan mailboxes, Antimalware Scan Settings, and Boot Time Scan 

Settings are available only in the clients with Windows operating systems. 

• Notification for Scan from the SEQRITE Endpoint Security console will not be sent if the 

user is not logged on to the Mac system. 

Update 

SEQRITE releases updates regularly to fix technical issues and provide protection against new 

threats. Hence, it is recommended that you update the virus definitions of your software 

protection regularly. Using this feature, you can take the update remotely. 

To take the update, follow these steps: 

1. On the Status page, select the endpoints you want to update. 

2. The client action bar is enabled above the table. In the Client Actions list, select Update. 

3. Click Submit. The action will be initiated on the client as per the set polling interval.  

The selected endpoints are updated with the latest virus definitions. 

Tuneup 

This facility improves the performance of the endpoints by defragmentation and by cleaning 

unwanted and junk files and invalid and obsolete registry entries. While you work in 

applications, computers write junks on the drives or when you visit any Websites, the 

temporary files are created on your computer. Such junks and files occupy spaces in the 

memory resulting in slowing down of the endpoints. Tuning up your computers cleans up these 

files by improving their performance. 

Tuneup settings allow you to carry out different types of clean-ups such as; disks, registry 

entries, or schedule a defragmentation at next boot. 

Disk Cleanup: Helps you find and remove invalid and unwanted junk files from the hard disk. 

These files consume hard disk space and slow down the system considerably. Disk Cleanup 

deletes these files and provide free space that can be used for other applications and helps in 
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improving system performance. This feature also deletes temporary files, Internet cache files, 

improper shortcut files, garbage name files, and empty folders. 

Registry Cleanup: Helps you remove invalid and obsolete registry entries from the system, such 

entries may appear due to improper uninstallation, non-existent fonts, etc. Sometimes during 

uninstallation, the registry entries are not deleted. This leads to slower performance of the 

system. The Registry Cleanup removes such invalid registry entries to increase the performance 

of the system. 

Defragment: Helps you defragment vital files, such as page files and registry hives for improving 

the performance of the endpoint. Files are often stored in fragments in different locations 

slowing down the system performance. Defragmentation reduces the number of fragments and 

clubs all the fragments into one contiguous chunk to improve your endpoint performance. 

Note: The Tuneup feature is available only in the clients with Windows Desktop operating 

systems. The Tuneup feature is not available for Windows Server operating system.  

To tune up the endpoints, follow these steps: 

1. On the Status page, select the endpoints you want to tuneup. 

2. The client action bar is enabled above the table. In the Client Actions dropdown, select 

Tuneup. 

3. In the Please Select dropdown, select Start Scan. 

4. Click Submit. Start Scan dialog appears. 

Click Start Scan to start the scan of the selected endpoints. The action will be initiated on 

the client as per set polling interval. 

Tuneup notifications are sent to the selected endpoints and tune up is performed on those 

endpoints. 

You can stop Tuneup activity by clicking Stop Scan at any time you prefer. 

You can customize the Tuneup settings if required. 

5. To customize the Tuneup settings, click Tuneup Settings. 

6. Select any of the following: 

• Disk Cleanup 

• Cleanup 

• Defragment at next boot 

However, all these options are selected by default. 

7. To save your settings, click Apply Changes. You can reset the Tuneup settings to default 

with Reset button, if required. 
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Temporary Device Access 

This feature allows you to permit temporary access to a device on the client for a specific 

period. If a user wants temporary access to a device on the client, the user can send a request 

to the Administrator to grant temporary access. The Administrator will generate OTP and will 

share with the user. The client uses this OTP to access the device for the specific period. 

To enable Temporary Device Access, follow these steps: 

1. On the Status page, select the endpoints to send the temporary device access request.  

2. The client action bar is enabled above the table. In the Client Actions list, select Temporary 

Device Access. 

3. Click Submit. 

4. On the Temporary Device Access dialog, in the Allow temporary access for list, select 

minutes. 

5. In the Use OTP within list, select minutes. 

6. Click Generate OTP. The OTP appears. 

7. Click Notify By Email and the email containing the OTP is automatically received by the 

client. Temporary access is allowed as per the settings effective from that minute. The 

action will be initiated on the client as per set polling interval. 

At the client side, after successful validation of the OTP, temporary device access is enabled 

for the specific period. 

Enumerate Network 

This feature allows you to get a list of all the unmanaged endpoints available in the client 

network. 

To generate a list of unmanaged endpoints, follow these steps: 

1. On the Status page, select the endpoints to send the request. 

2. The client action bar is enabled above the table. In the Client Actions list, select Enumerate 

Network. 

3. Click Submit. The action will be initiated on the client as per set polling interval. 

The enumeration result will appear on the EPS console dashboard based on the Heartbeat 

interval set for the client. You can view the enumeration results on the dashboard widget 

only. 

Remote Uninstall 

With Remote Uninstall, you can initiate remote uninstallation of Seqrite client along with the 

antivirus program from the computers on your network. 

To uninstall the client through Remote Uninstall, follow these steps:  
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1. On the Status page, select the endpoints you want to uninstall. 

2. The client action bar is enabled above the table. In the Client Actions list, select Remote 

Uninstall. 

3. In the Please Select dropdown, select Start. 

4. Click Submit. 

The uninstallation initiates on the selected endpoints as per set polling interval. 

To stop the remote uninstallation, In the Client Actions list, select Remote Uninstall > Stop. 

Click Submit. The Stop command will be executed only if the uninstallation is not started. 

Email notification will be received when client uninstallation is successful if you have enabled 

the settings of Client Deployment on the Notification page. 

DLP 

Assign DLP License 

This feature allows you to assign Data Loss Prevention (DLP) license to the selected endpoint.  

To assign the DLP license, follow these steps: 

1. On the Status page, select the endpoints you want to assign the DLP license. 

2. The client action bar is enabled above the table. In the Client Actions list, select DLP. 

3. In the Please Select dropdown, select Assign DLP License. 

4. Click Submit. 

5. A confirmation message appears. Click OK. 

The DLP license is assigned to the selected endpoint. On the Status page, the legend for DLP 

License Assigned is displayed for the respective endpoints. 

Revoke DLP License 

This feature allows you to revoke the DLP license to the selected endpoint. 

To unassign the DLP license, follow these steps: 

1. On the Status page, select the endpoints you want to unassign the DLP license. 

2. In the Client Actions dropdown, select DLP. 

3. In the Please Select dropdown, select Revoke DLP License. 

4. Click Submit. 

5. A confirmation message appears. Click OK. 

The DLP license is unassigned to the selected endpoint. 
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Data-At-Rest Scan 

Using Data-At-Rest Scan, you can scan and detect any confidential data present in your 

endpoints and removable devices. You can scan the desired location such as drive, folder, or 

removable devices on the endpoints and detect the confidential or sensitive information 

present. You can view the information related to the detected confidential data such as the file 

path, threat type, and matched text. 

Note: To perform Data-At-Rest scan, you must enable DLP on the endpoints. 

Start Data-At-Rest Scan 

To initiate scanning, follow these steps: 

1. On the Status page, select the endpoints you want to scan. 

2. The client action bar is enabled above the table. In the Client Actions list, select DLP. 

3. In the Please Select dropdown, select Start Data-At-Rest Scan. 

4. Click Submit. 

Start Scan dialog appears. 

Click Start Scan to start the scan of the selected endpoints. The action will be initiated on 

the client as per set polling interval. 

The selected endpoints are scanned for compliance. 

You can customize the Data-At-Rest scan settings if required. 

Customize the DAR scan settings 

1. To customize the DAR scan settings, click Data-At-Rest Scan Settings and select one of the 

following: 

• Quick Scan: Select this option to scan the drive on which your operating system is 

installed. 

• Full System: Select this option to scan all the drives. 

• Scan Specific Folder(s): Select this option to scan a particular folder(s). To scan specific 

folder, follow these steps: 

a. Click Configure. 

b. Enter the path of the folder that you want to scan. 

c. Click Add. 

d. You can also choose to scan the subfolders by selecting the Include Subfolder check box. 

e. You can also remove a path from the list by clicking Delete. 

f. Click Apply. 
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2. Select Scan Priority. The Scan Priority is Normal by default. You can change the priority to 

Low or High, if required. 

3. In the Select data to scan section, click the File Types tab. 

4. Select the file types (format) that you want to scan. 

5. Click the Confidential Data tab. 

6. Select the Confidential Data to scan. 

7. Click the User Defined Dictionaries tab and select the User Defined Dictionaries to scan. 

8. Click Apply Changes. 

9. You can reset the DAR scan settings to default with Reset button, if required. 

10. Click Start Scan. 

Note: Email Notifications are not supported for Data-At-Rest Scan feature. Data-At-Rest Scan 

feature will be available only if DLP feature pack is enabled for that EPS server.  

Exclusion 

You may exclude folders for scanning. 

To exclude the folder, enter the name of the folder in the text box and click Add. 

To remove the folder from the excluded folders list, select the folder from the list and 

click Delete. 

Stop Data-At-Rest Scan 

To stop Data-At Rest scanning, follow these steps: 

1. On the Status page, select the endpoints you want to stop Data-At-Rest scan. 

2. The client action bar is enabled above the table. In the Client Actions list, select DLP. 

3. In the Please Select dropdown, select Stop Data-At-Rest Scan. 

4. Click Submit. 

The Stop command has been sent. 

Update Agent Role 

This feature allows you assign update agent role to the selected endpoint. The Update Agent 

downloads and manages the updates for Seqrite Endpoint Security. The Update Agent provides 

you the flexibility to download the updates on a single machine. All the Seqrite Endpoint 

Security clients fetch the updates from this centralized location. It also provides the facility of 

automatically updating Seqrite Endpoint Security clients for enhancements or bug fixes.  

To assign the update agent role, follow these steps: 

1. On the Status page, select the endpoints you want to assign the update agent role.  
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2. The client action bar is enabled above the table. In the Client Actions dropdown, 

select Update Agent Role. 

3. In the Please Select dropdown, select Assign. 

4. Click Submit. 

5. The Update Agent Role dialog appears. Here you can select either option Domain Name or 

IP address to assign the update agent role. For more than 500+ endpoints, select IP address. 

As per your selection, Update Manager URL will be created and shared. 

6. A confirmation message appears. Click OK. 

7. The update agent role is assigned to the selected endpoint. On the Status page, the legend 

for Update Role Assigned is displayed for the respective endpoint. 

Update Agent will be installed on Domain Name or on IP address as per configuration.  

Revoke Update Agent Role 

This feature allows you to revoke the update agent role for the selected endpoint.  

To revoke the update agent role, follow these steps: 

1. On the Status page, select the endpoints for which you want to revoke the update agent 

role. 

2. In the Client Actions dropdown, select Update Agent Role. 

3. In the Please Select dropdown, select Revoke. 

4. Click Submit. 

5. A confirmation message appears. Click OK. 

The update agent role is revoked for the selected endpoint. 

Delete Backup Data 

Data Backup feature automatically takes a backup of files for ransomware protection. This 

feature takes backup as per predefined configuration in the Miscellaneous policy. Here you can 

delete the backup data. For more information, see Miscellaneous policy. 

To delete Backup Data, follow these steps: 

1. On the Status page, select the endpoints for which you want to delete the backup data.  

2. The client action bar is enabled above the table. In the Client Actions list, select Delete 

Backup Data. 

3. In the Please Select list, select one of the following: 

• Old Backup Data – Backup taken by the older clients on this endpoint 

• Current Backup Data – Backup taken by the current client on this endpoint 
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4. Click Submit. The action will be initiated on the client as per the set polling interval.  

The backup data will be deleted. 

Assign Custom Policy 

This feature allows you to assign custom policy to the selected endpoint. You can override the 

settings of Container policy by selecting the custom policies. 

To assign custom policy, follow these steps: 

1. On the Status page, select the endpoints you want to assign the policy. 

2. The client action bar is enabled above the table. In the Client Actions list, select Assign 

Custom Policy. 

3. Click Submit. The Assign Custom Policy dialog appears. The list of custom policies appears. 

Select the policies and click Assign. 

The policies are assigned to the selected endpoint. You can view the assigned policies on the 

Status page and in the Assign Custom Policy dialog. 

Upgrade Clients 

To upgrade the clients, follow these steps: 

1. On the Status page, select the endpoints you want to upgrade the clients. 

2. The client action bar is enabled above the table. In the Client Actions list, select Upgrade 

Clients. 

3. Click Submit. The action will be initiated on the client as per the set polling interval.  

The client will be upgraded with the latest version. 

Application Control 

This feature allows you to check whether security compliance policies framed by your 

organization are being followed on each endpoint. It also helps you in verifying whether 

endpoints have any unauthorized applications other than the authorized ones running on them. 

The Application Control scan is done in the following two ways, 

• When you request the scan through Client Action. For details, see Application Control 

Scan explained below. 

• When you set the Application Control policy. ‘On access’ reports are generated in this 

case. For details, see Application Control policy. 

Application Control Scan 

To initiate scanning, follow these steps: 

1. On the Status page, select the endpoints you want to scan. 
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2. The client action bar is enabled above the table. In the Client Actions dropdown, 

select Application Control. 

3. In the Please Select list, select Start Scan. 

4. Click Submit. Start Scan dialog appears. 

5. Click Start Scan to start the scan of the selected endpoints. The action will be initiated on 

the client as per set polling interval. You can stop scanning by clicking Stop Scan at any time 

you prefer. You can customize the scan settings if required. 

6. To customize the scan settings, click Application Control Settings. 

7. Select one of the following scan options: 

• Unauthorized applications: Helps you initiate scanning only for the unauthorized 

applications present on a client machine. 

• Unauthorized and authorized applications: Helps you initiate scanning for both, 

unauthorized and authorized applications present on the client machine. 

• All installed applications: Helps you initiate scanning for all applications installed on a 

client. 

Scanning by first two options may take longer time. 

8. Select Scan Priority. The Scan Priority is Normal by default. You can change the priority to 

Low or High, if required. 

9. After configuring the scan setting, click Apply Changes. 

The new setting is applied. You can reset the Scan setting to default with Reset button, if 

required. 

Vulnerability Scan 

This feature helps you to set vulnerability scan for the clients so that the clients are scanned for 

possible vulnerabilities. This scan helps for vulnerability assessment of the operating system on 

the client. 

To initiate vulnerability scan, follow these steps: 

1. On the Status page, select the endpoints you want to scan. 

2. The client action bar is enabled above the table. In the Client Actions drop down, select 

Vulnerability Scan. 

3. In the Please Select list, select Start Scan. 

4. Click Submit. 

Start Scan dialog appears. 
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5. Click Start Scan to start the scan of the selected endpoints. The action will be initiated on 

the client as per set polling interval. 

You can stop scanning by clicking Stop Scan at any time you prefer. 

You can customize the vulnerability scan settings if required. 

6. To customize the scan settings, click Vulnerability Scan Settings. 

7. Under Scan Type, select one of the following options to scan for vulnerability against 

following software vendors 

• Microsoft applications and other vendor applications 

• Microsoft applications only 

• Other vendor applications only 

8. The Scan Priority is Normal by default. You can change the priority to Low or High, if 

required. 

9. The Scan Severity is Low by default. You can change the priority to Medium or High, if 

required. 

10. After configuring the scan setting, click Apply Changes. 

The new setting is applied. 

You can reset the Scan setting to default with Reset button, if required. 

Move to Group 

This feature allows you to move the selected endpoint to a group. 

To move the endpoint, follow these steps: 

1. On the Status page, select the endpoints you want to move. 

2. The client action bar is enabled above the table. In the Client Actions list, select Move to 

Group. 

3. Click Submit. The Assign to Group dialog appears. 

4. Select a group/subgroup where you want to move the selected endpoint. 

5. Click Move. 

6. A confirmation message appears. Click OK. 

The policies of the parent group are applied to the moved endpoint. 

Remove Selected Endpoints 

This feature allows you to remove the clients from a group. 

To remove the client, follow these steps: 
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1. On the Status page, select the endpoints you want to remove. 

2. The client action bar is enabled above the table. In the Client Actions dropdown, 

select Remove Selected Endpoint(s). 

3. Click Submit. 

4. A confirmation message appears. Click OK. 

The endpoints are removed. 

Debug Log 

Important: This feature is applicable only for the Mac clients.  

This feature allows you to enable Web Security logs under the product installation directory.  

If any issue occurs on the Mac client related to Web Security, then enable debug log from here. 

Generate the issue and collect the logs from /Library/Application Support/Seqrite/Seqrite/logs.  

The log file name is ’emlprod.logs’. Share the emlprod.logs file with Seqrite team for further 

analysis. 

Enable Debug Logs 

To enable Debug Logs, follow these steps: 

1. On the Status page, select the Mac endpoints for which you want to enable Debug Logs.  

2. The client action bar is enabled above the table. In the Client Actions drop down, 

select Debug Logs. 

3. In the Please Select drop down, select Enable. 

4. Click Submit. 

As per heartbeat interval set for the client, emlprod.logs start to generate. 

Seqrite recommends disabling the ‘Debug Logs’ once the required logs have been collected. 

Failure to do so may result in a slowdown of the Mac system or potential system hang-ups if the 

log size increases. 

Disable Debug Logs 

To disable Debug Logs, follow these steps: 

1. On the Status page, select the Mac endpoints for which you want to disable Debug Logs.  

2. The client action bar is enabled above the table. In the Client Actions drop down, 

select Debug Logs. 

3. In the Please Select drop down, select Disable. 

4. Click Submit. 
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As per heartbeat interval set for the client, log creation will be stopped. 
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Deployment 

The Deployment page helps you to deploy the Endpoint Security client on different endpoints.  

Deployment Methods 

Select one of the following methods to deploy the Endpoint Security client as applicable. A brief 

about each method is mentioned below. 

• Online Installer: Create and download client installer for manual installation. 

• Standalone Installer: Download Standalone Installer and then create a client installer.  

• Email Install Link: Send e-mail notification containing URL to install the client. 

• Remote Installer: Download Remote Installer, which helps you to remotely deploy 

SEQRITE Endpoint Security clients on Microsoft Windows and Mac endpoints. 

• Active Directory: Download Active Directory Tool, which helps you to deploy SEQRITE 

Endpoint Security clients with help of active directory synchronization. 

The following table shows different operating systems that support the client 

deployment methods: 

Features Clients 
 

Windows Mac Linux 

Online Installer Yes Yes Yes 

Standalone Installer Yes Yes Yes 

Email Install Link Yes Yes No 

Remote Installer Yes Yes No 

Active Directory Yes No No 

This page helps you to create and download the Client Installer for manual installation of client 

on different endpoints. 

Automatic uninstallation of EPS clients 

If you start deploying client on the endpoints which already has on-premises EPS client, the on-

premises client will be uninstalled and SEQRITE Endpoint Security client will be installed on the 

endpoint. 

This feature is available in the clients with Windows and Mac operating systems. 

Supported EPS Versions 

• Windows client – EPS version 6.0 and later 

• Mac client – EPS version 6.4 and later 



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  52 

System Requirements for Client 

For Installing SEQRITE Endpoint Security client through client install utility, the System 

requirements are as follows: 

Any one of the following operating systems: 

Windows OS 

• Microsoft Windows 2008 Server R2 Web / Standard / Enterprise / Datacenter (64-bit) 

• Microsoft Windows 7 Home Basic/ Premium / Professional / Enterprise / Ultimate (32-

bit/64-bit) 

• Microsoft Windows SBS 2011 Standard / Essentials 

• Microsoft Windows Server 2012 R2 Standard / Datacenter (64-bit) 

• Microsoft Windows Server 2012 Standard / Essentials / Foundation / Storage Server / 

Datacenter (64-bit) 

• Microsoft Windows 8.1 Professional / Enterprise (32-bit/64-bit) 

• Microsoft Windows 10 Home / Pro / Enterprise / Education (32-Bit / 64 -Bit) 

• Microsoft Windows 11 

• Microsoft Windows Server 2016 

• Microsoft Windows Server 2019 (64-bit) 

• Windows 10 November 2019 Update 

• Microsoft Windows Server 2022 Standard / Datacenter / Essentials 

Note:  

• For Windows 2008 Server R2, you need to install updates, please 

See KB4474419 and KB4490628. 

• For Windows 7, you need to install updates, please See KB4474419 and KB4490628. 

• For Windows 2016, Windows Server 2019 and Server 2022, you need to uninstall 

Windows Defender. 

MAC 

• Processor: Intel core or Apple’s M1, M2 chip compatible 

• Mac OS X 10.12, 10.13, 10.14, 10.15, 11, 12, 13 and 14 

Linux 32-bit 

• GNU C Library 2.5 and later 

https://www.catalog.update.microsoft.com/search.aspx?q=kb4474419
https://www.catalog.update.microsoft.com/search.aspx?q=KB4490628
https://www.catalog.update.microsoft.com/search.aspx?q=kb4474419
https://www.catalog.update.microsoft.com/search.aspx?q=KB4490628
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• SAMBA version 4.16 and earlier 

Supported Distributions for EPS client: 

• Debian 9, 10 

• Ubuntu 14.04,16.04 

• Boss 6.0 

• Linux Mint 19.3 

Linux 64-bit 

• GNU C Library 2.5 and later 

• SAMBA version 4.16 and earlier 

Supported Distributions for EPS client: 

• Fedora 30, 32 

• Linux Mint 19.3, 20 

• Ubuntu 16.04, 18.04, 20.4, 22.04 

• Debian 9, 10 

• CentOS 7.8, 8.2 

• RHEL 7.5, 7.8, 8.2, 8.6 Enterprise 

• SUSE Linux 12. SP4 / Enterprise Desktop 15 

• Rocky Linux 8.4 

• Boss 6.0, 8.0, 9.0 

• Oracle Linux 7.1, 7.9 and 8.1 

General Requirements 

Windows 

Processor 

• Minimum: 1 GHz 32-bit (x86) or 64-bit (x64) processor 

• Recommended: 2 GHz 32-bit (x86) or 64-bit (x64) processor 

RAM 

• Minimum: 1 GB 

• Recommended: 2 GB free RAM 

Hard disk space 
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• 3200 MB free space 

Web Browser 

• Internet Explorer 7 or later 

Network protocol: 

• TLS 1.2 

MAC 

Processor 

• Intel core or Apple’s M1, M2 chip compatible 

RAM 

• Minimum: 512 MB 

• Recommended: 2 GB free RAM 

Hard disk space 

• 1200 MB free space 

Linux 

Processor 

• Intel or compatible 

RAM 

• Minimum: 512 MB 

• Recommended: 1 GB free RAM 

Hard disk space 

• 1200 MB free space 

Note:  

• For installing the client on Window 2016 OS, uninstall Windows Defender with the 

following link, See docs.microsoft.com/en-us/windows/security/threat-

protection/windows-defender-antivirus/windows-defender-antivirus-on-windows-

server-2016#install-or-uninstall-windows-defender-av-on-windows-server-2016 

• From EPS Cloud 1.6 onwards, Apple M1 chip is supported and from version 1.8 onwards, 

Apple M1, M2 chip is supported. 

• From version 1.6 onwards, Seqrite EPS Cloud uses only SHA2 Certificate for code-

signing. For more details on patches mandated by Microsoft, click 

here https://bit.ly/3vqRhKU 

https://docs.microsoft.com/en-us/windows/security/threat-protection/windows-defender-antivirus/windows-defender-antivirus-on-windows-server-2016#install-or-uninstall-windows-defender-av-on-windows-server-2016/
https://docs.microsoft.com/en-us/windows/security/threat-protection/windows-defender-antivirus/windows-defender-antivirus-on-windows-server-2016#install-or-uninstall-windows-defender-av-on-windows-server-2016/
https://docs.microsoft.com/en-us/windows/security/threat-protection/windows-defender-antivirus/windows-defender-antivirus-on-windows-server-2016#install-or-uninstall-windows-defender-av-on-windows-server-2016/
https://www.seqrite.com/blog/seqrite-announces-sha-1-deprecation-for-its-products
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Online Installer 

The Online Installer will take you to next dialog to build Client Installer set up. This may take a 

longer time to download the Client Installer set up. 

To create a new client installer, follow these steps: 

1. Click the Create Client Installer button to create the Client Installer. 

2. In the Create Client Installer window that opens, enter the required information in 

the Create Installer, Proxy Settings, Set Password tabs. 

3. Click Create. 

The Client Installer is ready for download. 

To install SEQRITE Client, see Installing SEQRITE Client. 

Standalone Installer 

The standalone installer will download a Client Installer. If network speed is slow and you want 

to create client installer faster, use this option. This requires at least one system with Windows 

platform. 

To create a new client installer, follow these steps: 

1. Click Standalone Installer button. 

2. The Client Installer zip file is downloaded. Extract the files. 

3. Execute the Installer. 

4. In the Client Installer, enter the required information in the Create Installer, Proxy Settings 

and Password tabs. 

5. Click Create. 

A help file is provided in the Client Installer. 

To install SEQRITE Client, see Installing SEQRITE Client. 

Email Install Link 

This facility allows you to send an email with a Client Installer download link for client 

installation to the endpoints. 

To send Email with the link, do the following, 

1. In the To text box, enter the Email address. 

2. Click Send Email. A confirmation message appears. 

3. Click OK. The Email is sent from the EPS console. 
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Installing SEQRITE Client on Windows 

1. Open the link in the Email on Windows system. 

2. Download Windows client. The cainstlr.zip file is downloaded. 

3. Extract the zip file. 

4. Execute camininst.exe file. This installs clients on the system. 

5. After SEQRITE client installation is finished, the SEQRITE Antivirus installation will be 

initiated by the SEQRITE client. 

Installing SEQRITE Client on Mac 

1. Open the link in the Email on Mac system. 

2. Download Mac client. The tar file is downloaded. 

3. Extract the tar file. 

4. Execute MCLAGNT.DMG file. This installs clients on the system. 

5. After SEQRITE client installation is finished, the SEQRITE Antivirus installation will be 

initiated by the SEQRITE client. 

Remote Installer 

This page helps you to download Remote Installer Utility, which allows you to remotely deploy 

SEQRITE Endpoint Security on all supported Windows and Mac endpoints. 

Installing SEQRITE Windows Client 

To do remote Installation on multiple Windows endpoints, follow these steps: 

1. Download Remote Installer. 

2. Run Remote Installer. 

3. You can initiate remote installation in one of the following ways:  

• Add endpoints by selecting from the list 

• Add by IP Address 

4. Enter the IP Address. 

5. Click Add to add endpoints. 

6. In the Add User dialog, type the User Name and Password with Administrator privilege. 

7. Click Finish to add all selected endpoints to the installation list. 
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8. Click Install to initiate installation. 

This feature allows you to deploy the client on all supported Windows operating systems at 

a time. 

Installing SEQRITE Mac Client 

You can install SEQRITE Mac client in one of the following ways:  

• Installing using Apple Remote Desktop or Casper 

• Connecting remotely using Secure Shell 

▪ Using Terminal (for Mac and Linux OS) 

▪ Using PuTTY (for Windows OS) 

Creating Mac Client Installer 

To create Mac client installer, follow these steps: 

9. On the SEQRITE Endpoint Security, go to Deployment. 

10. In the Client Installer tab, click Create Client Installer button. The Create Client Installer 

dialog opens. 

11. Enter Package Name and select Group. 

12. In the OS platform list, select Mac. 

13. Select validity period in the list box. The validity period can be of 30, 60 or 90 days.  

14. Click Create. The .TAR file is created. 

The installer without AV setup is created and appears in the list on Deployment > Client 

Installer page. You can download this installer. 

Note: With Standalone Installer, you can create Mac client installer with antivirus setup. 

Installing using Apple Remote Desktop or Casper 

Apple Remote Desktop (ARD) helps you to connect to the Mac client computers remotely in the 

network, send software to them, install software on them, help other end users in real time, 

and perform various tasks. 

Prerequisites 

Before you install SEQRITE Mac client, ensure the following requirements. 

• The administrator computer with ARD or Casper installed must have Mac OS X 10.12 or 

later / OS X server. 

• Mac SEQRITE Client installer must be created on SEQRITE Endpoint Security. To know 

about how to create client installer, see Creating Mac client mentioned above. 

• Administrator must have an account on the Mac client computers with admin privileges.  
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• Enable Remote Management on the Mac client computers. 

• Your administrator computer must have Packages installed on it. Packages is a Mac OS 

application that helps you to create bundle for your payload and installation. To 

download Packages, visit http://s.sudre.free.fr/Software/Packages/about.html. 

• For macOS Catalina and above only, do the following on your Mac system,  

1 Open System Preferences.  

2 Go to Security & Privacy > Privacy tab.  

3 Click the lock icon and provide password if it is locked.  

4 Select Full Disk Access in the left pane.  

5 Add the following process in the given path and then select the processes in the  

Security & Privacy Full Disk Access window,  

/Library/PrivilegedHelperTools/fr.whitebox.packages/packages_dispatcher  

Installing Mac client using Apple Remote Desktop or Casper 

This procedure helps you install Mac client on the remote Mac client computers using ARD or 

Casper. For more details, you may refer the documentation of the respective software 

applications. 

Creating Mac Client Package 

1. On the SEQRITE Endpoint Security, download UEMREMOTEINST.TAR from the URL, 

http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST.tar 

2. Download Mac client installer (with/without AV) from the EPS server. These builds will 

be in the TAR format. 

3. Rename the Mac client installer as follows: 

Mac client installer (without AV) – MCCLAGNT.TAR 

4. Extract UEMREMOTEINST.TAR. 

5. Copy MCCLAGNT.TAR or MCCLAGAV.TAR to ‘/UEMREMOTEINST’. 

6. Open Terminal.app on the administrator Mac computer and go to the UEMREMOTEINST 

folder. 

7. Enter the following commands. 

cd ./Remote_Installation/PKG 

sudo sh ./ClientAgentInstaller/CreatePackage.sh 

Note: Administrator rights are required for executing this command. 

When the package creation completes successfully, ClientAgentInstaller.pkg file is created in 

the ./Remote_Installation/PKG/ClientAgentInstaller/ folder. 

http://s.sudre.free.fr/Software/Packages/about.html
http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST.tar
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If the Client Packager is failed to create on macOS Catalina and above, do the following,  

1. Open System Preferences.  

2. Go to Security & Privacy > Privacy tab.  

3. Click the lock icon and provide password if it is locked.  

4. Select Full Disk Access in the left pane.  

5. Select the packages_dispatcher check box.  

6. Now again try to create Client Packager, it will be created successfully. 

Deploying SEQRITE Mac Client using Apple Remote Desktop 

In addition to the Prerequisites described above, follow this prerequisite. 

Prerequisite 

Before deploying SEQRITE Mac client, ensure that you get Apple Remote Desktop (ARD) tool 

installed on your administrator computer. To download ARD, 

visit https://www.apple.com/in/remotedesktop/. 

To deploy SEQRITE Mac client using Apple Remote Desktop, follow these steps:  

1. Open Apple Remote Desktop. 

2. Select the Mac client computers from the list of all available computers and then 

click *Install* to add the package. 

3. Click the plus (+) sign to locate and add ClientAgentInstaller.pkg and then click Install to 

begin deployment. 

Deploy SEQRITE Mac Client using Casper 

In addition to the Prerequisites described above, follow this prerequisite. 

Prerequisite 

Before deploying SEQRITE Mac client, ensure that you get Casper tool installed on your 

administrator computer. Casper helps to install software and run scripts remotely on the client 

computers. To download Casper, visit http://www.jamfsoftware.com/products/casper-suite/. 

To deploy SEQRITE Mac client using Casper, follow these steps: 

1. Log on to Casper Admin. 

2. Drag ClientAgentInstaller.pkg to the window and then select File > Save. 

3. Log on to Casper Remote. 

4. In the Computers tab, select the Mac client computers from the list of available computers. 

https://www.apple.com/in/remotedesktop/
http://www.jamfsoftware.com/products/casper-suite/
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5. In the Packages tab, select ClientAgentInstaller.pkg. 

6. Click Go. 

Connecting Remotely using Secure Shell 

Secure Shell (SSH) is a network protocol that is used to connect to the remote Mac client 

computers over secure data communication through command line to manage client 

computers. 

Using Terminal (for Mac or Linux OS) 

The administrator computer having either Mac or Linux OS can install the client using this 

method. 

Prerequisites 

Before you install SEQRITE Mac client, ensure the following requirements. 

• Administrator must have an account on the Mac client computers with admin privileges.  

• Enable Remote Login and either allow access for all users, or only for specific users, such 

as Administrators. You can find this setting on the Mac computer under System 

Preferences > Sharing > Remote Login. 

• Ensure that the firewall does not block the port that Secure Shell (SSH) uses, which is by 

default TCP port 22. This port allows the required communication for remote login.  

• If you use the Mac firewall, disable stealth mode. With stealth mode enabled, the 

remote push installation cannot discover the client through Search Network. 

• To disable stealth mode on the Mac computers, do the following, 

a. In System Preferences, go to Security and Privacy. 

b. Click the Lock icon and provide password if it is locked. 

c. Select Firewall > Firewall Options. 

d. Clear the Enable stealth mode check box if it is selected. 

e. Click OK. 

• Mac SEQRITE Client installer must be created on the SEQRITE Endpoint Security. 

Installing SEQRITE Mac Client 

To install SEQRITE Mac client using Terminal, follow these steps on the administrator Mac 

computer: 

1. On the SEQRITE Endpoint Security, download UEMREMOTEINST.TAR from the URL, 

http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST.tar 

http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST.ta
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Download Mac client builds (with/without AV) from the EPS server. These builds will be in 

the TAR format. 

2. Rename the Mac client installer as follows: 

• Mac client installer (without AV) – MCCLAGNT.TAR 

3. Extract UEMREMOTEINST.TAR. 

4. Copy MCCLAGNT.TAR or MCCLAGAV.TAR to “< Download directory>/UEMREMOTEINST”. 

Download directory is the directory where you have downloaded and extracted 

UEMREMOTEINST.TAR. 

5. Open Terminal.app and go to the UEMREMOTEINSTRemote_Installation folder. 

6. Enter the following command 

sh ./Scripts/copy.sh 

Parameter description 

sh ./Scripts/copy.sh is static. 

specifies the user name of the remote Mac computer such as ‘test’. 

specifies the IP address of the remote Mac computer such as ‘10.10.0.0’.  

Example: sh ./Scripts/copy.sh “test” “10.10.0.0”  

7. Enter the password of the remote computer to connect to it. 

8. Enter the command sudo sh /tmp/install.sh. 

9. Enter the password of the remote computer when prompted. 

10. A confirmation message appears – "If earlier version of SEQRITE Endpoint Security client is 

found on the system, then it will be uninstalled automatically. Do you want to continue?? 

[Yes/No]:”. 

11. Enter Yes or No. 

• If you enter Yes, installation will proceed. 

• If you enter No, installation will be aborted with message "Option No has been selected. 

Installation aborted." 

12. Enter the command exit to close remote SSH session. 

13. Repeat steps 6 through 10 to install SEQRITE Mac client on a different remote computer.  

Using PuTTY (for Windows OS) 

The administrator computer having Windows OS can install the Mac client using this method.  

Prerequisites 

Before you install SEQRITE Mac client, ensure the following requirements. 
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• Administrator must have an account on the Mac client computers with admin privileges.  

• Enable Remote Login and either allow access for all users, or only for specific users, such 

as Administrators. You can find this setting on the Mac client computer under System 

Preferences > Sharing > Remote Login. 

• Ensure that the firewall does not block the port that Secure Shell (SSH) uses, which is by 

default TCP port 22. This port allows the required communication for remote login.  

• If you use the Mac firewall, disable stealth mode. With stealth mode enabled, the 

remote push installation cannot discover the client through Search Network. 

• To disable stealth mode on the Mac computers, do the following, 

a. In System Preferences, go to Security and Privacy. 

b. Click the Lock icon and provide password if it is locked. 

c. Select Firewall > Firewall Options. 

d. Clear the Enable stealth mode check box if it is selected. 

e. Click OK. 

• Mac SEQRITE client installer must be created on the SEQRITE Endpoint Security. To 

know about how to create client installer, see Creating Mac client Installer. 

Installing SEQRITE Mac Client 

To install SEQRITE Mac client using PuTTY, follow these steps: 

1. On the SEQRITE Endpoint Security, download UEMREMOTEINST.TAR from the 

URL,http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST.tar  

2. Download Mac client builds (with/without AV) from the UEM server. These builds will be in 

the TAR format. 

3. Rename the Mac client installer as follows: 

Mac client installer (without AV) – MCCLAGNT.TAR 

Mac client installer (with AV) – MCCLAGAV.TAR 

4. Extract UEMREMOTEINST.TAR. 

5. Copy MCCLAGNT.TAR orMCCLAGAV.TAR to “/UEMREMOTEINST”. Download directory is the 

directory where you have downloaded and extracted UEMREMOTEINST.TAR. 

6. Open cmd.exe and go to the folder “< Download directory>/UEMREMOTEINST”.  

7. Do one of the following: 

• Enter the following command if antivirus is included in the client installer 

.Remote_InstallationSoftwarespscp.exe . MCCLAGAV.TAR 

http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST.tar
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.Remote_InstallationScriptsinstall.sh username>@<ip_address< 

a="">:/tmp/</ip_address<> 

 

Parameter description 

•  <username>specifies the user name of the remote Mac client computer such as ‘test’. 

•  <ip_address> specifies the IP address of  the remote Mac client computer such as 

‘10.10.0.0’. 

Example: .Remote_InstallationSoftwarespscp.exe   .MCCLAGNT.TAR 

.Remote_InstallationScriptsinstall.sh test@10.10.0.0:/tmp/. 

8. Open .Remote_InstallationSoftwaresputty.exe. 

9. Enter the IP address of the remote Mac client computer and click Open. 

10. In the PuTTY terminal Window, enter the username and password of an administrator user 

on the remote computer. 

11. Upon getting connected to the remote computer, type the following command sudo sh 

/tmp/install.sh. 

12. A confirmation message appears – "If earlier version of SEQRITE Endpoint Security client is 

found on the system, then it will be uninstalled automatically. Do you want to continue?? 

[Yes/No]:”. 

13. Enter Yes or No. 

• If you enter Yes, installation will proceed. 

• If you enter No, installation will be aborted with message "Option No has been selected. 

Installation aborted." 

14. Type the command exit to close SSH connection. 

Repeat steps 6 through 11 to install on a different Mac client computer. 

Note: While installing the Mac client for the first time on Mac OS 10.13 and later, user should 

allow permission for loading the drivers manually when prompted. 
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Active Directory 

This page helps you to download Active Directory Tool. With Active Directory Tool you can 

synchronize the EPS server group with active directory organizational unit 

(OU)/container/computer. After synchronization, the clients will be installed on all the 

endpoints of your domain network. A periodic check is carried out to find if any new endpoint is 

added to your network. When a new endpoint is added, the client gets automatically installed 

on that endpoint. 

You can also exclude certain endpoints from the EPS server group so that the client is not 

installed on these endpoints. 

Note: 

• This installation method is available only with Microsoft Windows operating system. 

• To synchronize the EPS server with Active Directory OU, the Active Directory Tool should 

be installed on the domain machine or should be a member of the domain. 

• Synchronization cannot be done with Default group. 

• On the Groups page, groups are shown with AD tag, which are already synchronized 

with Active Directory. 

• The user should have permissions of Domain Admins to synchronize with Active 

Directory. 

Synchronizing with Active Directory 

To install SEQRITE Active Directory Tool on your computer, follow these steps: 

1. Click Active Directory Installer button. 

2. The Active Directory zip file is downloaded. Extract the files. 

3. Double click adinst.msi file. The Active Directory installer opens and guides you through the 

steps required to install SEQRITE Active Directory Tool on your computer. 

Note: This system should be powered on 24X7 for periodic check in synchronization 

process. 

4. Follow the instructions in the wizard. SEQRITE Active Directory Tool will be installed on your 

computer. 

5. Launch the SEQRITE Active Directory Tool. 

A help file is provided in the SEQRITE Active Directory Tool. 
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Installing Seqrite Client 

The procedure to install SEQRITE Client on different operating systems is as follows: 

Installing SEQRITE Client on Windows 

1. Copy the Client Installer created from Online/Standalone Installer to Windows system. 

2. Extract the zip file on the system. 

3. Execute the installer file. The name of installer file, as per the options selected is as follows,  

• 32-bit with AV – clagav32 

• 32-bit without AV – clagnt32 

• 64-bit with AV – clagav64 

• 64-bit without AV – clagnt64 

• Minimal – minimal.exe 

4. On executing the installer file, the SEQRITE Client Agent is installed. 

Installing SEQRITE Client on Mac 

1. Download the .TAR file from the SEQRITE console. 

2. Extract the tar file. 

3. Double-click the installer file (MCLAGNT.DMG). The Endpoint Security icon is mounted on 

the desktop. 

4. Double click the Endpoint Security icon. An installer window will appear. 

5. Double click the SEQRITE Installer icon in the window. “Verifying Client Agent installer” 

message is displayed. 

6. After the verification is complete, a message appears, "Client Agent Installer” is an app 

downloaded from the Internet. Are you sure you want to open it?”  

7. Click Open button. 

8. Provide username and password of the system when prompted by the installer. 

9. Click OK. 

Note: If password-protected Client Installer is being executed, then it will ask for Client 

Installer password first and then it will ask for System password. 

10. The Client Agent will be installed. A message, “Endpoint Security Client installed successfully” 

appears. 
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11. Click OK. 

The AV will be automatically downloaded and installed in the background. After installation, 

AV will get activated and its status will be sent to the server. 

Note: 

• To install Endpoint Security on macOS Catalina, refer KB article, 

SEQRITE Endpoint Security compatibility with macOS Catalina 

• To install Endpoint Security on Big Sur, refer KB article, 

SEQRITE Endpoint Security supports macOS Big Sur 11 

Installing SEQRITE Client on Linux 

1. Log in as root and go to the terminal. 

2. Go to the directory containing SEQRITE Endpoint Security installation folder and run ./install 

script. The installation script will copy the necessary files to the /usr/lib/SEQRITE/SEQRITE 

folder. 

3. Configure SEQRITE and save your settings. 

Email notification will be received when client installation is successful if you have enabled the 

settings of Client Deployment on the Notification page. 

  

https://techsupport.seqrite.com/index.php?/selfhelp/view-article/seqrite-endpoint-security-compatibility-with-macos-catalina-1015
https://techsupport.seqrite.com/index.php?/selfhelp/view-article/seqrite-endpoint-securitys-compatibility-with-macos-11-big-sur
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Migration Considerations 

Difference between Migration and Upgrade 

Upgrading does not directly affect the data. The data is not moved or touched during an 

upgrade. Whereas migrating data refers to moving data from one database into another 

database. 

The following table provides more information while migrating from the earlier version to the 

later version. 

Category From Version To Version Yes/No Comment 

On Prem EPS 5, 6, up to 7.5 EPS 8.x No – 

 EPS 5, 6, up to 7.5 EPS 7.6 SP5 Yes – 

 EPS 7.6 SP5 EPS 8.0 Yes Only Group and Client 

Migration 

 EPS 7.6 SP5 EPS 8.1 Yes Group, Client, and Policy 

Migration Supported 

 EPS 7.6 SP5 EPS 8.2 Yes Group, Client, and Policy 

Migration Supported 

Over Cloud EPS 7.6 SP5 EPS Cloud 1.6 Yes Only Group and Client 

Migration Supported 

 EPS 7.6 SP5 EPS Cloud 1.7 Yes Group, Client, and Policy 

Migration Supported 

 EPS 7.6 SP5 EPS Cloud 1.8 Yes Group, Client, and Policy 

Migration Supported 

 EPS 7.6 SP5 EPS Cloud 1.9 Yes Group, Client, and Policy 

Migration Supported 

 EPS 7.6 SP5 EPS Cloud 2.0 Yes Group, Client, and Policy 

Migration Supported 

For more details on migration, refer: EPS 7.6 Migration 

For more details on upgrade, refer: UPGRADING-EPS-CLOUD-ENDPOINTS 

 

https://docs.seqrite.com/docs/seqrite-endpoint-security-eps-cloud-2-0/deployment/eps-7-6-migration/
https://techsupport.seqrite.com/index.php?/solutions/view-article/UPGRADING-EPS-CLOUD-ENDPOINTS-TO-THE-LATEST-VERSION
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Note: 

• All the OS that are supported by EPS Cloud 10.6 are supported while migrating. Not 

supported OS are – Win Vista, Win 2003, and Win XP SP1/SP2. 

• The IE11 required for Win 7. 

• Rebooting is required once the migration process is completed. 

• Migration is not applicable for the clients with Linux and Mac operating systems. 

• No migration support for versions previous to EPS 7.6 SP5 to EPS 8.x or EPS Cloud 1.6.x.  

EPS 7.6 Migration 

SEQRITE recommends customers of EPS 7.6 should migrate to SEQRITE EPS 2.0. 

For the current EPS 7.6 customers, SEQRITE is providing a tool to migrate data of clients, 

groups, and policies from EPS 7.6 to EPS 2.0. 

This page will guide you through the step-by-step migration process to migrate EPS 7.6 data of 

clients, groups, and policies to EPS 2.0 This page is active for only 60 days from the activation 

date of Migration feature. 

System Requirements 

• Service Pack 5.0 applied on EPS 7.6 Server and clients  

• Windows and Linux 

For System requirements for Seqrite EPS clients, refer System Requirements. 

 

Important 

• If the OS requirements are not met, the client and groups data will not be migrated to 

EPS 8.1. 

• The client is installed in the default path. You can modify the client installation path, if 
required. If you want to change the path, you should change the path before migration. 
To change the client installation path, go to EPS 2.0 console > Configurations > Client 
Installation. 

Migrating Data 

EPS 7.6 Migration process means migrating the data of clients, groups, and policies from the 

EPS Server 7.6 to the EPS Server 2.0. 

Migrating Clients, Groups, and Policies 

To migrate EPS 7.6 data of clients, groups, and policies to EPS 2.0, follow these steps: 

1. Go to EPS 2.0 console > Deployment > EPS 7.6 Migration page. 

2. Click the Export Tool button. The tool is downloaded. 
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3. Execute the Export Tool on the EPS 7.6 server. 

4. After the Export Tool is executed, ‘Do you want to change export location? [y/n]’, question 
appears. To provide local system path to export data of the Groups and clients, type ‘y’ and 
type the path. 
To export the data to the default path, type ‘n’. The default export path is <installation 
directory>\Seqrite\Endpoint Security 7.60\Admin\Export  
After validating the path, the data is exported in the .DAT format at the set path. 
The Client.dat and Groups.dat files will be zipped automatically to Export.zip by the Export 
Tool. 

5. Go to EPS 2.0 console > Deployment > EPS 7.6 Migration page. 

6. Click the Import Data button. 

The Import Data dialog appears. By default, the Client, Groups, and Policy check boxes are 

selected, so all clients, groups, and policies are imported. 

You can clear the Groups or Policy check boxes if you don’t want to import. If you don’t 

import Groups and you import only Policy, all clients will be imported in the default group. 

The policy will be imported but will not be assigned to any group. 

7. Click Browse to Import Export.zip file. 

8. Click Import. The data is imported successfully. The success message appears. 

Note: 

• Maximum no. of groups to be imported: 999 

• Maximum no. of policies to be imported: 198 

Important: Group and Policy Migration 

• If a duplicate group is found on both EPS 7.6 and EPS 2.0, it will be skipped. But if the 
applied policies are different on duplicate groups, the policy applied on EPS 2.0 
remains the same.  

Example: If ‘Group1’ is present on both EPS 7.6 and EPS 2.0, after migration, the policy 
assigned to Group1 on EPS 2.0 remains the same. 

• While importing the Firewall policy, ensure the following things. 

▪ In EPS 7.6, if multiple Remote IP addresses are added to the Firewall exception, 
then in the imported policy in EPS 2.0 multiple exceptions will be created for 
each IP. 

▪ Domain name exceptions are ignored. 

• If a duplicate name is found in EPS 7.6 and EPS 2.0 of the following components while 

importing, a timestamp will be appended to the imported name. 

▪ Policy 
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▪ Device name 

▪ User Defined Dictionary 

 

9. Applying Migration Service Pack for Windows, do the following. 

a. If you want to change the default client installation path, go to EPS 2.0 console > 

Configurations > Client Installation. Else, client will be installed at default location. 

b. On EPS 7.6 Migration page, click the Client Migration Tool button. 

c. The Client Migration Tool, migrate.zip is downloaded. 

d. Extract the zipped file on the EPS 7.6 server. The extracted folder contains clagnt.dat 

and acsvpack.exe files. 

e. Execute acsvpack.exe on the EPS 7.6 server. 

f. The Client Migration Tool prompt appears. Click Yes. 

If you select Yes, the endpoints will be migrated group-wise. 

If you select No, all the endpoints will be migrated in one go. 

g. The success message appears. Click Ok. 

h. The Migration Service pack is applied on EPS 7.6 server successfully. 

Migrating Group-wise endpoints 

To migrate group-wise endpoints, follow these steps. 

1. Log on to the SEQRITE Endpoint Security 7.6 console. 

2. Go to Clients > Manage Groups. 

3. Select the group from which the endpoints need to be migrated. You can migrate a group 

only once. 

A submenu list appears. 

4. Select Migration to EPS 2.x. 

The confirmation screen appears. 

5. Click Yes. 

6. Restart the endpoint when the restart prompt will appear on the endpoint. You will receive 

2 restart prompts during migration process in case you have not rebooted the system after 

EPS 7.6 client installation. 

The migration feature is applied to the selected parent group and all child subgroups if available. 

All the endpoints under the parent group and child group, if available are migrated to EPS 2.x.  
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For Linux, do the following. 

1. Go to EPS 2.0 console > Deployment > Online Installer page. 

2. Download latest Linux Seqrite Client packager on the Linux client. 

3. The Client Installer tar file is downloaded. Extract the files on the Linux client.  

4. Execute the Installer. Uninstallation of previous version and installation of latest version will 

be done automatically. 

The data of clients, groups, and policies will be migrated successfully.  

Migrated Clients will appear online on the EPS 2.0 console. 

Removing Inactive Clients from EPS 7.6 

The migrated clients appear offline/inactive on the EPS 7.6 Web console. 

To remove inactive clients, follow these steps: 

1. Log on to the Seqrite Endpoint Security 7.6 Web console. 

2. Go to Admin Settings > Clients. 
The Client Installation page appears. 

3. Under Inactive Client Settings, select the Enable automatic removal of inactive 
clients check box. 

4. In the Remove a client if inactive for list, select number of days after which Seqrite 
Endpoint Security considers a Client is inactive. 

5. To apply the setting, click Apply. 

Limitations 

• EPS Migration 7.6 does not support the clients with Mac operating systems. 

• The Default client on the EPS Server will not be migrated to EPS 8.1. 

• Update Agent upgrade is not supported. 

• Master Secondary setup not supported for EPS 8.1. 

• Migration of EPS Users, and reports are not supported.   
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Policies 

Policies feature helps you to create policies that help centrally control and manage the users 

belonging to a group. You can create two types of policies, 

• Container policy – Container policy is a combination of all features. 

• Feature policy – Feature policy is used for specific feature. The feature policy overrides 

the container policy. 

On the Policies page, you can manage policies. 

Creating a New Policy 

To create a new policy, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Policies. The Policies page appears displaying list of policies. 

3. Click Create Policy button. 

4. The Create Policy dialog appears. Enter Policy Name. 

5. Select the Policy Type, either Container Policy or Feature Policy. If you select the Feature 

policy option, select the feature from the list. 

6. Enter Description of the policy. 

7. Click Create. The Policy Settings page appears. Configure the policy. 

8. Click Save Policy. 

The policy is created. 

Deleting a Policy 

To delete a policy, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Policies. The Policies page appears displaying list of policies. 

3. Select the policy that you want to delete, and then click Delete button. A confirmation 

message appears. 

4. If you are sure to delete the selected policy, click YES. 

If the selected policy is applied to a group, it cannot be deleted, and a failure message 

appears. 
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Note: 

• You cannot delete the default policy. 

• If a policy is applied to a group or to an endpoint and you want to delete it, then apply a 

different policy to that group or unassign the policy applied to the endpoint. Then you 

can delete the policy. 

Duplicating a Policy 

To duplicate a policy, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Policies. The Policies page appears displaying list of policies. 

3. Click the duplicate icon of the policy that you want to duplicate. 

4. The duplicated policy appears in the next row. Edit the name of the policy. Click check mark 

icon to save the policy. The selected policy is duplicated. The policy settings remain same. 

You can also change the policy settings if required. 

5. To save your setting, click Save Policy. 

Updating a Policy 

To update a policy, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Policies. The Policies page appears displaying list of policies. The name of the policy 

owner and date of policy creation appears. 

3. Click the edit icon of the policy that you want to update. The Policy Settings page appears.  

4. Update the settings. 

5. To save your setting, click Save Policy. 

Note: You cannot update Default_MSSP policy. 

Schedule Settings 

Scanning regularly keeps the systems clean and safe. In a large organization the client systems 

may be installed in physically separated environments. 

To centrally manage all the systems about how to scan and when to initiate scanning, the 

administrator must have a policy. This feature helps you create policies for scheduling scans for 

the client systems. 

To configure policy for Schedule Settings, follow these steps: 
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1. On the Feature Policy page, you can see the following list of settings with expand sign and 

toggle button. Expand and enable settings that you want to configure. 

• Scheduled Tuneup 

• Scheduled Client Scan 

• Data-At-Rest Scan 

• Asset Management 

• Application Control 

• Vulnerability Scan 

2. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, you can do so by clicking the Reset Default button. 

Scheduled Tuneup 

Scheduled Tuneup setting allow you to carry out different types of cleanups such as; disks, 

registry entries, or schedule a defragmentation at scheduled time at next boot. 

To schedule Tuneup settings, follow these steps: 

1. In Frequency (Weekly), select a day of the week. 

2. In Start At, set time in hours and minutes. 

3. Select the Run task immediately if missed check box if you want to run the scan 

immediately if missed the set schedule. 

4. In Tuneup settings, select either or all of the following options:  

• Disk cleanup 

• Registry cleanup 

• Defragment at next boot 

However, all these options are selected by default. 

Scheduled Client Scan 

This feature allows you to create policies to initiate scanning the clients automatically at a 

convenient time. You can define whether the scan should run daily or weekly, select scan mode 

(Quick Scan, Full System Scan). You can also enable Antimalware while scanning. This will 

supplement other automatic protection features to ensure that the client systems remain 

malware-free. 

1. In Frequency, select either the Daily or Weekly option. 

2. In Start At, set time in hours and minutes. 
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3. Select the Run task immediately if missed check box if you want to run the scan 

immediately if missed the set schedule. 

Note: 

• Missed schedule scan is not supported on Windows XP SP3 (32- bit) operating system. 

• For Microsoft Windows Vista and above operating systems, missed schedule scan will 

not work if Schedule task is not run at least once. 

4. In Scanner Settings section, Under How to Scan, select a scan mode from the following: 

a. Quick Scan (Scan Drive where operating system is installed) 

b. Full System Scan (Scan all the fixed drives) 

5. Select Scan Priority. The Scan Priority is Low by default. You can change the priority to 

Normal or High, if required. 

6. Under Select scan mode, to set optimal setting, select the Automatic option. 

7. To set advanced setting, select the Advanced option. 

8. If you select the Advanced option, further settings such as, scan items and scan types are 

activated. 

9. Under Select items to scan, select any of the following: 

• Scan executable files 

• Scan all files (Takes longer time) 

• Scan packed files 

• Scan mailboxes 

• Scan archives files 

10. If you select the Scan archives files option, you can set the following also: 

a. Archive Scan Level: You can set up to level 16. 

b. Select action to be performed when virus is found in archive file: You can select one of 

the actions from Delete, Quarantine, and Skip. 

11. In Select action to be performed when a virus is found section, select an action from the 

following: Repair, Delete, and Skip. 

12. To enable scanning for malware, select the Perform Antimalware scan check box. 

13. In Select action to be performed when malware found, select an action from the 

following: Clean and Skip. 

14. Under Boot Time Scan Settings, select the Perform Boot Time Scan check box. 

15. Select Boot Time Scan Mode option from the following, 
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• Quick Scan (Scan the areas where operating system and applications are installed)  

• Full System Scan (Scan all the fixed drives) 

Boot time scan will be executed whenever the endpoint system restarts. 

Note: Scan packed files, Scan mailboxes, and Antimalware Scan Settings are available only in 

the clients with Windows operating system. 

Data-At-Rest Scan 

With Data-At-Rest scan, you can search for a particular type of data in various formats and 

detect any confidential data that is present in your endpoints and removable devices. To 

perform Data-At-Rest scan, you must enable DLP on the endpoints. To do this, see DLP License. 

1. In Frequency, select either the Daily or Weekly option. 

2. In Start At, set time in hours and minutes. 

3. If you want to repeat scanning of your clients, select Repeat Scan and set the frequency to 

repeat the scan. 

4. Select the Run task immediately if missed check box if you want to run the scan if missed 

the set schedule. 

5. Select a scan mode from the following: 

• Quick Scan (Scan Drive where operating system is installed) 

• Full System Scan (Scan all the fixed drives) 

• Scan Specific Folder(s): Select this option to scan a particular folder(s). 

a. Click Configure. 

b. Enter the path of the folder that you want to scan. You can also choose to scan the 

subfolders by selecting the Include Subfolder check box. 

c. Click Add. You can also remove a path from the list by clicking Remove. 

d. Click Apply. 

6. Select Scan Priority. The Scan Priority is Low by default. You can change the priority to 

Normal or High, if required. 

7. Configure the settings for File Types, Confidential Data, and User Defined Dictionary.  

Asset Management 

Assets Management helps you keep a watch on the system information, hardware information, 

and software installed. You can also view the hardware changes and software changes, if any, 

that are made to the configuration of the systems. 

Select the following check boxes: 
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• Track Software Changes 

• Track Hardware Changes. This check box is selected by default. 

Application Control 

Application Control helps you define schedules to scan applications at a preferred or specified 

frequency. 

To configure Application Control Schedule Scan, follow these steps: 

1. In Frequency, select either the Daily or Weekly option. If you select the Weekly option, 

select the weekday from the list. 

2. In Start At, set time in hours and minutes. 

3. If you want to repeat scanning for the applications, select the Repeat Scan check box and 

set the frequency of interval after which the scan should be repeated. 

4. Select the Run task immediately if missed check box. 

5. Select one of the following scan options: 

• Unauthorized applications: Helps you initiate scanning only for the unauthorized 

applications present on a client machine. 

• Unauthorized and authorized applications: Helps you initiate scanning for both, 

unauthorized and authorized applications present on the client machine. 

• All installed applications: Helps you initiate scanning for all applications installed on a 

client. 

6. Select Scan Priority. The Scan Priority is Low by default. You can change the priority to 

Normal or High, if required. 

Vulnerability Scan 

Vulnerability Scan helps you define schedules to initiate vulnerability scan of the clients as per 

your convenience. 

To configure Vulnerability Scan Schedule Scan, follow these steps: 

1. Select the weekday from the list. 

2. In Start At, set time in hours and minutes. 

3. If you want to repeat scanning for the applications, select number of weeks to repeat the 

scan. 

4. Select the Run task immediately if missed check box. 

5. Under Scan and report, select one of the following options to scan for vulnerability against 

following software vendors: 

• Microsoft applications and other vendor applications 
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• Microsoft applications only 

• Other vendor applications only 

6. Select Scan Priority. The Scan Priority is Normal by default. You can change the priority to 

Low or High, if required. 

7. Select Scan Severity . The Scan Severity is High by default. You can change the priority to 

Low or Medium, if required.You can reset the Scan setting to default with Reset Default 

button, if required. 

Feature Policies 

Scan 

This feature allows you to define a policy on how to initiate the scan of the endpoints. The 

policy can be refined to enable Virus Protection or DNA scanning or include blocking of any 

suspicious packed files, and other settings. 

To configure policy for Scan, follow these steps: 

1. Create Container/feature policy for Scan. 

2. On the Feature Policy page, you can see the following list of settings with expand sign and 

toggle button. Expand and enable settings that you want to configure. 

• Scanner 

• Virus Protection 

• Exclude Files and Folders 

• Exclude Extensions 

• Advanced DNA Scan 

• Disconnect Infected Endpoints from the network 

• Block suspicious packed files 

• Automatic Rogueware Scan 

• Scan External Drive 

• Autorun Protection 

3. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, you can do so by clicking the Reset Default button. 
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Scanner 

Under Scanner, you can select either of the following scanning options:  

• Automatic: This is the default scan setting that ensures optimum protection to the 

clients. 

• Advanced: If you select this option, you may further need to customize the 

configuration of scanning options as per your requirement. When you select this option, 

other features are activated that are described as follows: 

Features Description 

Select items to scan Select either of the options to scan:  

• Scan executable files: Includes scanning of 

executable files only.  

• Scan all files: Includes scanning of all files, but 

takes longer time for scanning. 

Scan Packed Files Scans packed files inside an executable file. 

Scan Mailboxes Scans emails inside the mailbox files. 

Scan Archive Files Scans compressed files such as ZIP and ARJ files 

including other files. 

Archive Scan Level You can set the level for scanning in an archive file. The 

default scan level is set to 2. You can increase the scan 

level up to 16, however, that may affect the scanning 

speed. 

Action to be performed when virus is 

found in archive file. 

You can select an action that you want to take when a 

virus is found in archive file during an on-demand scan. 

You can select any one of the following actions: ·  

• Delete – Deletes the entire archive file even if a 

single file within the archive is infected.  

• Quarantine – Quarantines the archive 

containing the infected files.  

• Skip – Takes no action even if a virus is found in 

an archive file. 

Action to be performed when a virus 

is found. 

You can select an action that you want to take when a 

virus is found during manual scan. You can select any 

one of the following actions: ·  

• Repair – All the infected files are repaired 

automatically. The files that are not repairable 
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are deleted. ·  

• Delete – All the infected files are deleted 

automatically. ·  

• Skip – Takes no action even if a virus is found in 

a file. 

Virus Protection 

This feature helps you continuously monitor the endpoints against viruses that may infiltrate 

from sources such as email attachments, Internet downloads, file transfer, and file execution. 

By default, Virus Protection is enabled to keep the endpoints clean and secure from any 

potential threats. 

Features Description 

Load Virus protection 

at Startup 

Enables real-time protection to load every time the system is 

started. 

Display Alert 

messages 

Displays an alert message with virus name and file name, 

whenever any infected file is detected by the virus 

protection. 

Report source of 

infection 

Displays the source IP address of the system where the virus 

is detected. 

Select action to be 

performed when a 

virus is found 

You can select an action that you want to take when a virus 

is found during manual scan. You can select any one of the 

following actions:  

• Repair – All the infected files are repaired 

automatically. The files that are not repairable are 

deleted. 

• Delete – All the infected files are deleted 

automatically. 

• Deny Access – Access to an infected file is blocked. 

Exclude Files and Folders 

This feature helps you decide which files and folders should be omitted from scanning for 

known viruses, Advanced DNA Scan, and Suspicious Packed files. It is helpful in case you trust 

certain files and folders and want to exclude them from scanning. 

To add a file or a folder, follow these steps: 

1. In Exclude File and Folders section, click Add. 

2. On the Exclude Item screen, select either of the following: 



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  81 

• Exclude Folder: If you select Exclude Folder, type the folder path in the Enter folder path 

text box. If you want to exclude a subfolder also from scanning, select Include Subfolder.  

• Exclude File: If you select Exclude File, type the file path in the Enter file path text box. 

• Exclude MD5 checksum: If you select Exclude MD5 Checksum, type the checksum in 

Exclude MD5 Checksum text box. MD5 checksum is a 32-character hexadecimal number 

which is the fingerprint of the file. With MD5 checksum, you can verify whether your 

downloaded file got corrupted or not in transit. 

3. In Exclude from section, select the following options as per your requirement:  

• Known Virus Detection 

• DNAScan 

• Suspicious Packed Files Scan 

• Behavior Detection 

• Anti-Ransomware 

Note: When you select the Exclude MD5 checksum option, all the above options are 

selected, by default. Anti-Ransomware option is available only in the Exclude MD5 

checksum selection. 

4. To save your settings, click OK. 

Note: 

• If you select Known Virus Detection, DNAScan and Suspicious Packed File Scan will also 

be enforced, and all the three options will be selected. 

• If you select DNAScan, Suspicious Packed File Scan will also be enforced, and both the 

options will be selected. 

• However, you can select Suspicious Packed File Scan or Behavior Detection as a single 

option. 

Exclude Extensions 

This feature helps you to exclude the files from scanning using their extensions to provide a 

real-time virus protection. This is helpful in troubleshooting performance related issues by 

excluding certain categories of files that may be causing the issue. 

To exclude a file extension from scanning, follow the step: 

1. Type an extension in the Enter Extension text box, and then click Add. 

The file extension should be without any dots in the following format: xml, html, zip etc.  

Note: The Exclude Extensions feature is available only in the clients with Windows and Mac 

operating systems. 
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Advanced DNA Scan 

Helps you safeguard the client systems even against new and unknown malicious threats whose 

signatures are not present in the virus definition database. DNAScan is an indigenous 

technology of SEQRITE to detect and eliminate new types of malware in the system. DNAScan 

technology successfully traps suspected files with very less false alarms. 

Advanced DNAScan Settings also includes the following: 

Features Description 

Enable DNAScan Helps in scanning the systems based on Digital Network Architecture 

(DNA) pattern. 

Enable Behavior 

detection system 

Helps in scanning the files and systems based on their behavior. If the 

files or systems behave suspiciously or their behavior changes by itself 

is considered as suspicious. This detection can be categorized based 

on their criticality level as Low, Moderate, and High. You can select 

the detection criticality level depending on how often the suspicious 

files are reported in your systems. 

Submit suspicious 

files 

Helps in submitting suspicious files to the SEQRITE research lab 

automatically for further analysis. 

Show notification 

while submitting 

files 

Displays a notification while submitting DNA suspicious files. 

 

Note: 

• The Advanced DNAScan Settings feature is available only in the clients with Windows 

operating systems. 

• The ‘Behavior detection system’ scan setting is not applicable for Windows Server 

platforms. 

Disconnect Infected Endpoints from the Network 

This feature, when enabled disconnects the infected endpoints from the network when non-

repairable virus is found. 

Select the When non-repairable virus found check box to disconnect infected endpoint. 

Note: Disconnect Infected Endpoints feature is not supported on Mac operating system. 

Block Suspicious Packed Files 

This feature helps you identify and block access to the suspicious packed files. Suspicious 

packed files are malicious programs that are compressed or packed and encrypted using a 
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variety of methods. These files when unpacked can cause serious harm to the endpoint 

systems. 

It is recommended that you always keep this option enabled to ensure that the clients do not 

access any suspicious files and thus prevent the spread of infection. 

Note: The Block suspicious packed files feature is available only in the clients with Windows 

operating systems. 

Automatic Rogueware Scan 

This feature automatically scans and removes rogueware and fake antivirus software. If this 

feature is enabled, all the files are scanned for possible rogueware present in a file.  

Note: The Automatic Rogueware Scan feature is available only in the clients with Windows 

operating systems. 

Scan External Drives 

Whenever your system comes in contact with any external devices, your system is at risk that 

viruses and malwares may infiltrate through them. This feature allows you to set protection 

rules for external devices such as; CDs, DVDs, and USB-based drives. 

With External Drives Settings, you can scan the USB-based drives as soon as they are attached 

to your system. The USB-based drives should always be scanned for viruses before accessing it 

from your system, as these devices are convenient mediums for transfer of viruses and 

malwares from one system to another. 

Autorun Protection 

The Autorun Protection protects your system from autorun malware that tries to sneak into the 

system from USB-based devices or CDs/DVDs using the autorun feature of the installed 

operating system. 

Email 

This feature allows you to customize the protection rules for receiving emails from various 

sources. You can set rules for blocking spam, phishing, and virus infected emails. 

To configure policy for Email Settings, follow these steps: 

1. Create Container/feature policy for Email Settings. 

2. On the Feature Policy page, you can see the following list of settings with expand sign and 

toggle button. Expand and Enable settings that you want to configure. 

• Email Protection 

• Trusted Email Client Protection 
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• Spam Protection 

3. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, you can do so by clicking the Reset Default button. 

Email Protection 

With this feature, you can apply the protection rules to all incoming emails. These rules include 

blocking infected attachments (malware, spam, and viruses) in the emails. 

This feature is turned on by default which provides the optimal protection to the mailbox from 

malicious emails. We recommend that you always keep Email Protection turned on to ensure 

email protection. Once the feature is enabled, all the incoming emails will be scanned before 

they are sent to the Inbox. 

1. The Block attachments with multiple extensions check box is selected by default. This 

option helps you block attachment in emails with multiple extensions. Worms commonly 

use multiple extensions which you can block using this feature. 

2. The Block emails crafted to exploit vulnerability check box is selected by default. This 

option helps you block emails whose sole purpose is to exploit vulnerabilities of mail clients. 

Emails such as MIME, IFRAME contain vulnerability. 

3. The Enable attachment control option helps you block email attachments with specific 

extensions or all extensions. If you select this option, the following options are enabled:  

• Block all attachments: Helps you block all types of attachments in emails. 

• Block user specified attachments: Helps you block email attachments with certain 

extensions. If you select this option, the Configure button is activated. For further 

settings, click Configure and set the following options: 

a. In the User Specified Extensions dialog, select the extensions so that the email attachments 

with such extensions are blocked. 

b. If certain extensions are not in the list that you want to block, type such extensions in the 

Enter Extension text box and then click Add to add them in the list. 

c. Click OK to save changes. 

4. Select the Enable Email scanning over SSL check box to enable incoming mail scanning for 

mail accounts configured over SSL. Ensure that you perform the procedure mentioned 

below to import the certificate for the mail client that you are using. This feature is available 

only in the clients with Microsoft Windows operating system. 

5. In the Configure Ports for Email Scan section, do the following: 

• Enter POP3 and IMAP ports for incoming mails. 

• Enter POP3 and IMAP ports for incoming mails over SSL. 
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• Enter SMTP port and SMTP port (SSL) port for outgoing mails. 

Note: The Email Protection feature is available only in the clients with Microsoft Windows and 

Mac operating systems. 

Configuring Email Clients 

For MS Outlook mail client, SEQRITE Email Scanner certificate is imported automatically. No 

action required. 

For your reference, procedure to import SEQRITE Email Scanner certificate for Mozilla 

Thunderbird mail client is quoted here, 

1. Launch Thunderbird mail client. 

2. Select Options Menu > Advanced > Certificates tab. 

3. Click View Certificates. 

4. In Certificate Manager dialog, select Authorities tab, click Import. 

5. Select SEQRITE Email Scanner CA.der certificate from installation directorySEQRITESEQRITE. 

6. Click the Trust this CA to identify websites check box and click Ok. 

7. In Certificate Manager dialog, click Ok. 

8. In Options dialog, click Ok. 

Similarly, for other mail clients, to import SEQRITE Email Scanner certificate, refer their 

technical documentation. 

Trusted Email Clients Protection 

Since email happens to be the most widely used medium of communication, it is used as a 

convenient mode to deliver malware and other threats. Virus authors always look for new 

methods to automatically execute their viral codes using the vulnerabilities of popular email 

clients. Worms also use their own SMTP engine routine to spread their infection. 

Trusted Email Clients Protection is an advanced option that authenticates email-sending 

application on the system before it sends the emails. This option prevents new worms from 

spreading further. It includes a default email client list that is allowed to send emails. Email 

clients in the default list includes Microsoft Outlook Express, Microsoft Outlook, Eudora, and 

Netscape Navigator. 

Trusted Email Clients Protection supports most of the commonly used email clients such as; 

Microsoft Outlook Express, Microsoft Outlook, Eudora, and Netscape Navigator. If your email 

client is different from the ones mentioned, you can add such email clients in the trusted email 

client list. 

Note: The Trusted Email Clients Protection feature is available only in the clients with Windows 

operating systems. 
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Spam Protection 

This feature allows you to differentiate genuine emails and filter out unwanted email such as 

spam, phishing, and adult emails. We recommend you to always keep Spam Protection 

enabled. If you enable Spam Protection, the Spam Protection Level, Whitelist, and Black list 

options are also activated. 

Whitelist 

Whitelist is the list of trusted email addresses. The content from the whitelisted email IDs is 

allowed to skip the spam protection filtering policy and is not tagged as SPAM. 

This is helpful if you find that some genuine email IDs are detected as SPAM or if you have 

blacklisted a domain but want to receive emails from certain email addresses from that 

domain. 

Blacklist 

Blacklist is the list of email addresses from which all emails are filtered irrespective of their 

content. All the emails from the addresses listed here are tagged as "[SPAM] -". 

This feature is useful particularly if your server uses an open mail relay, which is used to send 

and receive emails from unknown senders. This mailer system can be misused by spammers. 

With blacklist, you can filter incoming emails that you do not want or are from unknown 

senders both by email IDs and domains. 

Configuring Spam Protection 

1. Under Spam protection level, set the protection level from the following: 

• Soft: Applies soft filtering spam protection policy. 

• Moderate: Ensures optimum filtering. It is always recommended to enable the 

moderate filtering. However, this is selected by default. 

• Strict: Enforces strict filtering criteria. However, it is not ideal as it may even block 

genuine emails. Select strict filtering only if you receive too many junk emails. 

2. Select Enable white list to implement protection rules for whitelisted emails. 

3. In the Email ID text box, type an email address or a domain and then click Add. You can 

import email addresses or domains from text file using the Import button. 

4. Select Enable black list to implement the protection rules for blacklisted emails. 

5. In the Email ID text box, type an email address or a domain and then click Add. You can 

import email addresses or domains from text file using the Import button. 

Note: 

• An email address should be in the format: abc@abc.com. 

mailto:abc@abc.com
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• A domain name should be in the format: *@mytest.com. 

• The same email ID cannot be entered in both blacklist and whitelist. 

6. To save your settings, click Save Policy. 

IDS IPS 

When you create a network where numerous machines are deployed, security is of paramount 

concern. With IDS/IPS, you can detect attacks. This detection implements a security layer to all 

communications and cordons your systems from unwanted intrusions or attack. You can also 

take actions like blocking the attacker’s IP for certain time and send an alert message to the 

administrator. 

Note: The IDS/IPS feature is available only in the clients with Microsoft Windows. 

You can create different policies with varying IDS/IPS settings and apply them to the groups so 

that each has separate policies based on the requirement. 

To configure policy for IDS/IPS, follow these steps: 

1. Create Container/feature policy for IDS/IPS. 

2. In the Host IDS/IPS section, enable IDS Rules by selecting the check box. By default, this 

option is selected. 

3. Select the Detect Port Scanning Attack check box, if required. On selecting this check box, 

Customize link gets enabled. 

4. You can add IP Port exceptions if required. 

5. Select the Detect DDOS (Distributed Denial of Service) Attack check box, if required. On 

selecting this check box, Customize link gets enabled. 

6. From the following options, select an action to be performed when attack is detected:  

• Block Attackers IP for … Minutes. By default, this option is selected, and 5 minutes are 

set. Select the time, if required. 

• Display alert message when attack is detected. This option helps you to take an 

appropriate action when attack is detected. 

7. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, click the Reset Default button. 

Customizing Port Scanning 

You can customize settings for Detect Port Scanning Attack and Detect DDOS (Distributed 

Denial of Service) Attack as follows: 

1. On IDS/IPS policy page, select the Detect Port Scanning Attack check box. 

mailto:*@mytest.com
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The Customize link gets enabled. 

2. Click the Customize link. 

Settings –Port Scanning dialog appears. 

3. Select one of the following levels: 

• Soft: Detect attack if many ports are scanned 

• Normal: Detect attack if multiple ports are scanned 

• Strict: Detect attack if few ports are scanned 

• Custom: Helps you customize the number of scanned ports and attack duration. 

4. To exclude an IP address you do not want to be scanned, click Add in the Excluded IP 
Addresses section. 

5. On the Add IP Address screen, type an IP Address or IP range and then click OK. 

6. To exclude a port that you do not want to be scanned, click Add from the Excluded Ports 
section. 

7. On the Add Port screen, type a Port or Port range and then click OK. 

Customization for Distributed Denial of Service 

Further customization settings for Distributed Denial of Service Attacks are as follows: 

1. On IDS/IPS policy page, select the Detect DDOS (Distributed Denial of Service) Attack  check 
box. 

The Customize link gets enabled. 

2. Click the Customize link. 

The Settings – Denial of Service dialog appears. 

Select one of the following levels: 

• Soft: Detect attack if many attacks are detected 

• Normal: Detect attack if multiple attacks are detected 

• Strict: Detect attack if few attacks are detected  

• Custom: Helps you customize the number of attack sources and attack duration. 

3. To exclude an IP address that you do not want to be scanned, click Add in the Excluded IP 
Addresses section. 

4. On the Add IP Address screen, type an IP Address or IP range and then click OK. 

5. To exclude a port that you do not want to be scanned, click Add in the Excluded Ports 
section. 

6. On the Add Port screen, type a port or port range and then click OK. 
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Creating the Exceptions 

1. In Exceptions section, the list of Exceptions appears. 

2. To create new exception, click Add. 

3. On the Add/Edit Exception screen, do the following. 

a. Type a name in the Exception Name text box 

b. Select a protocol. The protocol includes: TCP and UDP. 

c. Select one of the Direction from the following and click Next. 

• Inbound Connections 

• Outbound Connections 

• Inbound – Outbound Connections 

d. Click Next. 

4. Under Local IP Address, do one of the following, 

• Select the Any IP Addresses option, you need not type an IP address as all IP 

addresses will be allowed or blocked. 

• Select the IP address option and type the IP address. Click Add to add the IP address. 

You can add multiple IP addresses here. 

You can add up to 25 IP addresses per exception. However, the combined count of 

all IP addresses in all exceptions in a policy must be equal to or less than 255. 

You can delete the IP address with help of the Delete button. 

You can also import the IP addresses from a text file using the Import button. The 

maximum limit to import valid IP addresses is 25 per exception. 

• Select IP Address Range option. Enter Start IP Address and End IP Address. 

5. Click Next. 

6. Under Local TCP/UDP Ports, do one of the following, 

• Select the All Ports option to select all ports. 

• Select the Specific Ports option and type the port numbers. Use comma in between 

to add multiple ports. 

• Select the Port Range option. Enter Start Port Number and End Port Number. 

7. Click Next. 

8. Under Remote IP Address, do one of the following, 

a. Select the Any IP Addresses option, you need not type an IP address as all IP 

addresses will be allowed or blocked. 
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b. Select the IP address option and type the IP address. Click Add to add the IP 

address. You can add multiple IP addresses here. 

You can add up to 25 IP addresses per exception. However, the combined count 

of all IP addresses in all exceptions in a policy must be equal to or less than 255. 

You can delete the IP address with help of Delete button. 

You can also import the IP addresses from a text file using Import button. The 

maximum limit to import valid IP addresses is 25 per exception. 

c. Select IP Address Range option. Enter Start IP Address and End IP Address. 

9. Click Next. 

If you mention remote IP or port, that exception will be for outgoing communications.  

10. Under Remote TCP/UDP Ports, do one of the following, 

a. The All Ports option is selected by default. 

b. Select the Specific Ports option and type the port numbers. Use commas in 

between to add multiple ports. 

c. Select the Port Range option. Enter Start Port Number and End Port Number. 

11. Click Next. 

12. Click Finish. 

The Exception is added at the top position in the Exceptions list. The sequence of the 

exceptions decides the precedence of the rule. The precedence is in descending order. 

You can move the exception rule with the Move Up and Move Down buttons. 

13. Click Save Policy. 

Editing the Exceptions Rule 

You can edit the exceptions rule which are created by you. To edit the Exceptions rule, follow 

these steps: 

1. In Exceptions section, select the exception that you want to edit. 

2. On the Add/Edit Exception screen, you can edit the name in the Exception Name text 

box and edit the protocol. The protocol includes: TCP, and UDP. 

3. Edit Direction option if required. 

4. Click Next. 

5. Edit Local IP Address if required, and then click Next. 

6. Edit Local TCP/UDP Ports if required, and then click Next. 

7. Edit Remote IP Address if required, and then click Next. 
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8. Edit Remote TCP/UDP Ports if required, and then click Next. 

9. Click Finish. 

10. Click Save Policy. 

Deleting the Exceptions Rule 

You can delete the exceptions rule that you have created. To delete the Exceptions rule, follow 

these steps: 

1. In Exceptions section, select the exception that you want to delete. 

2. The action bar is enabled above the table. In the drop down, select Delete. 

3. Click Submit. The selected exception rule is deleted. 

4. Click Save Policy. 

Exporting the Exceptions Rule 

You can export the exceptions rule that you have created. To export the Exceptions rule, follow 

these steps: 

1. In Exceptions section, select the exceptions that you want to export. 

2. Select Action > Export. The Opening ids_exception.json dialog appears. 

3. Select Save File. 

4. Click Ok. 

The database file, ids_exception.json is downloaded. 

Importing the exceptions Rule 

You can import the exceptions rule that you have created in the earlier versions of EPS. To 

import the Exceptions rule, follow these steps: 

1. In Exceptions section, click Add > Import. The File Upload dialog appears. 

2. Select the database file, ids_exception.json. 

3. Click Open. 

The database file, ids_exception.json is imported. 

Firewall 

Firewall shields your endpoint by monitoring both inbound and outbound network connections. 

It analyzes all incoming connections whether it is secure and should be allowed through, and 

checks whether the outgoing communication follows the compliance that you have set for 

security policies. Firewall works silently in the background and monitors network activity for 

malicious behavior. 
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You can create different policies for various groups/departments like enabling Firewall 

protection, applying Firewall security level with an exception rule and other settings according 

to the requirements. For example, you can apply security level as High for the Accounts 

Department, and apply an exception rule by entering the policy with additional policy settings. 

You can also apply the Display alert message when firewall violation occurs and Enable firewall 

reports options. While for Marketing Department, you can create a policy with security level as 

Low without an exception rule and apply the Enable firewall reports options only.  

Note: The Firewall feature is available only in the clients with Microsoft Windows. 

Configuring Firewall 

To configure policy for Firewall, follow these steps: 

1. Create Container/feature policy for Firewall. 

2. On the Feature Policy page, you can see the following list of settings with expand sign and 

toggle button. Expand and Enable settings that you want to configure. 

• Firewall – When you enable this, a prompt appears, “This action will disable Windows 

Firewall on your endpoint. Do you want to continue?”  

Click OK. 

• Exceptions 

3. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, you can do so by clicking the Reset Default button. 

Firewall 

1. In the Level option, select one of the following: 

• Block all 

• High 

• Medium 

• Low 

Level Description 

Block all Blocks all Inbound and Outbound connections without any 

exception. This is the strictest level of security. 

High Blocks all Inbound and Outbound connections with an exception 

rule. The exception policy can be created for allowing or denying 

connections either for inbound or outbound through certain 

communication protocols, IP address, and Ports such as TCP, UDP, 

and ICMP. 
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Medium Blocks all Inbound and allows all Outbound connections with an 

exception rule. The exception policy can be created for allowing or 

denying either inbound or outbound connections through certain 

communication protocols, IP address, Ports such as TCP, UDP, and 

ICMP. For example, if you allow receiving data from a certain IP 

address, the users can receive data but cannot send to the same IP 

address. To take more advantage of this security level policy, it is 

advisable that you allow receiving inbound connections and block 

outbound connections. 

Low Allows all Inbound and Outbound connections. When you apply 

Low security level, it is advisable that you create an exception rule 

for denying particular inbound or outbound data with the help of 

certain Protocols, IP address, and Ports to take more advantage of 

the security level policy. 

2. By default, the Monitor Wi-Fi Networks check box is selected. This option helps to receive 

alert messages when connected with unsecured Wi-Fi network and when an attempt is 

detected to access unsecured client Wi-Fi (hotspot). Also, the reports are generated at the 

server. 

3. If you want an alert message about firewall violation, select the Display alert message 

when firewall violation occurs check box. 

4. If you want reports for all blocked connections, select the Enable firewall reports check box. 

Note: If the Firewall policy is set as Block All, Firewall will block all connections and generate 

many reports that may impact your network connection. 

Exceptions 

With Exceptions, you can allow genuine programs to perform communication irrespective of 

the Firewall level whether set as High or Medium. With Exceptions, you can block or allow 

Inbound and Outbound communication through IP addresses and ports. 

Creating the Exceptions 

1. In Exceptions section, the list of Exceptions appears. 

2. To create new exception, click Add. 

3. On the Add/Edit Exception screen, do the following. 

a. Type a name in the Exception Name text box. 

b. Select one of the protocols from the following: 

• TCP 
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• UDP 

• ICMP 

c. Under Application, All Applications that meet the specified conditions option is 

selected by default. If you want any specific application, select Specified Applications 

path option and enter the path of the application.  

d. Click Next. 

4. Depending on the selection of protocol, the steps are followed. 

ICMP Protocol 

If you select ICMP Protocol, do the following. 

a. Under Local IP Address, do one of the following, 

• Select the Any IP Addresses option, you need not type an IP address as all IP addresses 
will be allowed or blocked. 

• Select the IP address option and type the IP address. Click Add to add the IP address. 

You can add multiple IP addresses here.  

You can add up to 25 IP addresses per exception. However, the combined count of all IP 

addresses in all exceptions in a policy must be equal to or less than 255. 

You can delete the IP address with help of the Delete button.  

You can also import the IP addresses from a text file using the Import button. The 

maximum limit to import valid IP addresses is 25 per exception.   

• Select IP Address Range option. Enter Start IP Address and End IP Address. 

b. Click Next. 

c. Configure ICMP Settings. Select the check boxes as required. The default button sets the 
default settings of ICMP. Click Next. 

d. Under Status, select either Enable or Disable. 

e. Click Finish. 

TCP or UDP 

If you select TCP or UDP option for Protocol, do the following  

a. Select one of the Direction from the following and click Next: 

• Inbound Connections 

• Outbound Connections 

• Inbound - Outbound Connections 

b. Under Local IP Address, do one of the following, 

• Select the Any IP Addresses option, you need not type an IP address as 

all IP addresses will be allowed or blocked. 
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• Select the IP address option and type the IP address. Click Add to add the 
IP address. You can add multiple IP addresses here.  

You can add up to 25 IP addresses per exception. However, the combined 

count of all IP addresses in all exceptions in a policy must be equal to or 

less than 255. 

You can delete the IP address with help of Delete button.  

• Select IP Address Range option. Enter Start IP Address and End IP 
Address. 

• Click Next. 

c. Under Local TCP/UDP Ports, do one of the following, 

• Select the All Ports option to select all ports.  

• Select the Specific Ports option and type the port numbers. Use comma 

in between to add multiple ports. 

• Select the Port Range option. Enter Start Port Number and End Port 
Number.  

• Click Next. 

d. Under Remote IP Address, do one of the following, 

• Select the Any IP Addresses option, you need not type an IP address as 

all IP addresses will be allowed or blocked. 

• Select the IP address option and type the IP address. Click Add to add the 
IP address. You can add multiple IP addresses here.  

You can add up to 25 IP addresses per exception. However, the combined 

count of all IP addresses in all exceptions in a policy must be equal to or 

less than 255. 

You can delete the IP address with help of Delete button.  

You can also import the IP addresses from a text file using Import button. 

The maximum limit to import valid IP addresses is 25 per exception.   

• Select IP Address Range option. Enter Start IP Address and End IP 
Address. 

• Under Domain Name, type the Domain Name. Click Add to add the 

Domain Name. You can add multiple Domain Names here.  

You can add up to 25 Domain Names per exception. However, the 

combined count of all Domain Names in all exceptions in a policy must be 

equal to or less than 255. 

You can delete the Domain Name with help of the Delete button.  
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You can also import the Domain Names from a text file using the Import 

button. The maximum limit to import valid Domain Names is 25 per 

exception.   

• Click Next. 

If you mention remote IP or port, that exception will be for outgoing 

communications. 

e. Under Remote TCP/UDP Ports, do one of the following, 

• The All Ports option is selected by default.  

• Select the Specific Ports option and type the port numbers. Use commas 

in between to add multiple ports. 

• Select the Port Range option. Enter Start Port Number and End Port 
Number.  

• Click Next. 

f. Under Action, select either Allow or Deny. 

g. Under Status, select either Enable or Disable. 

h. Click Finish. 

The Exception is added at the top position in the Exceptions list. The sequence of the 

exceptions decides the precedence of the rule. The precedence is in descending order. You 

can move the exception rule with the Move Up and Move Down buttons. 

5. Click Save Policy. 

Editing the Exceptions Rule 

You can edit the exceptions rule which are created by you. To edit the Exceptions rule, follow 

these steps: 

1. In Exceptions section, select the exception that you want to edit. 

2. On the Add/Edit Exception screen, you can edit the name in the Exception Name text box 

and edit the protocol. The protocol includes: TCP, UDP, and ICMP. 

3. Click Next. 

4. Edit Local IP Address if required, and then click Next. 

5. Edit Local TCP/UDP Ports if required, and then click Next. 

6. Edit Remote IP Address if required, and then click Next. 

7. Edit Remote TCP/UDP Ports if required, and then click Next. 

8. Under Action, you can select either Allow or Deny. 

9. Under Status, you can select either Enable or Disable. 
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10. Click Finish. 

11. Click Save Policy. 

Deleting the Exceptions Rule 

You can delete the exceptions rule that you have created. To delete the Exceptions rule, follow 

these steps: 

1. In Exceptions section, select the exception that you want to delete. 

2. The action bar is enabled above the table. In the drop down, select Delete. 

3. Click Submit. The selected exception rule is deleted. 

4. Click Save Policy. 

Exporting the Exceptions Rule 

You can export the exceptions rule that you have created. To export the Exceptions rule, follow 

these steps: 

1. In Exceptions section, select the exceptions that you want to export. 

2. Select Action > Export. The Opening firewall_exception.json dialog appears.  

3. Select Save File. 

4. Click Ok. 

The database file, firewall_exception.json is downloaded. 

Importing the exceptions Rule 

You can import the exceptions rule that you have created in the earlier versions of EPS. To 

import the Exceptions rule, follow these steps: 

1. In Exceptions section, click Add > Import. The File Upload dialog appears. 

2. Select the database file, firewall_exception.json. 

3. Click Open. 

The database file, firewall_exception.json is imported. 

Web Security 

This feature helps you create security policies for an endpoint or group where Browsing and 

Phishing Protection can be enabled. This blocks malicious and phishing Web sites. You can 

restrict or allow access to the internet and Web sites as per your requirement. 

The following settings are provided under Web Security: 

• Browsing and Phishing 
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• Block Web Categories 

• Block Specific Websites 

• Schedule Internet Access 

• Alerts and Reports 

• Google Access Controller 

• YouTube Access Controller 

Browsing Protection 

While users visit malicious Web sites some files may get installed on their systems. These files 

can spread malware, slow down the system, or corrupt other files. These attacks can cause 

substantial harm to the system. 

Browsing Protection ensures that malicious Web sites are blocked while the users in a group 

are accessing the Internet. Once the feature is enabled, the site that is accessed is scanned and 

is blocked if found to be malicious. 

Phishing Protection 

Phishing is a fraudulent attempt, usually made through email, to steal your personal 

information. These emails usually appear to have been sent from seemingly well-known 

organizations and sites such as banks, companies and services seeking for your personal 

information such as credit card number, social security number, account number or password. 

Administrators can enable Phishing Protection that prevents users from accessing phishing and 

fraudulent Web sites. As soon as a site is accessed, it is scanned for any phishing behavior. If 

found fraudulent, then it is blocked to prevent any phishing attempts. 

Web Categories 

There are certain concerns that most organizations may face: 

• System infection by malware. 

• Users browsing unwanted Web sites. 

• The employees idling away time. 

To avoid these concerns the administrators need to have a policy that regulates users 

and their Web access activities. 

The Web Categories feature helps the administrators centrally control and manage the 

browsing behavior of the users. The administrators can create different security policies 

for different groups according to their requirements and priorities. 

Creating a new Web Security Policy 

To configure policy for Web Security, follow these steps: 



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  99 

1. Create Container/feature policy for Web Security. 

2. On the Feature Policy page, you can see the following list of settings with expand sign and 

toggle button. Expand and Enable settings that you want to configure. 

• Browsing and Phishing 

• Block Web Categories 

• Block Specific Websites 

• Schedule Internet Access 

• Alerts and Reports 

3. Expand Browsing and Phishing. Select either of the following or both the check boxes: 

• Browsing Protection 

• Phishing Protection 

4. Enable and Expand Block Web Categories. 

5. Select Protection level, Low, Medium, or High. 

6. This restricts or allows access to the Web sites based on their categories as per the security 

policy of your organization. If you block a category, all the Web sites referring to the 

category will be blocked. 

• The Web categories are enabled, and you can allow or deny access to each category.  

• From Status column, select either Allow or Deny. 

7. Enable and expand Block specified websites. You can enter the Web sites that you want to 

block. For details, see Block specified websites. 

8. Enable and expand Schedule Internet Access and do the following: 

9. Select one of the following options: 

• Always allow access to the internet 

• Allow access to the internet as per schedule – When you select the option, Allow access 

to the internet as per schedule, you can add the schedule time. 

a. Click Add to add the schedule. Add Time Interval dialog appears. 

b. Select the Weekday from the list. 

c. Select the Start at and End at hours. 

d. Click OK. 

You can delete the schedule entry if the entry is not required. 

Note: SSL versions earlier than 3.1 are not supported for Schedule Internet Access. 

10. Enable and expand Alerts and Reports. 
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11. Select either of the following or both the check boxes: 

• Display Alert Message – when website is blocked. 

• Generate Web Security Reports – To generate reports for all blocked Web sites. If you 

select this option, a large number of reports will be generated depending upon the Web 

usage. 

12. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, click the Reset Default button. 

Exclusion for Browsing Protection and Phishing Protection 

Exclusion enables you to apply an exception rule to the protection policy for Browsing 

Protection and Phishing Protection. This helps you exclude the URLs of the sites that are 

actually genuine, but get erroneously detected either as malicious or phishing sites. You are 

recommended to exclude only those URLs that you trust to be safe and genuine. 

You can exclude the URLs in the following way: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Policies > Container Policies > Web Security. 

3. In the Browsing and Phishing section, under Exclude URLs, type the URL and then click Add. 

The Report Miscategorized URL dialog appears. You can report about miscategorization of 

the URL to the Seqrite lab if the URL is detected as malicious or phishing site. 

4. Select one of the reasons from the following: 

• URL is getting detected as Malicious 

• URL is getting detected as Phish 

5. To report about miscategorization, click Yes. If you do not want to report about 

miscategorization, click No. The URL is added in the Exclude URL list. 

6. To save your settings, click OK. 

In the action bar, you can perform the following actions: 

Action Description 

Add Helps you exclude a URL from being detected as malicious or 

phishing. 

Delete Helps you delete a URL from the Excluded URL list. 

Report Helps you report if a URL is miscategorized. 
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Exclusion for Web Categories 

Exclusion helps you apply an exception rule to the protection policy for Web Categories. This 

helps you when you want to restrict access to a Web site category, but you want to allow 

certain Web sites from the restricted category. 

You can enlist such Web sites in the Exclusion list in the following way:  

1. Log on to the Seqrite Endpoint Security. 

2. Go to Policies > Container Policies > Web Security. 

3. Click the Exclusion button. The Exclude URLs dialog appears. 

4. In the Block Web Categories section, under Exclusions, type the URL and then click Add. The 

URL is added in the Exclude URL list. 

5. To exclude the subdomains, in the column Exclude Subdomain, select option Yes or No. 

6. To save your settings, click OK. 

Action Description 

Add Helps you exclude a URL from being restricted even if it 

belongs to the blocked category. 

Delete Helps you delete a URL from the Excluded URL list. 

Block Specified Websites 

This feature is helpful in restricting access to certain Web sites or when a Web site does not fall 

into an appropriate category. It is also helpful if you have a shorter list of the Web sites that you 

would prefer to restrict the Web sites than blocking the entire category. 

To block Web sites, follow these steps: 

1. Log on to Seqrite Endpoint Security. 

2. Go to Policies > Container Policies > Web Security. The Block specified websites features 

(Add, Delete, Delete All) are activated. 

3. Type a URL and then click Add. 

4. If you want to block the subdomains, select the option Yes or No in Block 

Subdomains column. For example, if you block www.google.com and enable ‘Block 

Subdomains’, all its subdomains such as mail.google.com will also be blocked.  

You can delete the URL, if required. 

Note: The Block Subdomains feature is not applicable for the clients with Mac operating 

systems. 
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Google Access Controller 

Here you can add Email domains related to your organization to log in to your Google account.  

1. Enable and expand Google Access Controller. 

2. The settings done on the Configuration page are displayed here. You can change the 

settings if required. 

3. Enter Email Domains to log in to your Google Account in the correct domain name 

format. The domain name should include the domain name and top-level domain. 

4. Click Add. 

The entry is added to the Domain list. This feature allows user to access google account only 

through the Email domains added in the list. 

You can delete the domain names if not required. 

YouTube Access Controller 

On the YouTube platform, channels and videos are arranged using YouTube video categories.  

Some examples of YouTube Video Categories are, 

• Film & Animation 

• Autos & Vehicles 

• Music 

• Pets & Animals 

• Sports 

• Short Movies 

Here you can block or allow YouTube categories to watch the videos. 

1. Enable and expand YouTube Access Controller. 

2. The settings done on the Configuration page are displayed here. You can change the 

settings if required. 

3. By default, the YouTube Categories Access is selected as Allow all. You can select the 

option Deny all to deny all the YouTube Categories. 

To allow some categories and deny some categories, select the option Custom. You can 

select Allow or Deny option as per required access to the YouTube Categories. 

Exclusions by YouTube Attribute 

Exclusion enables you to apply an exception rule to the YouTube Categories Access policy. This 

helps you to allow YouTube videos that you want to watch from blocked categories.  

You can exclude YouTube category by channel or publisher. YouTube Channel is a personalized 
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home where all the videos the creator uploads.The YouTube Channel handle terminology is 

named as Publisher here for easy understanding. 

For more information about Handles, see YouTube Handle. 

To exclude YouTube category, do the following steps: 

1. Click Add. 

The Exclusion by YouTube attribute dialog appears. 

2. Select Channel or Publisher. 

3. Enter the Channel/Publisher name. 

4. Click Add. 

The entry is added to the list. 

You can delete entry if not required. 

Block by YouTube Attribute 

Blocking helps you to block YouTube videos from allowed categories. 

You can block by channel or publisher. YouTube Channel is a personalized home where all the 

videos the creator uploads. The YouTube Channel handle terminology is named 

as Publisher here for easy understanding. 

For more information about Handles, see YouTube Handle. 

To block YouTube category, do the following steps: 

1. Click Add. 

The Block by YouTube attribute dialog appears. 

2. Select Channel or Publisher. 

3. Enter the Channel/Publisher name. 

4. Click Add. 

The entry is added to the list. 

You can delete entry if not required. 

Exclusion for Schedule Internet Access 

You can exclude certain known websites from getting it blocked. Excluded URLs/Websites will 

not get blocked even if internet is restricted. 

You can enlist such Web sites in the Exclusion list in the following way: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Policies > Container Policies > Web Security. 

3. In the Schedule Internet Access section, under Exclusions, type the URL and then click Add. 

The URL is added in the Exclude URL list. 

https://support.google.com/youtube/answer/11585688?sjid=13788006596079380191-AP/
https://support.google.com/youtube/answer/11585688?sjid=13788006596079380191-AP/
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4. To save your settings, click OK. 

Action Description 

Add Helps you exclude a URL from being restricted even if internet is restricted. 

Delete Helps you delete a URL from the Excluded URL list. 

 

Application Control 

Organizations usually face the following concerns while using applications:  

• No illegal or fake applications should be installed on client systems. 

• Malicious applications should not infect the systems. 

• Unnecessary applications should not clog the systems. 

With this feature, you can authorize or unauthorize the users to access and work with 

certain applications, so that no one accesses an unwanted application. 

You can create various policies based on the requirement of the groups or departments. 

For example, for the users of the Marketing Department, you can allow access to File 

Sharing Applications and Web Browser while restrict access to all other applications. For 

the Accounts Department, you can allow access to Archive Tools and Web Browsers 

only. 

Note: The Application Control feature is available only in the clients with Windows 

operating systems. 

Application Control 

To configure policy for Application Control, follow these steps:  

1. Create Container/feature policy for Application Control. 

2. On the Application Control page, the following settings are available. You can use only one 

of them at a time. 

• Allow All Applications 

• Block All Applications 

3. Click Save Policy. 

Allow All Application 

1. Toggle On the Allow All Application setting and expand. 

2. You can authorize/unauthorize application as per your requirement. To customize the 

access to the application, click the corresponding option in the Custom column. The list of 

applications under the selected category is displayed in the table. 
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3. On the Feature Policy page, If you want to send a notification when a blocked application is 

accessed, select Notify when an unauthorized application is blocked. 

Block All Applications 

1. Toggle ON the Block All Applications Settings and expand. 

2. To add allowlist, click Add. 

Add allowlists dialog appears. A list of existing allowlists is displayed with details. 

You can select existing allowlist. 

3. Select an allowlist from the list. You can create a new allowlist on the Configuration > 

Application Control page. 

4. Click Add. 

5. Select one of the following modes. 

• Monitoring (Recommended): Use Monitoring mode to analyze the unauthorized 

application usage for a few days. Fine-tune the allowlist prior to switching to 

Enforcement mode. Unauthorized applications will only be reported. 

• Enforcement: Unauthorized applications will be blocked and reported. 

Select the Notify user when an unauthorized application is blocked check box to 

receive a notification when an unauthorized application is blocked. 

Advanced Device Control 

While working with data storage devices such as CD/DVDs and USB-based devices such as pen 

drives, organizations are concerned with the following: 

• Autorun feature does not activate any infection. 

• Unnecessary data or applications do not clog the systems. 

This feature allows the administrators to create policies with varying rights. For example, 

administrators can block complete access to removable devices, give read-only and no write 

access so that nothing can be written on the external devices. They can also customize access 

to admin configured devices. Once the policy is applied to a group, the access rights are also 

applied. You can use the exception list to exclude the devices from the device control policy.  

Advanced Device Control 

To configure policy for Advanced Device Control, follow these steps:  

1. Create Container/feature policy for Advanced Device Control. 

2. On the Feature Policy page, you can see list of settings with expand sign and toggle button. 

Expand and enable settings that you want to configure. 

3. Enable Advanced Device Control. 
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4. Expand Storage Devices. The following list of storage devices is displayed: 

• USB Storage Device 

• CD/DVD 

• Internal Card Reader 

• Internal Floppy Drive 

• ZIP Drive 

For the above devices, select the permissions as per your requirement. 

5. Enable and expand Card Readers. The following list of Card Readers is displayed: 

• Card Reader Device (MTD) 

• Card Reader Device (SCSI) 

For the above devices, select the permissions as per your requirement. 

6. Enable and Expand Wireless. The following list of Wireless networks is displayed: 

• Wi-Fi (Customize) 

• Bluetooth 

For the above network, select the permissions as per your requirement. 

7. To authorize Wi-Fi connections, click Customize link.The ‘Authorized Wi-Fi Connections’ 

dialog appears. 

Select one of the following options. 

a. Allow for all Wi-Fi access points 

b. Allow only for authorized Wi-Fi access points – If you select this option, do the following. 

c. Enter SSID in the text box. 

d. Enter MAC address in the text box. 

e. Click Add. The network data is added. You can delete the data with help of Delete button. 

f. Click Ok. 

Note: Customize (Authorized Wi-Fi connections) feature is not supported on Mac operating 

system. 

8. Enable and expand Mobile & Portable Devices. The following list of Mobile & Portable 

Devices is displayed: 

• Windows Portable Device 

• iPhone 

• iPad 

• iPod 
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• BlackBerry 

• Mobile Phones (Symbian) 

• Scanner & Imaging Devices 

For the above devices, select the permissions as per your requirement. 

9. Enable and expand Interface. The following list of Interface mode is displayed: 

• FireWire Bus 

• Serial Port 

• SATA controller 

• Thunderbolt 

• PCMCIA Device 

• USB 

For the above interfaces, select the permissions as per your requirement. 

10. Enable and expand Camera. For Webcam, select the permissions as per your requirement. 

11. Enable and expand Others. The following list of other devices is displayed: 

• Local Printers 

• Teensy Board 

• Network Share 

• Unknown Device 

For the above devices, select the permissions as per your requirement. 

12. Enable and expand Exceptions. Ensure that you have added the devices in Configuration > 

Device Control > Add devices. Then do the following: 

a. Click Add. The ‘Managed Devices’ dialog appears. 

b. Select one or more devices to add to the exception list. 

c. Click Add. The devices are added in the Exceptions list. 

d. Set the access permissions as required.You can delete the devices with help 

of Delete button. 

13. To save your setting, click Save Policy. 

This policy is applied to all the devices that are configured in the list. Even if you add a 

device, the same policy will apply unless you customize the policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, click the Reset Default button. 

For Windows Clients 

• Only NTFS is supported for Partial encryption. 
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• USB Pen Drives with GUID Partition Table (GPT) Partition Style cannot be added for 

authorization. 

• If an authorized and encrypted device is formatted, the device will be treated as 

unauthorized. Hence, Administrator will need to add the device again in Device Control 

and configure the policies accordingly. 

• Some devices (e.g. Nokia phones, BlackBerry phones) may need system reboot or device 

reattachment for device access rights to be applied. 

• On blocking SATA Controller from Advanced Device Control, you may frequently see 

SATA Controller blocked prompts even when actual blocking is not performed. 

• While any ongoing session of Webcam or Bluetooth is in progress, changing access right 

to block will not interrupt this current ongoing session. The device may need 

reattachment or system reboot for access rights to be applied. 

For Mac Clients 

• If the option Read only is selected in Advanced Device Control of SEPS and a USB device 

is attached, such a device may not be accessible from the left pane in Finder for some 

time. 

• If a USB device is already attached to the machine and you are installing Mac client, the 

device may not be shown as mounted for a fraction of seconds. 

• If an NTFS USB device is attached to the machine during installation of Mac client, two 

copies of the attached USB may be visible for a few seconds. 

• If a USB device is to be shown as mounted or un-mounted using terminal commands, 

the Device Control policy will not apply to that device. 

• If you are installing Mac client on Mac OSx 10.9 while an FAT USB device is attached to 

the machine, such a device will not be displayed as mounted. To show the device 

mounted, you need to disconnect the device and reconnect it. 

• iDevices, Internal Card Reader, Webcam, CD-DVD, mobile phones and HFS encrypted 

devices may need device reattachment for device access rights to be applied. 

• Exception functionality will not be applicable for Bluetooth, Wi-Fi, Webcam, External 

CD-DVD. 

• Mobile phones except iDevices that are connected in ‘USB Mass Storage’ mode will be 

detected under USB storage device category. 

• Mobile phones connected in MTP mode will be detected under ‘Windows Portable 

Devices’ category. 

• Blocking functionality will not work for Blackberry mobile if the mobile is connected to 

Mac system in Sync Media. 
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• USB storage device would not be formatted with Mac OS extended (Journaled, 

Encrypted) file format. 

For Linux clients 

• The Read only option set for internal CD/DVD on the EPS server, is treated as Blocked on 

the Linux client. 

• Wireless adapters are not supported. 

• Bluetooth USB dongle may not be supported on some operating systems. 

• In all supported Linux OS, internal CD-DVD tray will not open if block mode is set for CD-

DVD” 

• If DC configuration is changed from Read-only mode to Allow mode, the USB drives may 

not work accordingly. 

• UMS Mobile Phones do not work in Read-only mode. Changing the mode using the 

option available in the device will connect it to the endpoint. If the device is plugged 

out, the device in a particular mode does not change the mode automatically. 

Data Loss Prevention 

You can prevent unauthorized loss, pilferage, or leakage of confidential company data using the 

Data Loss Prevention (DLP) feature. 

It is necessary to enable DLP on endpoints. To do this, see DLP License. 

The DLP policy can stop an unauthorized activity that is carried out through the following 

channels: 

• Using the Print Screen option to save the screenshot (Applicable only for Windows 

platform). The file/data is not monitored. 

• Using Removable Devices to copy data (Applicable only for Windows platform) 

• For selected File Types, the Removable Devices go to ‘Read Only’ mode when ‘Monitor 

Removable Devices’ option is selected. 

• Using Network Share accessed using UNC Path or Mapped Network Drive (Applicable 

only for Windows platform). 

• Using the Clipboard to paste information from one application to another. 

• Using printer activity, printing through local and network printer. The file/data is not 

monitored. (Applicable only for Windows platform) 

• Using online services of third-party Application/Services to send data such as email, file 

sharing apps, cloud services, Web browsers and other applications using social media.  

Note: Users need to purchase a DLP pack separately to avail this policy. 
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Data Loss Prevention 

To configure policy for Data Loss Prevention, follow these steps: 

1. Create Container/feature policy for Data Loss Prevention. 

2. On the Feature Policy page, you can see list of settings with expand sign and toggle button. 

Expand and enable settings that you want to configure. 

• Data Loss Prevention 

• Add-on Features 

• Data Transfer Channels 

• Data Settings 

• Exceptions 

3. Enable Data Loss Prevention. Select the Display alert message on DLP policy violation check 

box. 

4. Select Action to configure the action to be performed after the attempts is carried out, 

either Report only or Block and Report. Alert prompts will not be displayed for Report Only 

action. 

a. In the Add-on section, the following 2 add-on features are available. 

• File Classification 

• Optical Character Recognition (OCR) 

• Select the Always show pop-up to classify a new file check box if you want 

to view pop-up every time when you create a new file. 

• Select the Optical Character Recognition (OCR) check box. You can view list 
of supported OS versions for OCR by clicking the link, Supported OS list.  

File Classification 

When a new Microsoft Office file is generated, DLP asks to classify the file as 

Confidential or Public. You can classify existing files also. Files classified as 

confidential are treated as sensitive files and any operation to leak is 

blocked/reported as per DLP policy. This is regardless of the content of the file. 

Files classified as Confidential will be monitored only for the following Data 

Transfer Channels, 

• Removable Devices 

• Network Share  

• Application/Online Services 



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  111 

Select the Always show pop-up to classify a new file check box if you want to view pop-up 

every time when you create a new file. 

5. When you create a new MS Office file, save and close it, a Seqrite File Classification dialog 
appears. The dialog appears only for MS Office files.  

6. Select the classification level as Public or Confidential.  

7. Click OK. 

The overlay icon of classified file appears as per classification. 

When you copy a file, classify the copied file as per above procedure.  

Note: The overlay icon of classified file appears after system or Windows Explorer is restarted 

after client is installed. 

To classify existing files, follow the given steps: 

8. Select the files to be classified. You can select maximum 100 files at a time.  

9. Right click the selected files and select Seqrite File Classification > classification level as 
Public or Confidential or Unspecified. 

A Seqrite File Classification dialog appears showing result. The lay over icon of classified files 

appears as per classification. 

You can remove the classification, by selecting Unspecified option.  

Note: Manual classification is supported only on NTFS. 

Optical Character Recognition (OCR) 

Optical Character Recognition feature is disabled by default.  

The confidential/user defined data from image files is identified in case of data leak and action 

is performed as per policy. The image details are mentioned in the DLP report.  

OCR supports the following image formats, 

• JPEG (or JPG) - Joint Photographic Experts Group 

• PNG - Portable Network Graphics 

• GIF - Graphics Interchange Format 

• TIFF - Tagged Image File 

• BMP - Bitmap image files 

Note: OCR is applicable only for the following Data Transfer Channels, 

• Removable Devices 

• Network Share  

• Application/Online Services 
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Limitations 

• OCR does not support embedded images scanning.  

• Only Roman (English) alphanumeric script is detected from the images. 

• Only clear and high-quality images are detected by OCR. The blur, distorted, too small 

or too large images may not be detected.  

Note: OCR feature in DLP is available in Microsoft Windows Vista SP2, Windows 7 SP1, 
and above Personal computer versions and Windows Server 2008 SP2, Windows Server 
2008 R2 SP1, and above Server versions 

10. Expand Data Transfer Channels. Select the channels that you want to monitor from the 

following options: 

• Print Screen (applicable only in Windows platforms) 

• Removable Devices (applicable only in Windows platforms) 

• Network Share (applicable only in Windows platforms) 

• Clipboard 

• Printer Activity (applicable only in Windows platforms) 

• Application/Online Services 

11. Select the applications that you want to monitor for attempts at data pilferage by clicking 

the Applications list. Do one of the following: 

You can select all the applications in the group. 

• Select the applications one by one after expanding the group caret. 

• Select all Mac platform applications by clicking the Mac group icon. 

• Select all Windows applications by clicking on the Windows icon. 

• Select all Web Browsers or one by one after expanding the group caret. 

• Select all E-mail applications or one by one after expanding the group caret. 

• Select all Instant Messaging applications or one by one after expanding the group caret.  

• Select all File Sharing/Cloud Services applications or one by one after expanding the 

group caret. 

• Select All Social Media/Others applications or one by one after expanding the group 

caret. 

12. To configure email SSL settings, select the Enable Email scanning over SSL check box. This is 

applicable only when you select Email option in the Application / Online Service. Ensure that 

you perform the procedure to import the certificate for the mail client that you are using. 

This feature is available only in the clients with Microsoft Windows operating system. 

13. Expand Data Settings to configure the settings for File Types, Confidential Data, and User 

Defined Dictionary. 
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14. Select the Monitor File Types check box. Select the File Types caret from the following: 

• Graphic Files (Audio, Video, Images) 

• Office Files (MS Office, Open Office, Kingsoft Office) 

• Programming Files 

• Other Files (Compressed files etc.) 

15. To add the Custom Extensions, do the following: 

a. Select the Custom Extensions check box. 

b. Click Add button. Add Custom Extensions dialog appears. 

c. Type an extension in the text box and press enter. 

d. Click Add. 

You can delete the custom extension with the help of delete icon. 

16. Select the Monitor Confidential Data check box. Select the Confidential data carets from the 

following: 

• Confidential data such as Credit/Debit Cards 

• Personal information such as Social Security Number (SSN), Email ID, Phone Numbers, 

Driving License Number, Health Insurance Number, Passport Number, ID, International 

Banking Account Number (IBAN), Individual My Number, Corporate My Number, Pin 

Code, Aadhar Number, Vehicle Registration Number, Drug Enforcement Agency 

Number, Australia Tax File Number, Australian Business Number, and Australia Medical 

Account Number.. 

• Select the Monitor User Defined Dictionary check box.  

• The User Defined Dictionaries are created at Data Loss Prevention.The words/strings 

must be flagged if used in communication. 

Note: You can either choose to be notified through email notification when an attempt 

is made to leak information, or prevent the attempt from being carried out successfully.  

17. Expand Action to configure the action to be performed after the attempts is carried out, 

either Block and Report or Report only. Alert prompts will not be displayed for Report Only 

action. 

18. Expand Exceptions. To add the domain names that you want to exclude from Data Loss 

Prevention, do the following: 

a. Enter the domain name in the text box. 

b. Click Add. You can see the list of domain names. You can edit, delete and export the domain 

names. 

c. To import the domain name, click Import. The File Upload dialog appears. 
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d. Select the valid exported domain data file. 

e. Click Open. The database file is imported. 

Note: 

• Domain Exceptions support the Windows platform only. 

• Domain Exceptions support Microsoft Outlook and Thunderbird email clients only.  

• If sender and receiver are from different domains, add both domain names in 

Domain Exception. 

19. In Application Whitelisting, you can import application in .dat file format to exclude 

applications from Data Loss Prevention. Do the following: 

a. To download DLP Application Whitelisting Tool, click Download. 

b. After downloading the Whitelisting Tool, add applications for DLP whitelisting in the tool.  

c. Generate DLPAppWhiteList.dat file. 

d. Click Import to import DLPAppWhiteList.dat file. The applications are whilelisted. 

20. To add the network paths, do the following: 

a. Enter the Network path the text box. 

b. Click Add. 

c. You can see the list of Network path. You can edit, delete and export the Network path. 

d. To import the Network path, click Import. The File Upload dialog appears. 

e. Select a valid exported network share data file. 

f. Click Open. The database file is imported. 

Note: Network path supports the Windows platform only. 

21. Click Save Policy. 

Note: For Mac Client: 

• Confidential & User Dictionary Data will not be blocked in subject line, message body of 

email or messenger communication. 

• Prompts and report will be generated in case if monitored file type is downloaded. 

• Certain file types (POT, PPT, PPTX, DOC, DOCx, XLS, XLSX, RTF) containing unicode data 

will not be blocked. 

• Seqrite provides you an advanced scanning feature, Data-At-Rest Scan. With this feature 

you can search for a particular type of data in various formats. 
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Update 

When a work environment has a large number of systems installed, the challenge that the 

administrators usually face is how to update all the endpoints for security patches. 

This feature allows you to create policies for taking the updates automatically for the 

endpoints. You can create policies that help different clients take the updates from different 

sources. Taking the updates from different sources reduce the load on a single server. 

To configure policy for Update Settings, follow these steps: 

1. Create Container/feature policy for Update. 

2. Enable and expand Automatic Update. 

3. To display notification window when the updates are taken, select the Show update 

notification window check box. 

4. Under Frequency, set the schedule when you want to take the updates. 

• Automatic 

• Custom 

If you select Custom, Daily Start at and Repeat after, lists are activated, you can set the 

schedule as per your requirement. 

5. Under Update Mode, when EPS is installed on private IP (Private IP natted to Public IP), the 

following update settings can be configured: 

• Download from Internet 

• Download from Specified Update Agents 

If you select Download from Specified Update Agents, Update agent list is activated. 

Select the Update Agent from the list. The Antivirus Setup will be downloaded from the 

first Update Agent. If any Update Agent fails, the updates will be downloaded as per the 

sequence in this list. You can reorder this list to change the sequence. 

If all the Update Agents fail, then the Antivirus Setup will be downloaded from the 

Seqrite Internet center. 

6. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, you can do so by clicking the Reset Default button. 

Internet 

This feature gives the administrators a wider choice of creating policies for the client modules 

that need Internet connection to function. You can configure different settings for the server 

and port so that the client modules such as; Quick Update, Spam Protection, Web Security, and 

Messenger have Internet connection. This is very helpful in allowing the client modules to 
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function in a secure work environment where default Internet connection is not allowed. 

To configure policy with Internet Settings, follow these steps: 

1. Create Container/feature policy for Internet. 

2. Enable Proxy Setting. The proxy settings details are activated. 

3. Select the Proxy Type as HTTP Proxy, Socks V 4 or SOCKS V 5 as per your settings. 

4. In the Proxy Server text box, type the IP address of the proxy server or domain name (For 

example, proxy.yourcompany.com). 

5. In the Port text box, type the port number of the proxy server (For example: 80). 

6. In the User Name and Password text boxes, type in your proxy server credentials. 

7. Click Next. 

8. To save your settings, click Save Policy. 

Importantly, if you have customized the settings and later you want to revert to the default 

settings, you can use the Reset Default button. 

Note: The Internet Settings feature is applicable for the clients such as Microsoft Windows, 

and Mac operating systems. 

Miscellaneous 

This feature helps to receive notification to the given Email ID, give access to client settings.  

This feature allows you to create a policy that authorizes the clients to receive notification to 

the given Email ID, to access client settings and change their own password, enable or disable 

Safe Mode Protection, Self Protection, and News Alert. 

1. Create Container/feature policy for Miscellaneous. 

2. Enable and expand Notification. 

3. Select the following check boxes as per requirement to receive the notification when the 

incidents occur: 

a. Virus detected on endpoints 

b. Intrusion detected on endpoints 

c. Attempt to breach device control policy 

d. Attempt to breach DLP policy 

e. Hardware change detected on endpoints 

f. Endpoint virus definition is older than N days 

g. Attempt to access unauthorized application 

h. Virus active on endpoints 
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4. Select the Email Address from the list to receive the notifications. You can also add new 

Email Address. Enter new Email Address in the text box, and click Add. You can delete the 

Email Address with the help of Delete button. 

5. Enable and expand SNMP Configuration. Here you can enter the IP address of the Simple 

Network Management Protocol (SNMP) server in your network. This SNMP Server IP 

Address is sent to the client. As soon as the virus/ransomeware attack incident occurs, the 

client sends SNMP notification to the SNMP server and to the EPS server also. In the 

network without SNMP server, the virus attack notification is sent to the EPS server only as 

per heartbeat interval set for the client. Enter the SNMP Server IP Address in the text box. 

6. The Trap notifications can be viewed in the SNMP server where the configuration file, 

seqrite.mib is imported. Download the seqrite.mib file from the following SNMP Trap KB 

article, http://esupport.seqrite.com/support/solutions/articles/23000018039-how-to-

configure-snmp-under-eps-products– 

7. To give access to the client settings, Enable and expand Client Password. 

8. In Enter Password, type the password and then re-type the same password in Confirm 

Password field. The clients will have to use these passwords for accessing the client settings. 

The Safe Mode Protection check box is selected by default. Seqrite recommends that you do 

not disable this feature. 

9. The Self Protection setting is enabled by default. Seqrite recommends that you do not 

disable this feature. 

10. Expand Data Backup. Data Backup automatically and periodically (multiple times a day) 

takes a backup of all your important and confidential files present on the endpoint. If you 

update any file, then this feature automatically takes backup of the latest copy. In the Data 

Backup section, do the following, 

a. Default Backup Location is selected by default. The backup data is stored at the 

default location, by default. EPS Cloud server searches all volumes on the local PC 

and then selects the drive with maximum free space to store the backup data locally.  

b. Select New Backup Location option if you want to store your backup data at ther 

location. Enter the folder path. 

c. Select Network Path Location option if you want to store your backup data of all 

machines on a particular system in the network. Enter the Network Path Location. 

d. Enter Username and Password. 

e. Click Test to verify the location. 

f. You may receive an error message, because the server does not have access to the 

Network Path Location, but client may have access to the Network Path Location. 

http://esupport.seqrite.com/support/solutions/articles/23000018039-how-to-configure-snmp-under-eps-products
http://esupport.seqrite.com/support/solutions/articles/23000018039-how-to-configure-snmp-under-eps-products
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g. You may receive a success message but ensure that client have access to the 

Network Path Location. 

h. Shared drive will be created using Samba for Linux and Mac. 

i. You can view the list of default extensions by clicking the View Button. 

j. You can add custom extensions to the list as per your requirement. Enter extension 

and maximum file size in the text boxes. 

k. Click Add. You can delete the extension with Delete button. 

l. To exclude file extension from the data backup, enter the extension in Exclude File 

Extension box. Click Add. You can delete the excluded extension with Delete button. 

While performing backup, avoid including large size files such as PST, media files to 

ensure stable system performance and network operations. After successful client 

installation, backup starts after 6 hours. Disable this feature if you have any other 

provision for data backup (Example: File server backup, Data backup server, etc.)  

We have provided a backup facility with EPS Cloud. To restore your data, contact EPS 

Cloud Support Team. 

11. Expand Desktop Shortcut and Tray Icon. As per requirement, select the check boxes to 

create shortcuts for the following: 

a. Safe Banking 

b. Secure Browse 

You can configure number of days to change the colour of the tray icon if the client is 

not updated for a set number of days. 

Select number of days to turn the tray icon to red. 

Note: Desktop Shortcut and change Tray icon colour feature is not supported on Mac operating 

system 

12. To save your setting, click Save Policy. 
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Configurations 

On the Configurations page, you can perform the following: 

• Active Directory 

• Client Installation 

• Device Control 

• Data Loss Prevention 

• Application Control 

• Asset Management 

• SMTP Settings 

• Internet Settings 

• Roaming Service 

• Endpoint Threat Hunting 

• Patch Management 

• File Activity Monitor 

Client Installation 

On this page, you can verify the client installation path and set the automatic uninstallation of 

other antivirus software. 

Client Installation Path 

On this page, the client installation path appears. The client will be installed at this path. 

You can modify the path if required. 

Uninstalling other Antivirus Software 

While installing the client, if another antivirus software is already present on your endpoint, 

client installation does not proceed further until you uninstall the other installed antivirus 

software to avoid conflicts. 

If this option is selected, the client will uninstall other antivirus products after client agent 

installation. Seqrite client installation will fail if it’s not able to uninstall other antivirus. The 

failure notifications will be displayed on EPS Web Console Dashboard > Notifications.  

Seqrite installation will not be completed until the other antivirus is uninstalled manually. 

Before you begin, 

• Turn off the following settings for other antivirus (AV) present on the endpoints 
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▪ Password protection  

▪ Self/Tamper protections 

• Turn Off Windows Defender of the server OS. For Windows Server 2019 and Server 

2022, you need to uninstall Windows Defender. 

• Before mass deployment, test on one endpoint whether the Seqrite is able to uninstall 

other antivirus. 

Please note, 

• Some antivirus products require a password while uninstallation. User need to provide 

password if prompted. 

• The other Avs where user interface is displayed while uninstallation.  

▪ if the user is logged off, the other AV will be uninstalled when the user logged in.  

▪ Uninstallation is supported for the users logged in with Admin privileges.  

• The other AVs with silent uninstall support, will be uninstalled seamlessly.  

• If the other AV uninstallation is interrupted (Example: password not provided, 

uninstallation user interface closed by user, etc.), uninstallation will be attempted in the 

next periodic interval. 

• If the other AVs do not have uninstall support or If Seqrite is not able to uninstall other 

AV, you need to uninstall the other AV manually. 

Set the automatic uninstallation of other antivirus 

On this page, you can set the automatic uninstallation of other antivirus software. 

1. To uninstall the currently existing other antivirus from the endpoints automatically, select 

the Uninstall other Antivirus if present check box.  

By default, the check box is not selected.  

As the option is not selected, if other antivirus is already installed, then the Seqrite client 

installation will fail.  

On a console, you will receive a notification. 

2. Click Apply.  

3. Download the client packager for EPS client installation.  

Note: If the client agent was already created when Uninstall other Antivirus if present check 

box is disabled, you will need to create it again by enabling ‘Uninstall other Antivirus if present’ 

checkbox and reinstall client agent again with this client packager. 
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Device Control 

This feature helps you to add USB. If your organization has a large number of USB storage 

devices of the same make and model, you can add these USBs by model name. 

You can add other devices also, Example: Scanner, Card Reader, Local printers, Mobile phones 

etc. 

Adding USB Device 

To add USB device, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Device Control. 

3. The list of devices which are already added appears. Click the Add devices button and select 

USB Devices. The Add Device dialog appears. 

4. Follow the procedure mentioned in the dialog. 

5. Click Browse to upload the Device Control file. 

6. Click Add. 

Adding USB Device by Model Name 

To add USB device by Model name, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Device Control. 

3. The list of devices which are already added appears. Click the Add devices button and select 

USB by Model to add device by Model. The Add Device by Model Name dialog appears.  

4. Enter Device name. 

5. Select a mode from the Mode to add Model Name list. Select one of the following modes:  

• From the list: A list of pre-specified device model names appears. Select a model name 

from the list. 

• Manually: Enter model name. 

6. Follow the procedure mentioned in the For Windows / For MAC tab as per the endpoint 

operating system. 

7. Click Add. 

Note: To add multiple USB devices, remove all the connected USB devices. Attach the USB 

device that you want to add and follow the above procedure. 
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8. Select the devices that you want to manage from the displayed list and click OK. 

After the device appears in the list, toggle the button under Authorized to Yes or No as 

required. You can also use the Edit icon that appears to change the device name as it 

appears or use the Trashbox icon to delete the device from the list. 

Note: If you set the device authorized permission to ‘No’, then that device cannot be added 

to the exceptions list. 

9. To add the device to the exceptions list, go to Policies > Advanced Device Control. 

10. Click Exceptions. 

11. Click Add. The Managed Devices dialog box appears. 

12. Select one or more devices to add to the exception list. 

13. Click Add. 

The devices are now added in the list of exceptions. 

14. You can delete the devices with help of Delete button. 

15. Set the access permissions as required. 

16. Click Save Policy. 

Note: To add multiple USB devices, remove all the connected USB devices. Attach the USB 

device that you want to add and follow the above procedure. 

Adding USB by Serial Number 

You can use this option to add the USB by serial number without connecting the USB. 

To add a USB by Serial Number, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Device Control. 

3. The list of devices which are already been added appears. Click the Add devices button and 

select USB by Serial Number. The Add Device by Serial Number dialog appears. 

4. Enter Device Name. 

5. Enter Serial Number of the device. 

6. Click Add. 

After the device appears in the list, toggle the button under Authorized to Yes or No as 

required. You can also use the Edit icon that appears to change the device name as it appears. 

Use the Delete button to delete the device from the list. 
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Adding Other Devices 

To add other devices, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Device Control. 

3. The list of devices which are already added appears. Click the Add devices button and 

select Other Devices. The Add Device dialog appears. 

4. Select Device Type from the list. 

5. Enter Device Name. 

6. Enter Description of the device. 

7. Enter Vendor ID. 

8. Enter Product ID. 

9. Enter Serial Number. 

10. Click Add. 

After the device appears in the list, toggle the button under Authorized to Yes or No as 

required. You can also use the Edit icon that appears to change the device name as it appears. 

Use the Delete button to delete the device from the list. 

Viewing Details of Devices 

To view details of devices, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Device Control. The list of devices which are already added appears. 

The list displays the following details of the devices: 

Fields Description 

Device Name Displays the device name. 

Device Type Displays the device type of the device. 

Serial Number Displays the serial number of the device. 

Model Name Displays the model name of the device. 

Encryption Status Displays whether the device is encrypted or not. 

Authorized Displays status of the authorization, whether ON / OFF. 

Deleting the Device 

To delete the device, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 
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2. Go to Configurations > Device Control. The list of devices which are already added appears. 

3. Select the device that you want to delete. 

4. Click Delete button. 

Updating the Device 

To update the device, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Device Control. The list of devices which are already added appears. 

3. Click the Update icon for the device that you want to update. 

4. Edit Device name dialog appears. Update the device name. 

5. Click Save. 

Data Loss Prevention 

You can add certain key words, or phrases that might contain, or refer to confidential 

information in the User Defined Dictionary. If any of the documents on your endpoints contains 

the text or phrase that you have added to the User Defined Dictionary, the Data-At-Rest Scan or 

Data Loss Prevention feature displays the path or location of these documents. 

On this page, User Defined Dictionaries can be created or managed which will be monitored 

through Data Loss Prevention Settings. 

Adding Dictionary 

To add dictionary, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Data Loss Prevention. 

3. Click Add > Add. 

4. Enter the details such as name, description and the word that you want to add. 

5. Click Add. 

You can add multiple words to the dictionary. 

You can delete a word from the list by selecting a particular word and clicking Delete. 

Importing Dictionary 

You can also import a dictionary that you prefer to use. 

To import the dictionary, follow these steps: 

1. Log on to the SEQRITE Endpoint Security. 

2. Go to Configurations > Data Loss Prevention. 
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3. Click Add > Import. 

4. In the Import Dictionary dialog, click Browse. The File Upload dialog appears. 

5. Select the valid exported dictionary json file (Example: DLP_Dictionary.json). 

6. Click Open. 

The json file is imported. 

Deleting Dictionary 

You can delete a dictionary that you do not require. 

To delete the dictionary, follow these steps: 

7. Log on to the SEQRITE Endpoint Security. 

8. Go to Configurations > Data Loss Prevention. 

9. The page appears displaying list of dictionaries. 

Select the check box of the dictionary that you want to delete. 

10. An action bar is enabled above the table. 

Select Delete. 

11. The confirmation message appears. Click Yes. 

The selected dictionary is removed. 

Asset Management 

To view the complete product key on the Endpoint Status page, select the OS Product key check 

box. If you do not select this check box, only partial product key will be displayed. 

This feature is applicable only for the clients with Microsoft Windows operating system. 

Web Access Controller Settings 

Seqrite Endpoint Security is launching a new extension called Web Access Controller. This 

extension ensures that users within your organization can only sign into their Corporate Google 

Accounts on the Endpoint’s Google Chrome or Microsoft Edge Browser for specific domains 

that are configured by the Administrator. This implementation ensures compliance and 

prevents any misuse or abuse. 

Additionally, this extension offers an additional layer of security by restricting users within your 

organization from watching YouTube videos solely on the Endpoint’s Google Chrome or 

Microsoft Edge Browser. Users can only access videos of specific categories, channels, and 

publishers, enhancing compliance and preventing unauthorized usage. 

This extension must be used with Seqrite Endpoint Security; cannot be used independently.  

https://docs.seqrite.com/docs/seqrite-eps-cloud/status/endpoint-status/
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Web Access Controller Extension Settings 

On this page, you can configure extension application settings. 

Web Access Controller extension is installed by Seqrite Endpoint Security automatically.  

1. In Extension Installation Settings section, select one of the following options. 

a. Manually restart Browser to apply Extension – You need to restart the browser 

manually. When the fresh browser session starts, Seqrite Extension is applied. 

b. Automatically terminate Browser to apply Extension – The current session of the 

browser will be terminated automatically, and the extension will be applied when 

the next browser session will be started. 

2. Select the Protect Web Access Controller Extension check box to disable the installation 

of other Browser Extensions. If you enable this, you cannot install any new browser 

extensions. 

Web Access Controller extension will be applied according to above settings to the broswer.  
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File Sandbox 

File Sandboxing helps you submit a suspicious file for analysis to determine if the file is 

malicious or safe. The major advantage of the File Sandbox is that it can reliably detect 

unknown threats. 

This feature is accessible for the Admin and Super Admin only.  

If you suspect a file to be malicious in your environment, you can submit that file to the 

sandbox for detonation. 

Sandbox detonation - Sandbox security testing detects malware by running suspicious code in a 

safe and isolated environment and monitoring the behavior and outputs of the code. This is 

known as “detonation”.  

Supported File Types (Extensions):  

"sh", "js", "7z", "py", "doc", "rtf", "xls", "ppt", "pps", "ps1", "bat", 

"eml", "exe", "jar", "txt", "odt", "odp", "ods", "swf", "msg", "msi", 

"pdf", "rar", "vbs", "zip", "cab", "lnk", "xml", "dll", "tar", "hta", 

"elf", "docx", "docm", "link", "xlsx", "xlsm", "xlsb", "pptx", 

"ppam", "html" 

Submitting file to Sandbox 

To submit a file to the sandbox, do the following steps. 

1. Log on to the Seqrite Endpoint Security. 

2. Go to File Sandbox. 

3. Click Browse to upload the file. 

4. Click Submit. 

5. The success message appears. 

Notes: 

• The maximum file size to submit to the sandbox is 64 MB. 

• The maximum no. of files you can submit depends upon your subscription to File 

Sandboxing-Total Detonations.  

Reports of File Sandbox 

1. In the File Sandbox Report section, existing reports if any are listed. 

2. Select the Period and Detonation Status for which you want to generate the report.  
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3. To add filters, click Add Filters. The parameters in the Add Filters are File Name and 

Threat Type. Select or clear the filter that you want to add or remove. 

4. To generate the report on the selected parameters, click Generate Report. The report in 

tabular format will be displayed.  

The report displays the following details of detonation analysis. 

Fields Description 

File Name Displays the file name which is submitted in the sandbox. 

Detonation Status Displays one of the following detonation statuses.  

• Completed 

• In progress 

• Queued 

• Analyzing 

• Failed 

Threat Type Displays the threat type (if any) the file contains. 

Submission Date Displays the date and time when the file was submitted for 

detonation. 

Completion Time Displays the date and time when the file detonation was complete. 

Report Redirects to the detailed detonation report. 

Details Displays further details of the threat. To view the details, click the 

Details link. 

Exporting the Report 

Select the CSV option from the Export as list to export the tabular report in CSV format. 

Select the PDF option from the Export as list to export the tabular report in PDF format.  

The Email containing a link to download the report will be sent to your registered Email 

address. The link is valid for 72 hours only. 
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Reports 

The Reports page provide the latest information of all clients and keeps comprehensive logs 

about virus incidents, policy breaches, and updates. 

You can view and generate reports for the listed categories. You can create your own custom 

category as per your requirement. There are default reports displayed for each category. You 

can create your own query and generate the custom reports. You can manage the generated 

queries. 

On the reports page, you can do the following. 

• View charts of the listed categories 

• Create queries to generate custom reports 

• Add custom category to generate reports 

• Download the archived monthly reports from server 

Note: Custom created reports can be viewed only by the user who has created the reports.  

The following are the listed categories for the reports: 

• Virus Scan – You can view the virus incidents after scanning the clients. You can also 

view the statistics of unscanned endpoints since the last 1 ,3 ,7 ,15, and 30 days.  

• Anti-Malware Scan – You can view the malware incidents after scanning the clients. 

• Web Security – You can view statistics of Web sites blocked through the Browsing 

Protection, Phishing Protection, or block Web site modules. 

• Tune-up – You can view the number of clients tuned up and not tuned up at all. 

• Advanced Device Control – You can view whether removable devices have been blocked 

and what actions were taken against unauthorized device access. 

• Device Exception – You can view details of devices added as exceptions in the Advance 

Device Control policy. This report is only in the tabular format, not in the chart format.  

• Data Loss Prevention – You can view statistics about attempts of sending the data 

outside the organization in an unauthorized manner. Data-at-Rest scan reports are 

included in DLP on demand report. You can view the information related to the 

detected confidential data such as; the file path, threat type, and matched text. You can 

generate a DLP report for a single endpoint at a time. 

• IDS/IPS – You can view whether there was any Port scanning attack, DDOS (Distributed 

Denial of Service) attack, or any attempt of intrusion, and actions taken. 

• Firewall – You can view number of violations for Firewall such as; the blocked 

connection for communications (Inbound or Outbound) and Firewall security level.  
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• Asset Management – You can view reports related to the hardware/software assets of 

the Endpoints. 

• Application Control – You can view statistics about how many applications were 

authorized or unauthorized. You can also view the application control scan reports here.  

• Backup for Ransomware Protection – You can view reports when the backup is failed. 

The reports display the reason for the failure of backup. This report is only in the tabular 

format, not in the chart format. 

• Vulnerability Scan – You can view reports of vulnerabilities present on the endpoints in 

the network. 

• Host Integrity – You can view reports of compliant and non-compliant endpoints. This 

report is only in the tabular format, not in the chart format. 

The procedures written below are same for all the above categories including custom category.  

On the reports page, you can do the following. 

• Viewing chart report 

• Viewing tabular report 

• Managing Query 

• Custom Category 

• Archived Monthly Reports 

Viewing Chart Report 

To view the reports, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Select the category for which you want to view the report. The default 

chart report of last 7 days appears. The chart reports are in Line chart and Pie chart format. 

The data points on the line chart are interactive. 

3. Hover the chart, a tool-tip appears showing the count of that part. 

4. Click the data point/slice, a pop-up appears displaying details of that part of chart. 

You can generate a new chart by adding a query. You can create maximum 25 reports for 

each category. The reports are displayed in expand / collapse format. 

The following table shows the types of chart reports per category. 

Category Types of Reports 

Virus Scan Virus Incidents 

Anti-Malware Scan Anti-Malware Incidents 
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Web Security 
• Blocked Websites 

• Websites blocked by categories 

Tune-up Tune-up Status 

Advanced Device Control • Number of device violations 

• Policy violations by devices 

Data Loss Prevention • DLP violations 

• Data leaks through data transfer 

channel 

• Type of Data Leaks 

IDS/IPS Intrusion Incidents 

Firewall No. of violations 

Asset Management • Software & Hardware changes 

• Platforms 

• Applications installed 

Application Control 
• Blocked Applications 

• Blocked Applications as per 

category 

Vulnerability Scan Vulnerabilities by Vendor 

Vulnerabilities by Severity 

You can refresh the chart report with the Refresh icon for the latest data. 

You can edit the chart report with the Edit icon. 

You can remove the custom chart with the Close icon. 

Viewing Tabular Report 

To view the reports, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Select the category for which you want to view the report. The default 

chart report appears. 

3. To view the tabular report, click Tabular icon. 

4. The list of queries appears. Click the View link of the query that you want to view. 

5. The Report page opens. The Group and Period appears as per the query. 

6. To add filters, click Add Filters. The parameters in the Add Filters are Endpoint Name and 

User Name. Select or clear the filter that you want to add or remove. 



   

Copyright © 2008–2023 Quick Heal Technologies Ltd.  132 

7. To generate the report on the selected parameters, click Generate. Click Save to save the 

selected parameters. The filter is changed after saving. 

After clicking Generate button, the report in the tabular format will be displayed. In 

addition, if you want to change the columns then you can do it by using Columns list. 

You can save the report in the csv format using the CSV button. 

Downloading Report 

To download the tabular report in the CSV format, select the CSV option from Export as a list. 

The report will be downloaded immediately on the working machine. 

Exporting Report in PDF Format 

To export the tabular report in PDF format, select the PDF option from Export as a list.  

The Email containing a link to download the report will be sent to your registered Email 

address. The link is valid for 24 hours only. 

Note: You can download the reports in the CSV format for maximum of 15,000 records. 

For records, more than 15,000, use option export as PDF. 

Managing Query 

There are default reports displayed for each category. You can create and manage your own 

query and generate the custom reports. 

Adding a Query 

To add a query, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Category for which you want to create a chart. 

3. The list of default queries appears. Click the Add Report button to create new query. 

4. The Add Report dialog appears. Select the Sub-Type. The Sub-Type option is for Web 

Security, Advanced Device Control, Data Loss Prevention, Asset Management categories 

only. 

5. Enter Report Name and Description. 

6. By default, All Groups option is selected. You can select the group if required. 

7. By default, Last 7 Days option is selected in Periods. You can change the period for report.  

8. Click Add. The query is generated. 

Updating a Query 

To update the query, follow these steps: 
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1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Category for which you want to update the chart. 

3. The list of queries appears. Click the Edit icon of the query that you want to update. The 

report page opens. 

4. Select a Group or type the group name. By default, all groups option is selected. 

5. In the Period list, select period of the report. Select number of days. You can also select 

Custom option and then select the start and end dates for the reports. 

6. As per the filter, Endpoint Name and User Name parameters are displayed. If you want to 

generate reports for a group, leave the endpoint name text box blank. If you want to 

generate reports for an endpoint name, enter the endpoint name in the text box. The 

reports will be generated for that endpoint name. 

7. Enter user name in the User Name text box. 

8. To add filters, click Add Filters. The parameters in the Add Filters are Endpoint Name and 

User Name. Select or clear the filter that you want to add or remove. 

9. Select the columns to be displayed in the report. By default, all parameters are selected. 

10. To generate the report on the selected parameters, click Generate Report. You can save the 

set of parameters. Click Save to save the selected parameters. When you visit this page next 

time, the reports of this saved parameters are displayed. The filter is changed after saving.  

 

Note: You cannot edit the default query. 

Deleting a Query 

To delete the query, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Category for which you want to delete the chart. The list of queries appears. 

3. Select the check box of the query that you want to delete. 

4. In The Please Select list, select Remove Query. 

5. Click Submit. 

6. The confirmation message appears. Click OK. 

The selected query is removed. 

Note: You cannot delete the default query. 

Duplicating a Query 

To duplicate the query, follow these steps: 
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1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Category for which you want to duplicate the chart. The list of queries 

appears. 

3. Click the duplicate icon of the query that you want to duplicate. 

4. The duplicated query appears in the next row. Edit the name of the query. Click tick icon to 

save the query. 

The selected query is duplicated. 

Moving a Query 

You can move the query only to the custom category. 

To move the query, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports > Category for which you want to move the chart. The list of queries appears. 

3. Select the check box of the query that you want to move. 

4. In The Please Select list, select Move To. 

5. Select the custom category where you want to move the query. 

6. Click Submit. 

7. The confirmation message appears. Click OK. 

The selected query is moved. 

Note: You cannot move the default query. 

Custom Category 

You can create a custom category as per your requirement. In this category, you can move 

queries from the other categories, generate queries as per your requirement and generate 

custom reports. 

Adding a Custom Category 

To add a custom category, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Reports. The Reports page opens. 

3. Click the Add Category button to create new category. 

4. Enter name of the new category. 
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5. Click Add. 

The new category is added in the category list. 

You can edit or delete the custom category with help of icons. 

Archived Monthly Reports 

Every month a report is generated from the 1st day of the month to the last day of the month, 

by default. This report is sent to the registered Email address on 1st day of next month 

automatically. 

On the Archived Monthly Reports page, you can view list of last 15 monthly archived reports. 

To download the report, follow these steps: 

1. Click the link of the month for which you want to download the report. 

The report is downloaded in the archive file format, zip. The zip report file is password 

protected. The zip report file is password protected and the password is tenant ID present 

on the license page. 

2. Extract the zip file. 

Seqrite recommends using a third-party archive tool like 7-Zip, WinRar, WinZip, or PeaZip to 

extract the zip file. The window 10 default extract tool may not support extracting of this 

report zip file. 

  

https://docs.seqrite.com/docs/seqrite-endpoint-security-eps-cloud-beta-2/admin/license/
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Admin 

License 

This page will be visible only to the customers who have purchased only Seqrite EPS. 

On this page, you can manage Seqrite Endpoint Security licenses. You can check the status of 

your Seqrite Endpoint Security license and DLP licenses information. For post-paid license, 

license information is not displayed. 

License Status 

In the License Status window, you can check the current status of your license information.  

The license information includes the following details: 

Title Description 

Company Name Displays the name of the company to which Seqrite 

Endpoint Security is registered. 

Product Name Displays the product name, Seqrite Endpoint Security. 

Product Edition Displays the product edition. 

Product Key Displays the Product Key of Seqrite Endpoint Security. 

License Expiry Date 

(GMT+5:30) 

Displays expiry date of the Seqrite Endpoint Security 

license. This field is not shown if the license type 

is Subscription. 

HawkkHunt Displays whether subscribed to HawkkHunt or not. 

License Type Displays type of the license from the following, · Trial · 

Commercial · Subscription 

Tenant Id Displays Tenant Id. This is password to extract zipped 

folder of archived monthly reports. 

The license status displays three half pie charts, one chart for EPS License, the other for DLP 

License and one for File Sandbox License. The chart displays the number of licenses utilized and 

licenses remaining. 

Update License Information 

This feature is useful to synchronize your existing license information with Seqrite Activation 

Server. You can update your license information whenever required by clicking the Update 

License Information button. 
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Licence Order 

The License Order window user interface changes according to your EPS Cloud license. 

If you have trial license,user interface to convert it into commercial license appears.  

If you have commerciallicense, user interface to place an order with different options appears.  

If you have trial license 

In the License Order window, you can do the following. 

• Convert your current trial license to commercial license by buying commercial license. 

• Activate your EPS Cloud product with the product key that you have 

Converting trial license to commercial license 

To buy commercial license, click the Buy Now button. 

An automated Email is sent to the Partner to process your order. 

If you are using trial license of any edition, you can convert it into commercial license. This 

needs to be done before the trial license period expires. 

While converting to commercial license, you can convert the trial license to the same edition or 

lower editions only. 

The benefit of this feature is your setup of Seqrite EPS remains intact. All your endpoints, 

created policies, applied policies remain as it is, if you convert to same edition. 

If you convert to downgrade license, only the features available in the downgraded edition will 

be available. 

If you have product key 

If you have the product key, you can activate EPS Cloud with the following steps. 

1. In the License Order window, click the ‘Have a product key? Activate license’ button.  

The Activate dialog box appears. 

2. Enter product key to activate Seqrite Endpoint Security Cloud. 

3. Click Activate. 

In few minutes, your commercial license for EPS Cloud will be set. A notification will be sent 

to your registered Email address once the setup is ready. 

4. Update License Information by clicking Update License Information button. 

If you have commercial license 

In the License Order window, you can place an order to renew your license, add new licenses to 

your existing setup, or buy additional features packs. 
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To place an order, follow these steps: 

1. Select one of the following options: 

a. Renew my license: Helps you renew your current license. 

b. Add license for new endpoints: Helps you buy additional licenses. 

c. Edition Upgrade/Buy additional feature: Helps you upgrade the edition or buy 

additional features packs as per the following table: 

2. Click Place an Order. 

An order is created, and an automated Email is sent to the Partner to process your order.  

Activity Logs 

This page helps you check the activity logs of all the incidents occurred on the server. 

You can select the number of days, either 7 or 15, for which the activities are generated. By 

default, you can view logs of the last seven days. You can also select Custom option and then 

select the start and end dates for the activity logs. 

To export complete activity log, click CSV button. ActivityLog.csv file is downloaded. 

User Roles 

The User Roles page displays the list of all the user roles. The table of the user role displays 

information such as Role Name, Role, Role Type, Last Updated and Action. 

To select all the user roles from the list, select the check box in the header row. 

To select an individual user role, select the check box in that row. 

You can view the user role privileges of the default role types by clicking the view icon. 

This feature helps you create, modify, duplicate, and delete roles for different types of user 

roles. The following are default user roles. 

• EPS User Roles 

▪ Super Admin 

▪ Admin 

▪ Report Viewer 

▪ Group Admin 

• HawkkHunt User Roles 

▪ HawkkHunt Admin 

▪ HawkkHunt Incident Responder 

• HawkkEye User Roles 

▪ Help Desk 
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▪ User 

You cannot delete default User Roles. 

You can create custom roles as per your requirement. 

EPS User Roles 

For EPS, the following user roles are added. 

Super Admin 

A Super Admin user has all the privileges to access, manage and delete the features of Seqrite 

Endpoint Security. You cannot edit the privileges. The role type is default. There can be only 

one user with Super Admin privilege. The default user role name for Super Admin is "Super 

Admin". 

Admin 

User with Admin privileges has privileges to access, manage and delete the features of Seqrite 

Endpoint Security. The default user role name for Admin is "Admin". You can create multiple 

user roles for Admin, if required. 

Report Viewer 

A user with the Report Viewer role has only access privileges, this user cannot manage or delete 

roles. The default user role name for Report Viewer is "Report Viewer". You can create multiple 

user roles for Report Viewer, if required. 

Group Admin 

A Group Admin user can view and manage its own group only. The default user role name for 

Group Administrator is "Group Admin". You can create Group Admin for each group. You can 

assign multiple Group Admins to one group. 

Super Admin and Admin user can create/edit/delete the Group Admin user and assign/unassign 

the Group Admin to any group. 

Group Admin can generate reports in table /chart formats for assigned group only.  

When Group Admin logs on, the Status page is displayed by default. The Group Admin has 

limited access to pages of Seqrite Endpoint Security. 

HawkkHunt User Roles 

For the HawkkHunt feature, the following user roles are added. 

HawkkHunt Admin 

A HawkkHunt Admin user has full access to HawkkHunt. 
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A user with the HawkkHunt Admin role has access to the following pages of Seqrite Endpoint 

Security Cloud also, 

Pages User Role Privileges 

Dashboard Read only 

User Manage 

Group Read only 

Admin Activity Log Read only 

Admin User Roles Manage and Delete 

HawkkHunt Incident Responder 

This HawkkHunt feature user, has full access to HawkkHunt. 

A user with the HawkkHunt Incident Responder role has access to the following pages of Seqrite 

Endpoint Security Cloud also, 

Pages User Role Privileges 

Dashboard Read only 

Admin Activity Log Read only 

Admin User Roles Read only 

 

HawkkEye User Roles 

For HawkkEye, the following user roles are added. 

Help Desk 

• A user with this role should be allowed to view, create, and manage everything (in all 

products), except for deleting anything. Also, they should not have access to user roles 

and not be able to assign the user role to the users. 

• Help Desk role of HawkkEye should be mapped with the current default role “Advanced” 

of EMM. For, EPS we don’t any default role to which we can map this role so the new 

default role has to be added in EPS. In this role as mentioned above view, create, and 

manage access everything should be provided, except for deleting anything. Also, they 

should not have access to user roles and not be able to assign the user role to the users.  
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User 

A user with this role should not have access to HawkkEye or an individual product’s console.  

Add User Role 

To add a user role, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Admin > UserRoles. 

3. On the User Roles page, click Add User Role. The Add User role page appears. 

4. From the Role list, select the type of role for which you want to create a user role.  

5. In the Role Name text box, type the name of the role. 

6. Configure access rights by selecting/clearing the check boxes. 

7. To save your access rights, click Add. 

Edit User Role 

To modify the settings of an existing user role, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Admin > User Roles. A list of all user roles appears. 

3. Click the Edit icon for the user role that you want to edit. 

4. Modify the access rights. 

5. To save the modified access rights, click Save. 

Note: You cannot edit or delete the default user role. 

Deleting User Role 

To delete an existing user role, follow these steps: 

1. Log on to Seqrite Endpoint Security. 

2. Go to Admin > User Role. A list of all user roles appears. 

3. Select the user role that you want to delete. 

4. The delete action bar is enabled above the table. Select Delete. You can delete a user role if 

you have the right privileges to do so. A confirmation message appears. 

5. To delete the user role, click Yes. 

Note: You cannot edit or delete the default user role. 
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Duplicating the User Role 

To duplicate the user role, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Admin > User Role. A list of all user roles appears. 

3. Click the duplicate icon of the user role that you want to duplicate. 

4. The duplicated user role appears in the next row. Edit the name of the user role.  

5. Click tick icon to save the user role. The selected user role is duplicated. The privileges 

remain same. You can change the privileges if required. 

Notification 

This page helps you set rules for sending notifications for events such as when update Agent 

virus definition are older and virus outbreak. 

You need to create a rule and a list of Email addresses to send the notifications. 

Set Rules to Send Notification 

1. Select the Enable Notifications Settings check box to set the rules. You can see the list 

of settings with > sign to expand and toggle button. Expand and enable Email that you 

want to configure. 

2. Enable and expand Virus Infection. You can select the respective Email check boxes 

for Virus detected on endpoints and Virus active on endpoints. 

3. For Virus outbreak in network, select values for the following to send the notification 

when the values are attended: 

• Number of virus incidents exceeds 

• Number of affected endpoints 

• Time span (minutes) 

4. For Ransomware detected on endpoints, select the Email. check box. 

5. Enable and expand IDS/IPS. You can select the respective Email check boxes for the 

following. 

• Intrusion detected on endpoint 

• Port Scanning incident detected on endpoint 

• DDOS Attack detected on endpoint 

6. Enable and expand Advanced Device Control. You can select the respective Email check 

box for the following. 
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• Attempt to breach the Device Control policy 

7. Enable and expand DLP. You can select the Email check box for the following. 

• Attempt to breach DLP policy 

8. Enable and expand Application Control. You can select the Email check box for the 

following. 

• Attempt to access unauthorized application 

9. Enable and expand Update. Select the number of days for the following if you want to 

change the default value of 15: 

• Endpoint virus definition is older than N Days 

• Update Agent virus definition is older than N Days 

10. Enable and expand Asset Management. You can select the Email check box for the 

following. 

• Hardware change detected on endpoints 

11. Enable and expand Install through Active Directory. You can select the Email check box 

for the following. 

• Synchronization with Active Directory failed 

12. Enable and expand Client Deployment. You can select the respective Email check boxes 

for the following. 

• Endpoint installation successful 

• Endpoint uninstallation successful 

• Unprotected Endpoints 

13. Enter Email address in the text box and click Add. When the set rule condition is 

attended, a notification is sent to the Email addresses added here. You can delete or 

edit the Email addresses. 

14. Click Save. 

General Settings 

On this page, you can configure an interval for deleting older Activity Logs, Action History, 

Reports, Notifications, Alerts and News. You can set Client-Server communication interval time. 

To do Admin Settings, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Admin > General Settings tab. 
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3. The following actions are displayed in the tabular format. Set the interval in days/Minutes 

for these actions. Set the switch to ON or OFF to apply the action. 

• Delete Activity Log older than 7 or 15 days 

• Delete Action History older than 7 or 15 days 

• Delete Notifications older than 7 or 15 days 

• Delete Alerts older than 7 or 15 days 

• Store Data-At-Rest scan reports for last 1, 2, 3 scans 

• Store Application Control scan reports for last 1, 2, 3 scans 

• HawkkHunt Feature – The Enable on all endpoints check box is selected by default. If 

you clear the check box, the HawkkHunt feature will be disabled. For more information 

about HawkkHunt, see Go to HawkkHunt. 

• Remove endpoint if inactive for 15 or 30 or 60 days. Selecting Never option will not 

remove the endpoint in spite inactive. 

Scheduled Report Settings 

Every month a report is generated from the 1st day of the month to the last day of the month, 

by default. This report is sent to the registered Email address on 1st day of next month 

automatically. Example: The reports are generated for the period of 1 October to 31 October 

and are sent on 1st November automatically. 

You can also generate Weekly reports. You need to select the day. Reports of last 7 days from 

the selected day are generated and sent to the registered Email address. Example: If you select 

“Monday”, the reports are generated from last Monday to Sunday.  

On Scheduled Report Settings page, you have provision to configure Monthly or Weekly 

reports. 

To do Scheduled Report Settings, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. Go to Admin > Scheduled Report Settings tab. 

3. On the Scheduled Report Settings page, you can see the following list of settings with 

expand sign button. 

• Monthly Reports 

• Weekly Reports 

4. To configure Monthly Reports, follow these steps: 

a. Expand Monthly Reports option. 

https://docs.seqrite.com/docs/seqrite-eps-cloud/go-to-hawkkHunt/
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b. Here you can add Email addresses to whom the consolidated monthly reports will be 

sent. Add at least 1 Email address, maximum 5 Email addresses are allowed. 

c. Type an Email address in the Add Email address text box, and then click Add. 

d. You can delete the Email address if not required with the help of Delete icon. 

The monthly reports are deleted after 15 months. 

5. To configure Weekly Reports, follow these steps: 

a. Expand and Enable Weekly Reports option. 

b. Schedule your weekly report by selecting Day. 

c. Add Email addresses to whom the consolidated weekly reports will be sent. Add at least 

1 Email address, maximum 5 Email addresses are allowed. 

d. Type an Email address in the Add Email address text box, and then click Add. 

You can delete the Email address if not required with the help of Delete icon. 

e. Under Report Type, select at least 1 type of report. 

The weekly reports are deleted after 3 weeks. 

6. To save your settings, click Save. 

The Monthly reports will be sent to the added Email addresses on 1st of next month. 

Also, you can download the monthly reports from the Reports > Archived Monthly 

Reports page. 

The Weekly reports will be sent to the added Email addresses on the selected day. 
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Support 

For the users of Seqrite EPS Cloud with HawkkEye 

For customers who have purchased Seqrite HawkkEye with Seqrite EPS Cloud, this page is not 

applicable hence not visible. 

For the users of only Seqrite EPS Cloud 

This page will be visible only to the customers who have purchased only Seqrite EPS Cloud. 

Seqrite provides extensive technical support for the registered users. It is recommended that 

you have all the necessary details with you during the call to receive efficient support from the 

support executives of Seqrite. 

The Support gives you options of Web Support where you can find answers to the most 

frequently asked questions, options to submit your queries, send emails about your queries, or 

contact us directly. 

The Support page includes the following options: 

• Email Support: Includes Submit Ticket that redirects you to our Support webpage. Here 

you can read some of the most common issues with answers. If you do not find an 

answer to your issue you submit a ticket. 

• Live Chat Support: Using this option, you can chat with our support executives. 

• Support Contacts: To know support contacts, please 

visit http://www.seqrite.com/contact_support 

Head Office Contact Details 

Quick Heal Technologies Limited 

(Formerly known as Quick Heal Technologies Pvt. Ltd.) 

Reg. Office: Marvel Edge, Office No.7010 C & D, 7th Floor, 

Viman Nagar, Pune 411014, Maharashtra, India. 

Official Website: http://www.seqrite.com. 

Email: support@seqrite.com 

Copyright Information 

Copyright © 2018–2023 Quick Heal Technologies Ltd. All Rights Reserved. 

No part of this publication may be reproduced, duplicated, or modified in any form or 

incorporated into any information retrieval system, electronic or any other media or 

http://www.seqrite.com/contact_support
http://www.seqrite.com/
mailto:support@seqrite.com
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transmitted in any form without prior permission of Quick Heal Technologies Limited, Marvel 

Edge, Office No. 7010 C & D, 7th Floor, Viman Nagar, Pune 411014, Maharashtra, India.  

Marketing, distribution or use by anyone barring the people authorized by Quick Heal 

Technologies Ltd. is liable to legal prosecution. 

Trademarks 

Seqrite and DNAScan are registered trademarks of Quick Heal Technologies Ltd. while Microsoft 

and Windows are registered trademarks of Microsoft Corporation. Other brands and product 

titles are trademarks of their respective holders. 

License Terms 

Installation and usage of Seqrite Endpoint Security Cloud is subject to user’s unconditional 

acceptance of the Seqrite end-user license terms and conditions. 

To read the license terms, visit http://www.seqrite.com/eula and check the End-User License 

Agreement for your product. 

  

http://www.seqrite.com/eula
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Go to HawkkHunt 

HawkkHunt is a new Seqrite product, aimed at detecting and responding to active cyber threats 

in an organization’s network. 

Seqrite HawkkHunt is available only in the English language. 

Seqrite HawkkHunt enhances the power of Seqrite Endpoint Security by proactively monitoring 

the organization’s network for any signs of active cyber threats and helping mitigate advanced 

malware attacks before they cause major damage. Threat Hunting, which is at the core of 

HawkkHunt, gives users in-depth visibility into digital artefacts present on the endpoints. 

Additionally, HawkkHunt enables users to forensically examine the trail of attacks-in-progress 

and respond appropriately. 

Seqrite HawkkHunt supports: 

• Threat Hunting 

• System and Custom Alerts 

• Detailed Alert Analysis 

• High Level Reports 

You must purchase a commercial license for HawkkHunt to use it with Seqrite EPS. A trial 

version for a limited period is also available for you to try before you buy. 

If you have purchased the commercial license for HawkkHunt, click Go to HawkkHunt link to 

access HawkkHunt console. 

If you have not purchased a commercial licence for Seqrite HawkkHunt, when you click the Go 

to HawkkHunt link, you are navigated to the Demo request page of Seqrite HawkkHunt. 

Here you can view information about Seqrite HawkkHunt and submit a demo request by filling 

the form. 

Note: Only the Super Admin and HawkkHunt User Roles have access to Go to HawkkHunt link.  

For information about User Roles to access Seqrite HawkkHunt, see User Roles. 

By default, HawkkHunt Feature is enabled on all the endpoints when purchased. For more 

information, see Settings. 

 

 

  

https://docs.seqrite.com/docs/seqrite-eps-cloud/admin/user-roles/
https://docs.seqrite.com/docs/seqrite-eps-cloud/admin/settings/
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Header Icons 

Alerts 

The Alerts icon on the header displays alert messages for the following critical situations:  

• Update Manager not updated. 

• License Suspended or Blocked 

• License limit reached. 

• License about to expire. 

• DLP License count is updated. 

1. Click Update Now to update the selected alert. The request for an update is sent. 

2. Click OK. 

3. Click See all alerts, to view the list of all alerts. 

4. Click Update Now to update the selected alert. The request for an update is sent. 

5. Click Delete to delete the selected alert message. A confirmation message appears. 

6. Click OK to confirm. 

Renew/Buy option also available to renew expired licenses or add an additional 

endpoint. 

Notifications 

The Notification icon on the header displays the list of Notifications. Notifications such as 

Update Agent installation failed, and Client deployment failed are displayed. When you click the 

notification, a new window of Notification Details appears showing the details. 

Click See all Notification to go to Notifications page. 

The Notifications table appears. You can view details of the notification by clicking View icon.  

Deleting the Notification 

To delete the notification, follow these steps: 

1. On the notification page, you can view list of notifications. 

2. Select the check box of the notification that you want to delete. An action bar is enabled 

above the table. 

3. Select Delete. 

4. The confirmation message appears. Click OK. 
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Editing the User Profile 

This page will be visible only to the customers who have purchased only Seqrite EPS Cloud. 

For customers who have purchased Seqrite HawkkEye with Seqrite EPS Cloud, this page is not 

applicable hence not visible. 

User profile is the information about the registered user. You can view name, contact details 

and Role of the logged-on user. 

To edit the user profile, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. On the header, click the arrow next to the human icon. 

3. Click Edit Profile. 

4. Edit the user details as per your requirement. 

5. Click Save. 

You can cancel the changes, with Reset button, if required. 

Change Password 

This page will be visible only to the customers who have purchased only Seqrite EPS. 

To change the password, follow these steps: 

1. Log on to the Seqrite Endpoint Security. 

2. On the header, click the arrow next to the human icon. 

3. Click Change Password. The Change Password page appears. 

4. Enter old password and new password. Enter the new password to confirm. 

5. Click Change Password. 

Log Off 

To log off from the Seqrite Endpoint Security portal, follow these steps:  

1. On the header, click the arrow next to the human icon. 

2. Click Logout. 

News 

The Alerts icon on the header displays the news published by Seqrite about security 

information, new service pack released, new Seqrite Endpoint Security version released etc.  
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